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About this guide

IMPORTANT! Before using this product, read and understand the information the “Safety” appendix
in QuantStudio™ 12K Flex Real-Time PCR System v1.6 or later Maintenance and Administration Guide
(Pub. No. MAN0018832).

Purpose

This document functions as both a tutorial and as a guide for performing your own experiments
using the 384-Well, 96-Well (01.ml and 0.2ml), and the TagMan™ Array Card consumables on the
QuantStudio™ 12K Flex Real-Time PCR System.

Prerequisites

This user guide is intended for personnel who have been specifically trained by Thermo Fisher
Scientific. The manufacturer is not liable for damage or injury that results from use of this manual
by unauthorized or untrained parties.

This guide uses conventions and terminology that assume a working knowledge of the Microsoft™
Windows™ operating system, the internet, and internet-based browsers.

Note: First-time users of the QuantStudio™ 12K Flex Real-Time PCR System, read this booklet
thoroughly. The booklet provides information and general instructions that are applicable to all the
experiments described in this document.

How to use these booklets as tutorials

Each booklet in this guide provides a tutorial for running an example experiment using QuantStudio™
12K Flex Software and the example data provided with the software. The following booklets are
provided:

* “Getting started” on page 17 —Introductory information and experiment workflow common to all
experiments.

* “Running standard curve experiments” on page 86—Designing, running, and analyzing a
Standard Curve experiment.

* “Running relative standard curve experiments” on page 145 and “Running comparative Ct
experiments” on page 198 —Designing, running, and analyzing Relative Standard Curve and
Comparative Cy experiments.

¢ “Running genotyping experiments” on page 254 —Designing, running, and analyzing a Genotyping
experiment.
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About this guide
How to use the guides with your own experiments

* “Running presence absence experiments” on page 310—Designing, running, and analyzing a
Presence/Absence experiment.

¢ “Running melt curve experiments” on page 361 —Designing, running, and analyzing a Melt Curve
experiment.

* Appendix A, “Documentation and support” —Additional documentation and support.

Note: In all parts, the term “experiment” refers to the entire process of performing an experiment,
including setup, run, and analysis.

How to use the guides with your own experiments
Each booklet contains instructions specific to an example experiment provided with the software.

However, you can use the booklets as guides for your own experiments. Tips for running your own
experiments are provided at various points in each booklet.

Assumptions

This guide assumes that you have access to the example experiments provided with the software.
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About this guide
How to use the guides with your own experiments

How to access an example experiment

Start the QuantStudio™ 12K Flex Software

Double-click  (QuantStudio™ 12K Flex Software shortcut) to access the Home screen, shown below.

Note: You can customize the Home screen by importing an image of your choice. The image is
displayed on the right side of the screen.

To personalize the Home screen, go to Tools » Select Welcome Image. Browse to the image of your
choice, then click OK.

Note: The icons in the Analyze menu appear active only if downloaded the software.

Open an example experiment

In the Home screen, click Open, then navigate to one of the following folders, where <...> is the
installation drive. The default installation drive is C: if the software is installed by the customer. The
default installation drive is D: if the software is installed by a Thermo Fisher Scientific field service
engineer.

* QuantStudio™ 12K Flex Software v1.7 and later—<..>: \Program Files\Applied
Biosystems\QuantStudio 12K Flex Software\examples

* QuantStudio™ 12K Flex Software v1.6 and earlier—<..>:\Program Files (x86)\Applied
Biosystems\QuantStudio 12K Flex Software\examples

The examples folder contains folders for each type of experiment. Open the folder that corresponds to
the experiment, then open the example experiment file.
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User attention words

Data files in the examples folder

* Gene Expression
— Comparative Ct
- Relative Standard Curve
¢ Genotyping
* Melt Curve
* Presence Absence
¢ Standard Curve

In addition to the above, the examples folder also contains the User Sample Files folder:
® BarCode Template.txt
® Custom Sample Properties Example.xls
® Human miRNA OA Plate Example.csv

® Open Array Plate Format.csv

User attention words

16

Five user attention words may appear in this document. Each word implies a particular level of
observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper instrument operation or accurate
chemistry kit use.

CAUTION! Indicates a potentially hazardous situation that, if not avoided, may result in minor or
moderate injury. It may also be used to alert against unsafe practices.

WARNING! Indicates a potentially hazardous situation that, if not avoided, could result in death or
serious injury.

DANGER! Indicates an imminently hazardous situation that, if not avoided, will result in death or
serious injury.

Except for IMPORTANT, the safety alert words in user documentation appear with an open triangle
figure that contains a hazard symbol. These hazard symbols are identical to the hazard symbols that are
affixed to the instrument. See the “Safety” appendix in QuantStudio™ 12K Flex Real-Time PCR System
v1.6 or later Maintenance and Administration Guide (Pub. No. MAN0018832) for descriptions of the
symbols.
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General information and instructions

Note: For more information about any of the topics discussed in this guide, access the Help from
within QuantStudio™ 12K Flex Software by pressing F1, clicking  in the toolbar, or selecting
Help » QuantStudio 12K Flex Software.

Set up an experiment

Define experiment properties

All experiments require the same general setup tasks. Individual booklets supply specific parameters.
The following procedures outline general steps to take to set up an experiment.

Access QuantStudio™ 12K Flex Software, then from the Experiment menu, click Create. Click
Experiment Properties to access the Experiment Properties screen.

Define experiment name and type

1.

18

Enter a unique experiment name in the Experiment Name field. The default is a date and time
stamp, which you can change. For example, 2011-12-08 123517.

* Enter a name that is descriptive and easy to remember. You can enter up to 100 characters.

* You can only use the alpha-numeric, period (.), hyphen (-), underscore ( _) and spaces ()
characters.

Note: Make sure each experiment name is unique. If you have named two different experiments
with the same name, you cannot run them on the same instrument. You will receive the following
error message:

If you do not want to delete the existing experiment, rename the duplicate experiment and then
proceed to the run.

(Optional) Enter or scan the barcode on the reaction plate. You can enter up to 100 characters in
the Barcode field.
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Set up an experiment

3. (Optional) Enter a user name to identify the owner of the experiment. You can enter up to 100
characters in the User Name field.

4. (Optional) Enter comments to describe the experiment.

5. Select the block type you are using to run the experiment
e 384-Well
* Array Card
* 96-Well (0.2mL)
* Fast 96-Well (0.1mL)

6. Select the experiment type:
¢ Standard Curve
* Relative Standard Curve
* Comparative Ct (AACy)
* Melt Curve
¢ Genotyping
* Presence/Absence

Select the reagent

Select the reagent you are using to detect the target sequence:
* TagMan™ Reagents
* SYBR™ Green Reagents
¢ Other

Note: If you select SYBR™ Green as the reagent, then you have the option of including a melt
curve for that experiment.

Define the instrument run properties

1. Select the ramp speed for the experiment:
e Standard
* Fast

2. For Genotyping and Presence/Absence experiments, select the options for the data collection to
include in the experiment run:

* Pre-PCR Read—To include data before amplification occurs. Use the data collected during
pre-PCR read to normalize florescence data collected during post-PCR read.

¢ Amplification—To include real-time data.
* Post-PCR Read—To include data after amplification has taken place.
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o
l!li- :itﬁ

20

Chapter 1
Set up an experiment

3. (Optional) For real-time data collection, you can change the default analysis settings in the
Preferences for the following:

* Automatic analysis
* Automatic save
¢ Baseline settings
Go to Tools » Preferences. Click the Experiment tab. Select the Auto Analysis and Auto

Save check boxes for the QuantStudio™ 12K Flex Software to automatically analyze and save
experiment results. You can also edit the following default baseline settings:

Field Entry
Start Cycle Number 3 (default)
End Cycle Number 15 (default)

Note: By default, the Auto Analysis and Auto Save check boxes are selected.

4. For the Melt Curve experiment, select the Include PCR check box, to include PCR.

5. Save the experiment. The default file name ( .eds extension) is the experiment name that you
entered when you set up the experiment and saved it for the first time. Changes to the experiment
name after the first save do not update the file name. To change the file name, select File » Save
As.

The Experiment Properties screen for a Standard Curve experiment is shown in the following graphic:
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Define targets, samples, and biological replicate groups

Use the Define screen to define targets, samples and biological replicates for your experiment. For
Genotyping experiments, use this screen to specify the number of SNP assays to include in the
experiment.

Note: You can start a run without these definitions, but there will be no real-time data in the
amplification plots (the amplification plots can be seen only after you have set up the plate).

1. Click Define to access the Define screen.

2. Define targets.

a.

b.

f.

Click New to add targets and define them.

In the target table, click a cell in the Target Name column for the target, then enter your target
name. The default name is Target 1.

. Select the Reporter and Quencher from the respective drop-down menu.

Note: The default reporter and quencher dyes used depend on the reagent selected during
experiment setup. For example, if TagMan™ is the selected reagent, the default reporter FAM™
and default quencher is NFQ-MGB.

Select the target Color from the drop-down menu.

. (Optional) Click Save to Library to save the newly added or existing edited targets to the

target library.

Note: Use the targets from the Target Library to avoid re-entering the information. See
“(Optional) Use libraries when designing your own experiments” on page 30 for information
on target libraries.

Click Import from Library to add targets from the target library.

3. Define samples.

a.

b.

Click New to add samples and name them.

In the samples table, click a cell in the Sample Name column for the sample to define and
enter your sample name. The default sample name is Sample 1.

. Select the sample Color from the drop-down menu.

(Optional) Click Save to Library to save the newly added or existing edited samples to the
sample library.

Note: Use the samples from the Sample Library to avoid re-entering the information. See
“(Optional) Use libraries when designing your own experiments” on page 30 for information
on sample libraries.

. Click Import from Library to add samples from the sample library.
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4. Define biological replicates.

a. In the Define Biological Replicates Groups table, click New to add biological replicate
group and name them. You can enter up to 100 characters in this field.

b. Select the Color from the drop-down menu.
c. Click in the Comments column to add comments for that biological replicate group.

5. Select the Passive Reference from the drop-down menu.
The Define screen for a Standard Curve experiment is shown in the following graphic:

Assign targets, samples, and biological replicate groups

Use the Assign screen to assign targets, samples, and biological replicate groups to wells in the
reaction plate. For Genotyping experiments, use this screen to assign SNP assays.

Note: You can start a run without these assignments, but there will be no real-time data in the
amplification plots (the amplification plots can be seen only after you have set up the plate).

1. Click Assign to access the Assign screen.

2. Assign targets.
a. Select wells using the plate layout or the well table on the Assign screen.
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b. Select a target and assign its task, in the plate, from the drop-down menu. Depending on the

experiment type, options are:

Experiment type Legend Tasks
Standard Curve U Unknown
] Standard
N Negative Control
Relative Standard Curve U Unknown
S Standard
N Negative Control
Comparative CT U Unknown
N Negative Control
Genotyping U Unknown
1/1 Positive Control Allele 1/Allele 1
2/2 Positive Control Allele 2/Allele 2
1/2 Positive Control Allele 1/Allele 2
N No Template Control
Presence/Absence U Unknown
| Internal Positive Control
N Negative Control
t Blocked Internal Positive Control
Melt Curve Unknown
Negative Control

3. Assign Samples.

a. Select wells using the plate layout or the well table on the Assign screen.

b. Select the check box next to the sample to assign to the selected wells.

Note: You can assign only one sample to a well.

4. Assign Biological Replicate Groups.
a. Select wells using the plate layout or the well table on the Assign screen.
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b. Select the check box next to the biological replicate group to assign to the selected wells.
The Assign screen for a Standard Curve experiment is shown in the following graphic:
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Assign targets, samples, and biological replicate groups - alternate
procedure

As shown in the following graphics, you can also paste assignment information from an " .xIs file into
the plate layout of the QuantStudio™ 12K Flex Software for wells with single targets.

Note: You must select the header, and the Well Number and Well Position columns while copying
information from the * .xIs file.

Note: Any of the columns not copied are treated as NULL values for those columns.
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Define the run method

Use the Run Method screen to set up the run method for your own experiments in the QuantStudio™
12K Flex Software.

1. Click Run Method to access the Run Method screen.

Note: You can save multiple run methods to the Run Method Library for later use. See “(Optional)
Use libraries when designing your own experiments” on page 30 for information on run method
libraries.

2. Enter a number from 1 to 20 for the reaction volume per well. The instrument supports the
following maximum reaction volumes for the consumables listed below:

MicroAmp™ Optical 384-Well Reaction Plate - 30 pyL

Applied Biosystems™ Array Card - 1 pL

MicroAmp™ Optical 96-Well Reaction Plate (0.2 mL)- 200 pL
MicroAmp™ Optical 96-Well Reaction Plate (0.1 mL)- 100 pL
MicroAmp™ Optical 8-Tube Strip with cap (0.2 pL)- 200 pL
MicroAmp™ Fast 8-Tube Strip with cap(0.1 pL)- 100 pL
MicroAmp™ Optical Reaction Tube without cap (0.2 pL)- 200 pyL
MicroAmp™ Fast Reaction Tube without cap (0.1 pL)- 100 pyL

3. In the Graphical View tab, review and, if necessary, edit the run method.

Make sure that the thermal profile is appropriate for your reagents.

Edit the default run method or replace it with one from the run method library included in the
QuantStudio™ 12K Flex Software.

Enable data collection by clicking

Note: Enabling data collection is especially useful when you later need to analyze data
collected in real-time during the various stages.

Edit the ramp rate. You can increase or decrease the ramp rate for a stage.

Note: Ramp rates are decimal numbers from 0.015-3.4.

Edit the PCR Stage.
Change the Number of Cycles for the PCR stage.

Select the Enable AutoDelta checkbox, to increase or decrease the temperature and/or hold
time for each subsequent cycle or to change the Starting Cycle for AutoDelta. Enabling
AutoDelta displays the A icon. Click the AutoDelta Off A icon to change the AutoDelta
settings for the cycling stage in the AutoDelta Settings dialog box. Then, click Save Setting to
display the AutoDelta On A icon.
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Note: If you selected SYBR™ Green as the reagent, the Melt Curve stage automatically appears
in the Run Method screen. If you delete the Melt Curve Stage section from the protocol, then the
melt curve is active in the Add Stage drop-down menu.

4. Complete the tasks on the Optical Filters tab:

By default, the Optical Filters tab is not visible. To show the Optical Filters tab, go to
Tools » Preferences, and select the Show optical filters for run method checkbox under the
Non-OpenArray tab.
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* To add a new filter set to the filter set library, click Save.
* To load a saved filter set, click Load.
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* To go back to the original filter set combinations, click Revert to Defaults.

Note: Select the filter set that matches the profile of the dye you have added to the plate. See
QuantStudio™ 12K Flex Real-Time PCR System v1.6 or later Maintenance and Administration
Guide (Pub. No. MAN0018832) for information on the emission spectrum for each dye, and the
filter at which each dye is read.

(Optional) Use libraries when designing your own experiments

30

The QuantStudio™ 12K Flex Software allows you to save information to libraries, so you can easily use
the information again when setting up an experiment. The libraries include:

Targets library

Samples library

SNP Assay library (only available for Genotyping experiments)
Run Method library

Target, sample, and SNP assay libraries

You can access the Targets, Samples, and SNP Assay libraries from the Tools menu to add, edit,
delete, and import or export items. You can also access a library by clicking Import from Library in the
Define screen when you are setting up an experiment.

Run Method library

You can use the Run Method library from the Run Method screen to:

Save a new run method for later use.

To select an existing run method for an experiment.

QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide



To add a run method to the Run Method Library:

Chapter 1 [#5%
Prepare reactions

1. Click Save Run Method in the toolbar of the Graphical View tab on the Run Method screen.

2. Enter a name and description (optional) for the run method, then click Save.

To select a run method from the Run Method Library

Click Open Run Method in the Run Method screen, and select one from the saved run methods.

Prepare reactions

Supported consumables

The QuantStudio™ 12K Flex Real-Time PCR Instrument is optimized for Applied Biosystems™
consumables. These can be ordered from the Thermo Fisher Scientific website. Use the consumables

appropriate for the sample block of your instrument.

QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide

Maximum | Recommen
Sample block Consumable Consumable description reaction degl
volume reaction
supported volume
384-Well Plate * MicroAmp™ Optical 384- 30 pL 5-20 pL
Well Reaction Plate
* MicroAmp™ Optical
Adhesive Film
Array Card Applied Biosystems™ Array Card | 1 pL 1L
31
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(continued)

Maximum | Recommen
reaction ded
volume reaction

supported volume

Sample block Consumable Consumable description

96-Well Plate * MicroAmp™ Optical 96-Well | 200 pL 10-100 pL

(0.2 mL) Reaction Plate

*  MicroAmp™ Optical
Adhesive Film

*  MicroAmp™ 96-Well
Support Base (only used
during sample preparation)

* QuantStudio™ 12K Flex
System 96-Well Plate
Adaptor

Fast 96-Well Plate * MicroAmp™ Fast Optical 100 pL 10-30 pL

(0.1 mL) 96-Well Reaction Plate

* MicroAmp™ Optical
Adhesive Film

*  MicroAmp™ 96-Well
Support Base (only used
during sample preparation)

* QuantStudio™ 12K Flex
System Fast 96-Well Plate
Adaptor
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(continued)
Maximum | Recommen
Sample block Consumable Consumable description reaction deq
volume reaction
supported volume
96-Well Plate MicroAmp™ Optical 8-Cap e 100puL | * 10-30
(0.2 pL) and Strip for uL for
Fast 96-Well plate MicroAmp™ Optical 8-Tube Fast Fast
0.1 pL) Strip (0.2 pL)/MicroAmp™ 96-well 96-well
Fast 8-Tube Strip (0.1 pL) plate plate
MicroAmp™ 96-Well * 200pL | ¢ 10-100
Tray/Retainer Set (Blue) for 96- HL for
(0.2 pL)/MicroAmp™ 96- well 96-well
Well Tray (Black) (0.1 pL) plate plate
MicroAmp™ 96-Well
Support Base (only used
during sample preparation)
QuantStudio™ 12K Flex
System 96-Well Tube
Adaptor/QuantStudio™ 12K
Flex System Fast 96-Well
Tube Adaptor
96-Well Plate MicroAmp™ Optical e 100pL | * 10-30
(0.2 pL) and Tube without cap for pL for
Fast 96-Well plate (0.2 pL)/MicroAmp™ Fast Fast Fast
(0.1 pL) Reaction Tube without Cap 96-well 96-well
(0.1 L) plate plate
MicroAmp™ Optical 8-Cap e 200puL | = 10-100
Strip for 96- uL for
MicroAmp™ 96-Well well 96-well
Support Base (only used plate plate
during sample preparation)
MicroAmp™ 96-Well
Tray/Retainer Set (Blue)
(0.2 pL)/MicroAmp™ 96-
Well Tray (Black) (0.1 pL)
QuantStudio™ 12K Flex
System 96-Well Tube
Adaptor/QuantStudio™ 12K
Flex System Fast 96-Well
Tube Adaptor

IMPORTANT! Make sure that you use the flat caps for 0.2 pL tubes and 0.1 pL tubes. Use of rounded
caps damages the heated cover.

QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide
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The reagents listed below can be used for experiments performed on the QuantStudio™ 12K Flex Real-
Time PCR System.

Experiment Reagent

Standard Curve * TagMan™ Reagents
¢ SYBR™ Green reagents

¢ Other reagents

Relative Standard Curve * TagMan™ Reagents
e SYBR™ Green reagents

¢ Other reagents

Comparative Ct (AACy) * TagMan™ Reagents
* SYBR™ Green reagents

* Other reagents

Melt Curve * SYBR™ Green reagents

® Other reagents

Genotyping * TagMan™ Reagents
® Other reagents

Presence/Absence ¢ TagMan™ Reagents
® Other reagents

Note: TagMan™ Fast Universal PCR Master Mix is not recommended to be used with the 96-well
(0.2 pL) reaction plates or reaction tubes and tube strips sealed with caps.

Reagent detection process

TagMan™ reagents

TagMan™ reagents use a fluorogenic probe to enable detection of a specific PCR product as it
accumulates during PCR cycles.

Advantages
* Increased signal specificity with the addition of a fluorogenic probe.
* Multiplex capability.

* Optional preformulated assays, optimized to run under universal thermal cycling conditions, are
available.

® (Can be used for either 1- or 2-step RT-PCR.
Limitations

Require synthesis of a unique fluorogenic probe.
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SYBR™ green reagents
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SYBR™ Green reagents use SYBR™ Green | dye, a double-stranded DNA binding dye, to detect PCR

products as they accumulate during PCR cycles.

Advantages

® Economical (no probe needed).

* Allow for melt curve analysis to measure the Tm of all PCR products.

® (Can be used for either 1- or 2-step RT-PCR.

Limitations

Bind nonspecifically to all double-stranded DNA sequences. To avoid erroneous information signals,
check for nonspecific product formation using melt curve or gel analysis.

Table 1 SYBR™ Green detection process

!LI !’0

4

Method

Description

Step 1: Reaction setup The SYBR™ Green | dye
fluoresces when bound to double-stranded DNA.
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Table 1 SYBR Green detection process (continued)

Method Description

Step 2: Denaturation When the DNA is denatured into
single-stranded DNA, the SYBR™ Green | dye is released
) and the fluorescence is drastically reduced.

Step 3: Polymerization During extension, primers anneal
and PCR product is generated.

| l l | l Step 4: Polymerization completed SYBR™ Green | dye
—.— —.— —.— —.'— —.— binds to the double-stranded product, resulting in a net

I ! I increase in fluorescence detected by the instrument.

l ] ] l ]

Precautions while preparing reactions

* Make sure that you do not prepare the reactions on a wet table. Wet surfaces lead to
contamination of your reactions.

* Wear appropriate protective eyewear, clothing, and powder-free gloves.

* Make sure that you use the appropriate consumables. The quality of pipettors and tips and the care
used in measuring and mixing dilutions affect data accuracy.

* Make sure that you perform dilutions exactly as instructed. Mistakes or inaccuracies in making the
dilutions directly affect the quality of results.

* Use a permanent marker or pen to mark a tube and the side of a plate or array card. Do not use
fluorescent markers.

* Make sure that the arrangement of the PCR reactions matches the plate layout displayed in the
QuantStudio™ 12K Flex Software.

Materials required while preparing the dilutions

* DI water or DEPC water
* Microcentrifuge tubes

* Pipettors

* Pipette tips
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* \ortex mixer

¢ Centrifuge

* Sample stock

¢ Standard stock

* Reaction mix components

* Plate or array card

Guidelines for preparing the dilutions, reaction mix, and plate

* Include excess volume in your calculations to provide excess volume for the loss that occurs during
reagent transfers.

Use TE buffer or water to dilute the standards and samples.

Prepare the reagents according to the manufacturer's instructions.

Keep the dilutions and assay mix protected from light, in the freezer, until you are ready to use it.
Excessive exposure to light may affect the fluorescent probes or dyes.

® Prior to use:
— Mix the master mix thoroughly by swirling the bottle.

— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend the samples by
vortexing, then centrifuge the tubes briefly

Do not allow the bottom of the reaction plate to become dirty. Fluids and other contaminants that
adhere to the bottom of the reaction plate can contaminate the sample block(s) and cause an
abnormally high background signal.

Correct Incorrect
Liquid is at the bottom of the well. Not centrifuged with enough force
Or
Not centrifuged for enough time

* For Genotyping experiments, prepare the reactions for each SNP separately.

* Place the reaction plate or array card at 4°C and in the dark until you are ready to load it into the
instrument
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Seal the reaction plate

If you use optical adhesive film to seal your reaction plates, seal each reaction plate as follows:

Note: The sealing instructions are applicable to 384-well and 96-well reaction plates.

1. Load the reaction plate using the plate layout described in “Assign targets, samples, and biological
replicate groups” on page 22.

Note: For 96-well reaction plates, place the reaction plate onto the center of the 96-well base,
then perform this step. Be sure that the reaction plate is flush with the top surface of the 96-well
base.

Note: You can also use the MicroAmp™ Optical 8-Cap Strip to seal the 96-well reaction plates.

2. Remove a single optical adhesive film from the box. Bend both end-tabs upward. Hold the film
backing side up.

3. In one swift movement, peel back the white protective
backing from the center sealing surface. Do not touch
the center sealing surface.

IMPORTANT! Improper peeling of the optical
adhesive film may result in haziness, but it will not
affect results. Haziness disappears when the film
comes into contact with the heated cover in the
instrument.

4. Holding the film by the end-tabs, lower the film onto
the reaction plate (adhesive side facing the reaction
plate). Make sure that the film completely covers all
wells of the reaction plate.

5. Applying firm pressure, move the applicator slowly
across the film, horizontally and vertically, to ensure
good contact between the film and the entire surface
of the reaction plate.
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6. Using the applicator to hold the edge of the film in
place, grasp one end of the end-tab and pull up and
away sharply. Repeat for the other end-tab.

Note: Ensure clean removal of both end-tabs from the
dotted line. Improper peeling of the end-tab can cause
sticking of plate on the heated cover assembly.

7. To ensure a tight, evaporation-free seal, repeat step 5
on page 38.

Applying firm pressure, run the edge of the applicator along all four sides of the outside border of
the film.

Note: Optical adhesive films do not adhere on contact. The films require the application of
pressure to ensure a tight, evaporation-free seal.

8. Inspect the reaction plate to be sure that all wells are
sealed. You should see an imprint of all wells on the
surface of the film. Check for the perforated tab to be
completely torn off to avoid plates from sticking to the
instrument after a run.

IMPORTANT! Remove all excess adhesive from the
perimeter of the optical adhesive cover. When the film
is applied, the glue from the optical adhesive cover can
adhere to the edges of the plate. If the excess glue is
not removed, the plate may adhere to sample block of
the QuantStudio™ 12K Flex Real-Time PCR Instrument.

Fill and seal the array card

Fill and spin the array card

IMPORTANT! Wear powder-free gloves while preparing the array cards.

1. Remove an array card from its box and place it on a clean, dry surface.
2. Using a permanent marker, mark the side of the empty array cards.

3. Transfer the experiment-related chemistries and solutions into the port of the array card.
For each transfer:
a. Place the array card on a lab bench, with the foil side down.

b. Load 100 pL of fluid into a pipette.
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c. Hold the pipette in an angled position (approximately 45 degrees) and place the tip into the fill
port. There is a fill port on the left arm of each fill reservoir — it is the larger of the two holes.

Do not allow the tip to contact and possibly damage the coated foil beneath the fill port.

(@ Fill port

@ Vent port

d. Dispense the fluid so that it sweeps in and around
the fill reservoir toward the vent port. Pipette fluid
into the fill reservoir, but do not go past the first
stop of pipettor plunger when pipetting the reagents
into the array card, or you may blow the solution out
of the port.

IMPORTANT! Do not allow the tip to contact and
possibly damage the coated foil beneath the fill port.

4. Place the filled array card(s) into a centrifuge array
card carrier clip and place empty array card(s) in the
remaining slots. Make sure that the labels on the
buckets and clips face the same way.

IMPORTANT! Make sure to balance the loads in
opposite buckets in the centrifuge.
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5. Place the filled carrier clips into the centrifuge buckets.
Make sure that the array-card fill reservoirs and bucket &/\
and clip labels face outward when loaded into the A
centrifuge. Balance the loads in opposite buckets. m
IMPORTANT! You must run the centrifuge with all
four buckets in place and each of the two carriers

filled with the array card. Place empty array cards into
unfilled slots.

6. Close the centrifuge cover, then spin the array card(s)
for 1 minute at 1200 rpm.

7. When the run is finished, stop the centrifuge, then spin
the array card(s) again for 1 minute at 1200 rpm.

IMPORTANT! Do not try to save time by doing
one spin for 2 minutes. The two sets of ramps are
important for a good fill into the array card.

8. When the second run is finished, open the centrifuge and check that the fluid levels in the
reservoirs of each array card have decreased by the same amount. Also, check for the formation of
bubbles in all wells and note possible problems.

Consistent filling Inconsistent filling
@ @ @ @ @ @

9. If necessary, centrifuge the array card(s) for an additional minute to fill any unfilled wells. Do not
exceed three 1-minute runs or centrifuge the array card for longer than 1 minute at a time.

Seal the array card

1. With the carriage (roller assembly) of the TagMan™ Array Card Sealer in the Start position, place a
filled array card into the fixture with the foil side up so that the fill reservoirs are the farthest away
from the carriage.

2. Press down on all four corners of the array card to ensure that it is fully seated within the fixture.

@ Carriage
@ Carriage starting position
@ Carriage ending position
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3. Use the two alignment pins in the fixture to position the array card correctly.

S

8

(@ Alignment pins
@ Spring clips

4. Seal the array card by running the carriage slowly over it, in one direction only. Do not apply
downward force on the carriage as you move it forward over the card.

5. Remove the sealed array card from the fixture and trim
the fill reservoirs from the array card assembly using
scissors. Trim the foil array card so that the edge is
even with the plastic carrier.

IMPORTANT! Completely remove the fill reservoirs
from the array card so that the edge is free of residual
plastic. The plastic from the fill reservoirs that extends
beyond the edge of the card can prevent the card
from seating properly on the sample block and affect
amplification.

i HA
LY o)

Correct trim

Incorrect trim

@ @

@ @

IMPORTANT! As you seal the remaining filled array cards, store them in a dark place until you are
ready to use them. The fluorescent dyes in the array card are photosensitive. Prolonged exposure

to light can diminish the fluorescence of the dye.
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Capping and uncapping the 96-well reaction tubes and tube strips

Note: Make sure that you secure the caps on the tubes and tube-strips tightly to avoid sample
evaporation.

If you use the 96-well MicroAmp™ Optical 8-Tube Strips or MicroAmp™ Optical Tubes without Cap, use
the MicroAmp™ Cap Installing Tool (Cat. No. 4330015) and follow the instructions below for:

* Applying the MicroAmp™ Optical 8-Cap Strip or MicroAmp™ Optical Tubes without Cap to the
tubes

* Removing a cap string from a plate

Required materials:
* MicroAmp™ Cap Installing Tool
* MicroAmp™ Optical 8-Tube Strips or MicroAmp™ Optical Tubes without cap
* MicroAmp™ Optical 8-Cap Strip

Apply the MicroAmp™ Optical 8-cap strip (flat)

1. Grasp the MicroAmp™ Cap Installing Tool so that the grooved side is exposed.
2. Hold the strip of caps over the tube strip or the row of tubes.

3. Use the grooved side of the tool to push and seat each cap firmly in place. Use a rocking motion to
properly seat each cap.
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Remove a cap string from a plate

The MicroAmp™ Cap Installing Tool is also used for removing the MicroAmp™ Optical 8-Cap Strip from
the 96-well optical plates and tray/retainer assemblies.

1. Insert the small protrusions on the side of the tool under the webbing between the caps on a cap

strip.

2. Slowly pry the strip from the plate or tray/retainer assembly.
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Start the experiment

1. Access the Instrument Console (see “Instrument Console screen” on page 45).

2. Load the reaction plate or array card into the instrument (see “Load the reaction plate or array card

into the instrument” on page 48).
3. Run the experiment (see “Run the experiment” on page 50).
Instrument Console screen

The Instrument Console screen displays all the QuantStudio™ 12K Flex Real-Time PCR Instruments
discovered on a network.
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Left pane

The features on the left pane of the Instrument Console screen allow the following items:

* Instrument access: Open and close the instrument door from the software user interface.

¢ Group management:

Create, rename, and delete groups and assign instruments to the groups.
Add and remove instruments to and from the My Instruments pane.

Note: To add instruments, select the icon of the instrument that you want to add to the

My Instruments pane. Click Add to My Instruments. Similarly, click Remove from My
Instruments to remove an instrument from the My Instruments pane. You can also drag

and drop the instrument icon into the My Instruments pane or into the group created by you.

Display instrument groups from the Display Group dropdown list according to their activity.
Select the status from the Filtered By dropdown list. For more information on the status of an
instrument, see “Monitor the experiment” on page 52.

* Instrument management:

46

Monitor experiments (check the run status or monitor a temperature plot or amplification plot
during a run). For more information on monitoring experiments, see “Monitor the experiment”
on page 52.

Maintain instruments (check the calibration status of instruments and perform different
calibrations). For more information about instrument maintenance, see QuantStudio™ 12K
Flex Real-Time PCR System v1.6 or later Maintenance and Administration Guide (Pub.
No. MANO018832).

Manage files (upload setup files; download completed experiments; and create, rename, and
delete experiment files and plate setup folders).

Note: Completed experiments are downloaded into the default folder Completed
Experiments.

Note: To manage files, click Manage Instrument.

Use the File Manager tool to create, rename or delete folders for holding setup files for
starting a run or completed experiments for analysis. To move setup files from one folder to the
other, click Move, then select the setup folder you want to shift the setup file into.

IMPORTANT! To manage and monitor, you must move instruments from the On the Network
pane to the My Instruments pane or a custom group. You can start a run and calibrate
instruments present only in the My Instruments pane or the custom group(s) that you created.

QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide



Chapter 1 F5%

Start the experiment

Right pane
The right pane of the Instrument Console screen displays the following information:
* The name of the instrument whose instrument icon is selected.
* The run status of the selected instrument.
* The group the instrument belongs to.
* The calibration status, maintenance reminders and instrument properties of the selected

instrument.

The calibration status is indicated by the  icon. The icon appears in the Status column of the
Calibration Status table after the last reminder date before the calibration expires.

Status icons

You can monitor the instrument status and view calibration and other information in the Instrument
Console screen.

Instrument status icon

The status of an instrument is represented by an icon in the top-right corner of the thumbnail
representation of the instrument in the Instrument Console screen. An instrument displays the status
when you place the instrument icon in the My Instruments pane or in the groups that you created.

1. Inthe Home tab ( ), select Instrument Console. If you do not see an instrument, click Refresh
in the instrument console toolbar.

2. If needed, move the instrument from the On the Network group to a group which can be
monitored.

a. Click the instrument of interest, then click Assign to Group in the instrument console toolbar.

b. Select the My Instruments or a personal group in the drop-down list. The instrument is now

monitored.
Icon Instrument status
Ready
[No icon] Available on the network but cannot be monitored because that instrument is
not in the My Instruments pane or a group you created.
Run in process
(The time remaining for the run is shown to the left of the icon.)
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(continued)

Icon Instrument status

Unavailable

Incompatible firmware version

No longer connected to the network

Error occurred during run

Load the reaction plate or array card into the instrument

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the
sample block(s) can exceed 100°C. Keep your hands away until the sample block(s) reaches room
temperature.
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Figure 2 Sample block

IMPORTANT! Wear powder-free gloves when you handle the reaction plate or array card.

IMPORTANT! Plates and array cards should be loaded and unloaded by operators who have been
warned of the moving parts hazard and have been adequately trained.

1. Touch on the instrument touchscreen or click Open Door in the Instrument Console screen of
the software to allow the plate adapter to come out from the instrument side.

2. Place the reaction plate or array card on the plate adapter. Ensure that the reaction plate or array
card is properly aligned in the holder.

* Make sure the well A1 is positioned at the top-left of the tray for any of the plate formats.

* Make sure the barcode (for any of the plate formats) is facing the front of the instrument.
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* |f using reaction tubes or tube strips, make sure you use adaptors. The adaptors are attached
to the plate transport arm. The tray containing the tubes or tube strips must be placed on the
adaptor and not into the sample block directly.

IMPORTANT! For optimal performance with partial loads, load at least 16 tubes and arrange
them in:

Adjacent columns of 8 tubes, using rows A through H. For example, use wells in columns 6 and 7
(rows A through H).

Or

Adjacent rows of 8 tubes, using columns 3 through 10. For example, use wells in row D (columns 3
through 10) and row E (columns 3 through 10).

IMPORTANT! Make sure that you use the flat caps for the 0.2pL tubes and 0.1pL tubes. Use of
rounded caps damages the heated cover.

3. Touch on the instrument touchscreen or click Close Door in the Instrument Console screen of
the software to retract the plate adapter back into the instrument.

Enable or change the notification settings

You can configure the QuantStudio™ 12K Flex Software to alert you by email when the instrument
begins and completes a run, or if an error occurs during a run.

Note: For details on using the notification settings feature, see QuantStudio™ 12K Flex Real-Time PCR
System v1.6 or later Maintenance and Administration Guide (Pub. No. MANO018832).

Run the experiment

You can run the experiment in either of the following two ways:
* From the software (“Start a run from the software” on page 51)
* From the instrument touchscreen (“Start a run from the instrument touchscreen” on page 51)
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Note: The example experiments in each of the getting started guide booklets start a run from the
software.

IMPORTANT! Make sure that instrument calibration is up-to-date. If a calibration has expired,

you get a warning when you start a run. For information on calibrating the instrument, see
QuantStudio™ 12K Flex Real-Time PCR System v1.6 or later Maintenance and Administration Guide
(Pub. No. MAN0018832).

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the
instrument is in operation.

Start a run from the software

1. In the navigation pane of the QuantStudio™ 12K Flex Software, click

2. Click START RUN. Select the instrument for the run from the drop-down menu of the instruments
placed under My Instruments.

IMPORTANT! Make sure that the instrument to run the experiment on is in My Instruments or
the custom group, and that it is ready to run an experiment. If the preferred instrument is not
present under My Instruments or the custom group, or if it is unavailable, clicking START RUN
does not display instrument names in the drop-down menu.

Start a run from the instrument touchscreen

1. Touch the instrument touchscreen to awaken it.

Note: If the touchscreen is not at the Main Menu screen, touch

2. In the Main Menu screen, touch Browse Experiments.

3. In the Browse screen, touch (Folders) to display the folders containing the experiment setup
files.

4. Touch any of the folder names to display the experiments in that folder.
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In the Experiments screen, select the desired experiment, then touch to view or edit the
experiment before starting the run.

Note: You can start a run immediately by clicking , then go to step 8 on page 52.

(Optional) Modify the experiment parameters as needed. You can use the following options:

* Use the button and the button to add and delete a stage or step to the thermal
profile.

* Usethe button to add a melt curve to the thermal profile.

* Use the button to save the experiment you modify.

In the Save Experiment screen, touch each field to edit the items.
* Experiment name
* Folder to save the experiment
* Reaction volume
* Barcode Number
* Notes

When finished, touch Save & Start Run to start the experiment.

In the Start Run screen, touch each field as needed to modify the associated parameter, then
touch Start Run Now to start the experiment.

Note: When the run is complete, touch g to unload the plate from the instrument. You can
download the results of the experiment from a computer if the instrument is connected to a
network, or copy the data to a USB device as explained in “Transfer experiment results” on

page 59.

Monitor the experiment

52

Note: If there is loss of connection during an experiment, remove the instrument from the My
Instruments list. Add the instrument back to the My Instruments list. You can then resume monitoring
the experiment.

You can monitor an experiment run in three ways:

From the instrument touchscreen, in the same way that you run the experiment (see “Start a run
from the instrument touchscreen” on page 51).

From the Run screen of the software, while the experiment is in progress, as shown below.

From the Instrument Console screen of the software (to monitor an experiment started from
another computer or from the QuantStudio™ 12K Flex Instrument touchscreen), as described in
“Monitor a run from the software Instrument Console screen” on page 53.
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Monitor an experiment from the software Run screen

1. Click Amplification Plot from the Run Experiment menu to monitor the amplification plot of the

experiment you are running.

Note: For melt curve experiments, click Melt Curve Plot from the Run Experiment menu.

2. Click Temperature Plot from the Run Experiment menu to monitor the temperature plot of the

experiment you are running.

Monitor a run from the software Instrument Console screen

1. In the Instrument Console screen, select the icon of the instrument that you are using to run the

experiment.

2. Click Manage Instrument.

3. In the Instrument Manager screen, click Monitor Running Instrument.

You can view the progress of the run in real time from the Run screen. During the run, periodically view
the Amplification Plot, Temperature Plot, and Run Method for potential problems.

Action

Instructions

Stop the run

* |n the software, click STOP RUN.

* Inthe Stop Run dialog box, click one of the following options:
— Click Stop Immediately to stop the run immediately.

— Click Cancel to continue the run.

View amplification data in real time

Select Amplification Plot.

See “To monitor the Amplification Plot” on page 54.

View temperature data for the run in
real time

Select Temperature Plot.

See “To monitor the Temperature Plot” on page 54.

View progress of the run in the Run
Method screen

Select Run Method.
See “To monitor the Run Method” on page 55.

Enable or disable the notification
settings

Select or deselect Enable Notifications.

See “Enable or change the notification settings” on page 50.

Note: The individual experiment booklets provide illustrations of the different experiments in real time.

Note: For melt curve experiments, click Melt Curve Plot from the Run Experiment menu.

The Run screen for a standard curve experiment run looks like this:
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To monitor the Amplification Plot

To view data in the Amplification Plot, click Amplification Plot from the Run Experiment menu, select
the Plate Layout tab, then select the wells to view.

The Amplification Plot screen allows you to view sample amplification as your instrument collects
fluorescence data during a run. If a method is set up to collect real-time data, the Amplification Plot
screen displays the data for the wells selected in the Plate Layout tab. The plot contrasts normalized
dye fluorescence (ARn) and cycle number.

The Amplification Plot screen is useful for identifying and examining abnormal amplification, including:
* Increased fluorescence in negative control wells.

* Absence of detectable fluorescence at an expected cycle (determined from previous similar
experiments run using the same reagents under the same conditions).

Note: If you notice abnormal amplification or a complete absence of signal, troubleshoot the error
as explained in the software help (click  or press F1).

To monitor the Temperature Plot
To view data in the Temperature Plot screen, click Temperature Plot from the Run Experiment menu.

During a run, the Temperature Plot screen displays the temperatures of the sample block(s), the
heated cover, and samples (calculated) in real-time.
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Action Instructions

Add or remove temperature plots Select Cover or Sample Block
to view the presence of the
associated data in the plot.

Change the time to display in the plot From the View drop-down list,
select the amount of time to
display in the plot.

Display a fixed time window during the instrument run Select Fixed View.

If the entire plot does not fit in the screen, the screen is not updated
as the run progresses. For example, if you select 10 minutes from the
View drop-down list, the plot will show data for 10 minutes. If the
Fixed View is:

¢ Deselected, the plot updates as the run progresses even after
10 minutes.

* Selected, the plot does not update as the run progresses even
after 10 minutes.

The Temperature Plot screen can be useful for identifying hardware failures. When monitoring the
Temperature Plot screen, observe the Sample plot and the Block plot for abnormal behavior.

* The Sample plot and the Block plot should mirror each other approximately. A significant deviation
of the plots can indicate a problem.

* The Cover plot should maintain the constant temperature specified in the method. A departure
from the constant temperature may indicate a problem.

Note: If you notice abnormal temperature plot, troubleshoot the error as explained in the software
help (click  or press F1).

To monitor the Run Method
To view data in the Run Method screen, click Run Method from the Run Experiment menu.

The Run Method screen displays the run method selected for the run in progress. The software
updates the Run Status field throughout the run.

Action Instructions

Change the number of cycles In the Adjust # of Cycles field, enter the number of cycles to
apply to the Cycling Stage.

Add a melt curve stage to the end of the run | Select Add Melt Curve Stage to End.

Add a Hold stage to the end of the run Select Add Holding Stage to End.

Add an indefinite hold to the end of the run | Select Add Infinite Hold to End.

Apply your changes Click Send to Instrument.

If an alert appears, click the error for more information and troubleshoot the problem as explained in the
software help (click  or press F1).
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To view the run data

After a run is complete, you can view a run report by clicking View Run Data. The View Run Data
screen displays information about the completed run, as in the following example from a Standard

Curve experiment:

The run report data helps in:

* Comparing two experiments of the same type run on two different instruments.

¢ Troubleshooting. For example, after a firmware upgrade, you can compare an experiment run
before and after the upgrade to determine if the upgrade affected performance.

Monitor a run from the instrument touchscreen

The touchscreen displays the method for the experiment, the date and time at which the run started,
the time remaining in the run, and other information.

Action

Instructions

Display a graphical view of the run

Touch Experiment View.

Show the Ampilification Plot for the run

Touch Plot View, then touch Experiment View to return
to the Run Method screen.

Display the time elapsed and the time
remaining in the run

Touch ® Time View, then touch Experiment View to return
to the Run Method screen.

Stop the run

Touch ¥ STOP to stop the protocol run immediately.

View the events log

Touch the status bar to display the events log.

The run method on the instrument touchscreen is shown in the following graphics:
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Figure 3 Experiment View tab

Figure 4 Time View tab
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Figure 5 Plot View tab

The Plot View tab displays the Amplification Plot in real time. You can change the plot using the
drop-down menus present below the Plot View tab.

Action Instructions

Change the data displayed on the y axis. Select either Rn (normalized reporter) or ARnA | Touch
(baseline-corrected normalized reporter).

Change the reporter dye displayed in the plot. Only dyes used in your experiment are Touch
shown.

View the run events that occurred during the run. Touch e again to close the event list. | Touch o .
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Unload the instrument

When the instrument displays the Main Menu screen, unload the reaction plate from the instrument and
transfer the experiment data to the computer for analysis.

Unload the reaction plate or array card

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the
sample block(s) can exceed 100°C. Keep your hands away until the sample block(s) reaches room
temperature.

1. Open the access door.

® On the instrument touchscreen, touch & .
* |n the Instrument Console screen of the software, click Open Door.

2. Remove the reaction plate or array card from the plate adapter.

3. Retract the plate adapter back into the instrument.

¢ On the instrument touchscreen, touch & .
* |n the Instrument Console screen of the software, click Close Door.

4. If the instrument does not eject the plate, perform the following steps.
a. Power off the instrument.

b. Wait for 15 minutes, then power on the instrument.
c. Eject the plate.
d. If the plate does not eject, power off and unplug the instrument, then open the access door.

e. Wearing powder-free gloves, reach into the instrument, remove the plate from the heated
cover, then close the access door.

f. Perform a background calibration to confirm that the sample block has not been
contaminated.

Transfer experiment results

Transfer the experiment results in one of the following ways:

* Download the experiment over the network (see “Download the experiment from the instrument
over the network” on page 60)

* Transfer the experiment by a USB drive (see “Transfer the experiment from the instrument to the
computer with a USB drive” on page 61)
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Download the experiment from the instrument over the network

1. In the software, click Instrument » Instrument Console.

2. Select the instrument icon of the instrument you just used to run the experiment from the My
Instruments list.

3. Click Manage Instrument to open the Instrument Manager screen.
4. In the Instrument Manager screen, click Manage Files.
5. In the Experiments panel, select the experiment to download, then click Download.

6. In the Save dialog box, select the folder to hold the experiment results, then click Save.
The experiments folder is located at <..>:\Applied Biosystems\QuantStudio 12K Flex
Software\experiments, where <...> is the installation drive.

The default installation drive is C: if the software is installed by the customer. The default
installation drive is D: if the software is installed by a Thermo Fisher Scientific field service
engineer.
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Transfer the experiment from the instrument to the computer with a USB drive

1. If not already connected to the instrument, connect a USB drive to the USB port.

2. Touch the instrument touchscreen to awaken it.
3. If the touchscreen is not at the Main Menu screen, touch

4. In the Main Menu screen, touch  (Collect Results) to save the data to the USB drive.
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5. Touch one or multiple experiments, then touch  (Save to USB) to copy selected experiment or
experiments to the USB drive.

Note: If your instrument cannot find the USB drive, remove the USB drive, then try again. If the
instrument still does not recognize the USB drive, try another USB drive.

6. Touch to return to the Main Menu screen.

7. Remove the USB drive from your instrument, then connect it to one of the USB ports on your
computer.

8. In the computer desktop, use the Windows™ explorer to open the USB drive.

9. Copy the example experiment file to <..>:\Applied Biosystems\QuantStudio 12K Flex
Software\experiments, where <...> is the installation drive.

The default installation drive is C: if the software is installed by the customer. The default
installation drive is D: if the software is installed by a Thermo Fisher Scientific field service
engineer.

Review experiment results

About analysis results

Immediately after a run, the software automatically analyzes the data using the default analysis settings,
then displays the Amplification Plot screen.

Note: For auto-analysis of data, after a run, go to Tools » Preferences » Experiment, then select the
Auto Analysis checkbox.

Note: For Genotyping experiments, the software displays the Allelic Discrimination Plot screen.

To reanalyze the data, select all the wells in the plate layout, then click Analyze.

About the analysis settings library

62

Analysis settings are different for each experiment type. If the default analysis settings in the software
are not suitable for your own experiment, you can change the settings in the Analysis Settings dialog
box, then reanalyze your experiment.

You can save the changed analysis settings to the Analysis Settings Library so that you can use them
in other experiments.

In the Analysis Settings Library dialog box you can apply a filter to reduce the number of settings
protocols displayed.

You can access the Analysis Settings Library from the Tools menu. The Analysis Settings Library
dialog box looks like this:
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To change the analysis settings and to save them to the Analysis Settings Library:

1. From the Experiment Menu pane, select Analysis.

2. On the Analysis screen, click Analysis Settings to open the Analysis Settings dialog box.
3. Change the analysis settings as per your requirement.

4. Click Save to Library to save the changes you have made to the Analysis Settings Library.

You can import the analysis settings you have previously saved to the Analysis Settings Library, by
clicking Load from Library in the Analysis Settings dialog box.

Override calibration

Each experiment file (.eds) stores the calibration data from the QuantStudio™ 12K Flex Real-Time PCR
Instrument that it was run on. The calibration data can affect the analysis results of an experiment.

If you have run multiple experiments on different instruments and prefer the analysis results from
a particular QuantStudio™ 12K Flex Real-Time PCR Instrument, then you can choose to use the
calibration data from another instrument.
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Use the calibration data from another experiment

1. Open the experiment file (.eds), in which you want to import the calibration data from another
QuantStudio™ 12K Flex Real-Time PCR Instrument, in the QuantStudio™ 12K Flex Software.

2. Click Analysis » Override Calibration » Use Calibration From Another File.

3. Browse to experiment file (.eds) from which you want to use the calibration data.

Note: You can choose to override the calibration data in an experiment with the calibration data of
only the same experiment type.

4. Click Open.

Revert to the original calibration data

1. Open the experiment file (.eds), in which you want to import the original calibration data, in the
QuantStudio™ 12K Flex Software.

2. Click Analysis » Override Calibration » Revert To Original Calibration.

The experiment file displays analysis results as per the calibration data of the instrument that the
experiment was run on.
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Display wells

To display specific wells in the analysis plots, select the wells in the Plate Layout tab:

To select wells of a specific type, use the Select Wells dropdown list. Select Sample, Target, or
Task, then select the sample, target, or task name.

To select a single well, click the well in the plate layout.

To select multiple wells, click and drag over the desired wells, press control-click, or press shift-
click in the plate layout.

To select all the wells, click the upper left corner of the plate layout.

The plate layout for a Standard Curve experiment is shown in the following graphic:

Display multiple plots

Use the Multiple Plots View screen to display up to four plots simultaneously. To navigate within the
Multiple Plots View screen, from the Experiment Menu pane, select Analysis » Multiple Plots View.

To display four plots, click 25 (Show plots in a 2 x 2 matrix).
To display two plots in rows, click = (Show plots in two rows).
To display two plots vertically, click Ul (Show plots in two columns).

To display a specific plot, select the plot from the dropdown list above each plot display.

The Multiple Plots View screen for a Standard Curve experiment is shown in the following graphic:
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Display an expanded view of a plot or wells

* Click 3 to expand the view of a plot, displayed on the left-hand side of the screen.

¢ Click 2l to expand the view of the Plate Layout or Well Table displayed on the right-hand side of the
screen.
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Edit plot properties

Use the Plot Properties dialog box on the Analysis screen to edit plot settings such as the font and
color of the plot text, and the labels on the X axis and Y Axis.

1. Click  on the Analyze screen (the icon appears above the plot) to open the Plot Properties
dialog box

2. Edit the settings under the General tab, the X Axis tab, and the Y Axis tab.

¢ Click the General tab to edit the plot title text, font, or color. You can also select whether to
show the plot title.

* (lick the X Axis tab to edit the x axis label text, font, or color; select the tick marks and tick
mark labels to display; and select the range to display.

¢ Click the Y Axis tab to edit the y axis label text, font, or color; select the tick marks and tick
mark labels to display; and select the range to display.

3. Click OK.

Save current settings as default

You can change the Plot Settings for the different analysis plots, and save them as defaults.

Select the Save current settings as the default checkbox on the respective plot screens under the
Analysis menu.

Publish the analyzed data

Action Instructions
Save a plot as an image file Click
Print a plot Click
Copy a plot to the clipboard Click
Print a report Click
Export data Click
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Action Go to Then
Print the plate layout | File » Print Select the background color, then click Print.
Create slides File » Send to PowerPoint | Select the slides for your presentation, then click Create
Slides.
Print a report File » Print Report Select data for the report, then click Print Report.

Export an experiment

About exporting an experiment

The export feature of the QuantStudio™ 12K Flex Software allows you to export:

* Plate setup files for future experiments.

Plate setup files contain setup information such as the well number, sample name, sample color,
target name, dyes, and other reaction plate contents.

* Analyzed data in different formats for further analysis.
The data can be exported in the QuantStudio™ 12K Flex format, the 7900 SDS format, and the
RDML format.
The 7900 format is applicable only to Standard Curve, Relative Standard Curve, Genotyping,
Presence/Absence, and Melt Curve experiments.
The RDML export format is applicable only to Standard Curve, Relative Standard Curve,
Comparative Ct, and Melt Curve experiments. The RDML format is available only in a single file
format.
For Standard Curve experiments, you can also export the analyzed data from the QuantStudio™
12K Flex Software to the external application, CopyCaller™ Software, if it is installed on your
computer before the QuantStudio™ 12K Flex Software is installed. The application appears in the
Tools menu.

* Gene Expression studies to carry out a comparative analysis.
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Export procedure

Note: If you choose the Auto Export option during experiment setup or before running an experiment,
the data is automatically exported to the location you specified. If you did not set the Auto Export
option, the analyzed data is not exported automatically.

1. Open the experiment file that contains the data to export, and from the Experiment Menu, click
Export.

2. Select the format for exported data.

* QuantStudio 12K Flex format—Supports TXT, XLS, and XLSX file formats

* 7900 format—Supports only the TXT file format
Single experiments are exported in the SDS 2.4 detector centric export format of the 7900
Sequence Detecting System.

* RDML format—Supports only XML data (Real Time Data Markup Language)

3. Select the option to export all data in one file or in separate files for each data type.

* One File—All data types are exported in one file.
- If you select the XLS format, a worksheet is created for each data type.

- If you select the TXT format, the data are grouped by data type.

* Separate Files—Each data type is exported in a separate file. For example, if you select three
different data types Results, Amplification, and Multicomponent to export, three separate files
(one each for Results, Amplification, and Multicomponent) are created. You can select the type
of file (XLS or TXT) to export from the File Type dropdown list.

Note: You cannot use an exported XLS file or an exported XLSX file when importing plate setup
information.

4. (Optional) Select the Open file(s) when export is complete checkbox to automatically open the
file when export is complete.

5. Enter a file name and location.
a. Enter a name for the export file in the Export File Name field.
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b. Enter the Export File Location information. Click Browse if you do not want to save the
export file in the default export folder.

Note: To set up the location, go to Tools » Preferences, then select the Export tab. You can
select the Use Last File Location radio button or the Use Default Folder radio button.

6. Select the data to export.

Select Export

Sample setup Well, sample name, sample color, and target name of samples in
the plate

Raw data Raw fluorescence data for each filter, for each cycle
Amplification data Amplification results, such as Ct values, Rn, or ARn
Multicomponent data Fluorescence data for each dye, for each cycle
Results Results information, such as Ct values, Rn, or calls
Technical Replicate Results (Tech. | Technical replicates information, such as Sample name, Target
Rep. Results) name, Task, or RQ
Biological Replicate Results (Bio. | Biological replicates information, such as Biogroup name, Target
Rep. Results) name, Task, or RQ
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Note: Results data are not available for export until the run status is complete and the data are
analyzed.

Note: The Technical Replicate Results and Biological Replicates Results are available only in
Relative Standard Curve and Comparative Ct experiments.

7. (Optional) For Standard Curve experiments, select the external application, CopyCaller™ Software,
if the software is installed on your computer.

8. (Optional) After you have defined the export properties or after moving the table headings order,
you can save those export settings as an export set by clicking Save Export Set As. Later you can
import the heading order into another file by clicking Load Export Set. You can also delete export
settings by clicking Delete Export Set.

Note: It is advisable to keep the default order of the table headings if you are using CopyCaller™
Software for further analysis.

9. Click Start Export.
The Export screen for a Standard Curve experiment is shown in the following graphic:

The exported file when opened in Notepad appears as shown in the following graphic:
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Experiment shortcuts

This chapter provides you with shortcuts to use in the QuantStudio™ 12K Flex Software after you have
learned experiment basics.

You can reuse experiment settings and plate setup information by: directly importing and editing a
template, using the QuickStart feature with a template, importing experiment setup information, or
importing a sample definition file; you can also prepare several experiments at once or create a new
experiment using the ReadiApp feature.

Create an experiment from a template

You can use a template to create a new experiment. Templates are useful when you want to create
many experiments with the same experiment parameters.

You can create an experiment from a template from the QuantStudio™ 12K Flex Software and from the
instrument touchscreen.

Note: To access the software example templates, navigate to one of the following folders, where <...>

is the installation drive. The default installation drive is C: if the software is installed by the customer.

The default installation drive is D: if the software is installed by a Thermo Fisher Scientific field service

engineer.

. QuantStudio™ 12K Flex Software v1.7 and later—<..>: \Program Files\Applied
Biosystems\QuantStudio 12K Flex Software\templates

. QuantStudio™ 12K Flex Software v1.6 and earlier—<..>:\Program Files (x86) \Applied
Biosystems\QuantStudio 12K Flex Software\templates

Create a template

1. In the QuantStudio™ 12K Flex Software Home screen, open an existing experiment, or create a
new experiment.

Note: To create a new experiment using the Experiment Setup, see “Set up an experiment” on
page 18.

2. Select File » Save As Template.
3. Enter a file name, select a location for the template, then click Save.
4. Click Close.

You can use that experiment as a template for similar experiments.
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Create a new experiment using a template

1.

2.

4.

From the Home screen, click Create From Template.

Locate and select the template file, then click Open.
A new experiment is created using the setup information from the template.

Edit the experiment properties, plate definitions, plate assignments, and run method before you
prepare the reactions and run the experiment.

Proceed to preparing reactions, running the experiment, and analyzing the data.

Create an experiment using a template on the instrument touchscreen

You can run experiments using templates from the instrument touchscreen by importing the templates
from the QuantStudio™ 12K Flex Software instrument console or a USB drive. You can also modify the
experiment parameters in the templates as per your requirement.

Run a pre-existing template

1.

2.

In the Home screen of the instrument touchscreen, touch View Template.
Select a pre-existing template from the templates list on the View Templates screen.
Touch  View to see the run profile before you start a run.

After confirming the template setup is correct, touch  (Back) to go back to View Templates
screen.

Touch Start Run.

Edit a template before running the experiment

1.

74

Touch g New on the View Templates screen to create a new experiment from the existing
template.

Note: Select a template before you touch New.

Edit the experiment parameters in the Create New Experiment screen.

Select one of the following options.

¢ Touch Save & Exit to save and exit the experiment.
e Touch Save & Start Run to save and start the experiment run.
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Use the QuickStart feature to start an experiment

You can use a template to run an experiment with the QuantStudio™ 12K Flex Software QuickStart
feature.

Use the QuickStart feature from the QuantStudio™ 12K Flex Software

1.

2.

Prepare the reactions.
Log in to the QuantStudio™ 12K Flex Software.

In the Home screen, click  96/384/Array Cards to access the Run 96/384/Array Cards dialog
box.

Enter or select the following information.
a. Instrument icon of the instrument to perform the run on.

b. Experiment name.
c. Experiment location.
d. Experiment template file.

e. (Optional) Barcode, User Name, and Comments for the experiment.
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5. (Optional) To review the experiment or to make changes to any of the experiment parameters, click
Experiment Setup.

Figure 6 96/384/Array Cards dialog box

6. Proceed to running the experiment and analyzing the data.

QuickStart feature from the instrument touchscreen

You can use the QuickStart feature to start an experiment from the instrument touchscreen in the
following ways:

¢ Start an experiment using a pre-defined template
e Start an experiment with a pre-defined short-cut button

Start an experiment using a pre-defined template

You can use a pre-existing template from the default experiments folder or use a custom template from
another folder to start a run.
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Start an experiment with a pre-defined short-cut button

The instrument touchscreen displays up to 18 shortcut buttons to templates or folders that contain
experiments to be run. The shortcut buttons are present under My Shortcuts on the Home screen. To
start a run, touch any of the predefined experiment or folder buttons.

1. Touch Settings to open the Settings menu.
2. Touch Set Up Shortcuts to list the shortcut targets.

3. On the Shortcut Targets screen, select an existing template Shortcut Target button or an unused
button.

4. Touch Set Shortcut. If you selected an unused button, then touching Set Shortcut will list out the
templates and folders to set the shortcut for.

5. Under the = From Templates tab, select the templates for which you are creating the shortcut
button.

6. (Optional) Create a shortcut button to show the templates or experiments in a particular folder for
quick access, from those listed under the From Folders tab. You can touch Edit to create or edit
shortcut buttons.

Import plate setup for an experiment

You can import the plate setup for a new experiment from an exported file with one of the following
formats:

® TXT—Text format

¢ XML—XML format

® (CSV—Comma separated values format

* SDT—Sequence detecting system (sds) template files format
e SDS—7900 v2.3 format

IMPORTANT! Make sure the file you select contains only plate setup data and that the experiment
types match.

Note: For instructions on exporting an experiment, see “Export an experiment” on page 68.

1. Create a new experiment or open an existing experiment.

2. In the Experiment Setup screen, select File » Import Plate Setup or access the Import dropdown
list in the toolbar, then select Import Plate Setup.
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3. Click Browse, locate and select the file to import, then click Select.

4. Click Start Import. The setup data from the exported text file is imported into the open
experiment.

Note: If your experiment already contains plate setup information, the software asks if you want to
replace the plate setup with the data from the import file. Click Yes to replace the plate setup.

5. After importing plate setup information, use Experiment Setup to set up your experiment, and
then run the experiment.

Note: You can import plate setup information from a 96-well plate into a 384-well plate, provided
that the file you are importing the information from is a TXT file.

Import sample information

You can import sample information from a sample definition file to include in the plate setup for your
experiment. A sample definition file is a comma-delimited file (CSV) or a tab-delimited text file (TXT) that
contains the following setup information: well number, sample hame, and custom sample properties.

Note: Make sure that the sample definition file you select contains only sample information.

Create a sample definition file
1. Open a text editing program, for example, Notepad.

2. Enter the following column headers in the first row (press the Tab key between each entry if you are
saving the file as TXT or enter a comma between each entry if you are saving the file as CSV):

o Well
* Sample Name

® (Optional) Column header names for up to six user-defined custom fields (for example,
Custom 1, Custom 2, etc.)
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For each subsequent row, enter the well number, press the Tab key or enter a comma, then enter
the sample name. Optionally, press the Tab key, then enter the custom properties for the sample.

Save the file with the TXT or CSV file extension.
An example sample definition, saved with the CSV extension, file looks like this:

Import sample information from a sample definition file

1.

Create a new experiment or open the experiment to receive the setup data (select File » Open,
select the file to open, then click Open).

From the open experiment, select File » Import Plate Setup.

Click Browse to browse your computer for a sample definition text file (CSV). After you locate the
file and select it, click Select.

Click Start Import.

If your experiment already contains plate setup information, the software asks you if you want to
replace the plate setup with the data from the file. Click Yes to replace the plate setup information.

The samples appear in the Samples table for the experiment. All samples and well assignments in the
experiment are replaced with those in the file. If defined, the custom sample properties also appear in
the Well Table of the Analysis section, and also in the Plate Layout tooltips in both the Setup screen
and the Analysis screen. The custom fields can be exported with the results data.
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Note: You cannot edit the custom sample properties from within the Well Table. To modify this
information, edit the custom fields in the sample definition file and import the file again. All of the
sample information in the experiment is replaced with the information in the new file.

The Assign screen with information from the above sample definition file looks like this:

The Well Table in the Analysis section looks like this:
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Use a template to create a batch of experiments

82

Use the batch experiment utility to create multiple experiment files from the same template without
using the Experiment Setup.

1. In the menu bar, select Tools » Batch Experiment Setup.

Figure 7 Batch Experiment Setup Utility dialog box

2. Select the file or the files to use to create the new experiments.

a.

For multi-well plate, array card experiments, or experiments that use sample integration, click
Browse in the Experiment Template File field.

Locate an EDT file to import, then click Select.

For OpenArray™ experiments, click Browse in the Experiment Template File field or in the
Setup File Folder field.

Locate either an EDT file (template) or an SPF or a TPF file to import, then click Select.
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e. (Optional) Repeat steps 2a on page 82 and 2b on page 82 for the remaining setup file types
to import Assay Information File (AIF), Plate Setup File (TXT)).

3. Select the option to create experiment files. The selected option determines the number of
experiment files created.

* Specify Number of Files field—Enter a number from 1 to 100.

¢ Barcode radio button—Click Browse, then select a barcode file (TXT) to import. The software
automatically adds the Plate Barcode attribute to the file name format. The number of
experiments created equals the number of barcodes present in the barcode file.

Note: A barcode file contains one barcode per line.

Figure 8 Example barcode file
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4.

(Optional) Edit the file name format. Use the File Name Preview to verify your settings.

® Select the check box to include or exclude the Custom Name Field_Plate Barcode attribute
from the file name. If included, click the Custom Name Field, then enter up to 100 letters
and/or numbers to identify the batch of experiments.

Note: The file name can contain a total of 100 characters, including all file name attributes.

* (Click Move Up or Move Down to change the order of the selected file name attributes.

Select the Sample Files folder.

a. Click Browse, then locate and select a folder. Refer to the Expected Sample File Name for
an example of a file name.

b. Click Validate to visually check that experiment files are matched to sample files. If they do
not match, the Matching Sample File shows the missing file as Not found in red.

Select the location for the experiment files to be created:
a. Click Browse in the Export Setup Files To: field.

b. Review the location for the experiment files. Navigate to a new location if you do not want to
export the experiment files to that folder, then click Select.

Click Create Experiments.
A confirmation message is displayed when the batch of experiments has been created.

Create an experiment using the ReadiApp feature

84

You can use the ReadiApp feature to set up an experiment in the QuantStudio™ 12K Flex Software.
The ReadiApp feature provides a shortcut to create experiments for the assays purchased from Thermo
Fisher Scientific.

The default templates available in the QuantStudio™ 12K Flex Software include:

High Resolution Melting (HRM)

TagMan™ Gene Expression Assay

TagMan™ MicroRNA Assay

Custom TagMan™ Array Card

TagMan™ SNP Genotyping Assay

TagMan™ Copy Number Assay

TagMan™ Drug Metabolism Genotyping Assay
TagMan™ MicroRNA Assay (TagMan™ Array Card)

- Log in to the QuantStudio™ 12K Flex Software and, from the Tools menu on the Home screen, click

ReadiApp.

Click the assay to use to set up an experiment.

Note: Click Cancel to exit the ReadiApp dialog box.
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A new experiment is created using the setup information from the template.
3. (Optional) Edit the experiment properties.

4. Proceed to preparing reactions, running the experiment, and analyzing the data.
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About standard curve experiments

IMPORTANT! First-time users of the QuantStudio™ 12K Flex Real-Time PCR System, see the part
“Getting started” on page 17 and Appendix A, “Documentation and support”. The sections provide
information and general instructions that are applicable to all the experiments described in this
document.

Note: For more information about any of the topics discussed in this guide, access the Help from
within the QuantStudio™ 12K Flex Software by pressing F1, clicking  in the toolbar, or selecting
Help » QuantStudio 12K Flex Software Help.

Before you begin

The Standard Curve method is used for determining absolute target quantity in samples. With the
standard curve method, the software measures amplification of the target in samples and in a standard
dilution series. Data from the standard dilution series are used to generate the standard curve. Using
the standard curve, the software interpolates the absolute quantity of target in the samples.

Assemble required components

Sample —The tissue group that you are testing for a target gene.

Standard —A sample that contains known quantities of the target; used in quantification
experiments to generate standard curves.

Standard dilution series —A set of standards containing a range of known quantities. The
standard dilution series is prepared by serially diluting standards.

Replicates —The total number of identical reactions containing identical samples, components,
and volumes.

Negative Controls —Wells that contain water or buffer instead of sample template. No
amplification of the target should occur in negative control wells.

PCR Options

When performing real-time PCR, choose between:

Singleplex PCR and multiplex PCR (see “Singleplex and multiplex PCR” on page 88)

and

1-step RT-PCR and 2-step RT-PCR (see “1- and 2-step RT-PCR” on page 88)
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Singleplex and multiplex PCR

You can perform a PCR reaction using either:
* Singleplex PCR—In singleplex PCR a single primer set is present in the reaction tube or well. Only
one target or endogenous control can be amplified per reaction.
or
¢ Multiplex PCR—In multiplex PCR, two or more primer sets are present in the reaction tube or well.
Each set amplifies a specific target or endogenous control.

One example is a probe that is labeled with FAM™ dye detects the target and a probe that is
labeled with VIC™ dye detects the endogenous control.

IMPORTANT! SYBR™ Green reagents cannot be used for multiplex PCR.

1- and 2-step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in separate reactions
(2-step). The reagent configuration you use depends on whether you are performing 1- or 2-step
RT-PCR.

¢ 1-step RT-PCR—In 1-step RT-PCR, RT and PCR take place in one buffer system. Using one
buffer system provides the convenience of a single-tube preparation for RT and PCR amplification.
However, you cannot use Fast PCR master mix or the carryover prevention enzyme, AmpErase™
UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

e 2-step RT-PCR—2-step RT-PCR is performed in two separate reactions: First, total RNA is
reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful for
detecting multiple transcripts from a single cDNA template or for storing cDNA aliquots for later
use. The AmpErase™ UNG enzyme can be used to prevent carryover contamination.

Note: The Standard Curve example experiment is designed for singleplex PCR, where every well
contains a primer/probe set for a single target; the reactions are set up for a 2-step RT-PCR.
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About the example experiment

To illustrate how to perform Standard Curve experiments, this guide leads you through the process of
designing and performing an example experiment. The example experiment represents a typical setup
that you can use to quickly familiarize yourself with the QuantStudio™ 12K Flex Real-Time PCR System.

The objective of the Standard Curve example experiment is to determine the quantity of the RNase P
gene in two populations.

In the standard curve example experiment:

The samples are genomic DNA isolated from two populations.
The target is the RNase P gene.

One standard curve is set up for the RNase P gene (target). The standard used for the standard
dilution series contains known quantities of the RNase P gene. Because a single target is being
studied, only one standard curve is required.

IMPORTANT! In experiments where multiple targets are being studied, a standard curve is
required for each target.

The Standard Curve is a five-point dilution with 16 technical replicates per point.

The experiment is designed for singleplex PCR, where every well contains a primer/probe set for a
single target.

Reactions are set up for 2-step RT-PCR.
Primer/probe sets are from an Applied Biosystems™ RNase P assay.

Note: The human RNase P FAM™ dye-labeled MGB probe is not available as a TagMan™
Gene Expression Assay. It can be ordered as a Custom TagMan™ Gene Expression Assay (Cat.
No. 4331348).
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Design the experiment

This chapter explains how to design the example experiment from the Experiment Setup menu.

Note: To automatically export the analyzed data to a specified location, select the Auto Export task
from the Export screen, before running the experiment. For more information about Auto Export, see

the part “Getting started” on page 17.

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the QuantStudio™

12K Flex Software.

Field or selection

Entry

Experiment Name field

384-Well Fast Standard Curve Example

Barcode field

Leave field empty

User Name field

Example User

Comments field

Standard Curve example

Block

384-Well

Type of experiment

Standard Curve

Reagents

TagMan Reagents

Properties

Fast

Save the experiment.
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Figure 9 Experiment Properties screen
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Define targets, samples, and biological replicates

1. Click Define to access the Define screen.

2. Enter the following target information.

| ZL

Target name

Reporter

Quencher

Color

RNaseP

FAM

NFQ-MGB
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3. Enter the following sample information.

Sample name Color

A

4. In the Passive Reference dropdown list, select ROX .

Pop1

Figure 10 Define screen

Note: This example experiment does not define biological replicate groups. Leave the Biological
Replicate Groups pane blank.
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Assign targets, samples, and biological groups

1. Click Assign to access the Assign screen.

2. Define and set up standards.
a. In the Assign screen, click Define and Set Up Standards.

b. In the Define and Set Up Standards dialog box, in the Select a target for this standard
curve dropdown list, select RNaseP.

c. Define the standard curve.

Field Enter
# of Points field 5
# of Replicates field 16
Starting Quantity field 1250.0
Serial Factor field 2x

d. In the Use Wells section, select the Let Me Select Wells radio button.

e. Click Apply, then click Close.

Figure 11 Define and Set Up Standards dialog box
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3. Assign targets and samples.

Target name Well number Task Quantity Sample name
RNaseP A1 - P1 (column 1) Negative None None
RNaseP A2 - P2 (column 2) Standard 1250 None
RNaseP A3 - P3 (column 3) Standard 2500 None
RNaseP A4 - P4 (column 4) Standard 5000 None
RNaseP A5 - P5 (column 5) Standard 10000 None
RNaseP A6 - P6 (column 6) Standard 20000 None
RNaseP A7 - P15 (columns 7 - 15) Unknown | Determined by run Pop1
RNaseP A16 - P24 (columns 16 - 24) Unknown | Determined by run Pop2

Figure 12 Assign screen
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Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View

tab. Enter the following information:
¢ Reaction Volume Per Well: 20 uL
® Thermal Profile

Stage Step | Ramp rate | Temperature Time

Hold Stage Step1| 1.9°C/s 95°C 20 seconds
PCR Stage Step1| 1.9°C/s 95°C 1 second
Number of Cycles: 40 (default)
Enable AutoDelta: Unchecked (default) Step 2| 1.6°C/ 60° 20 q
Starting Cycle: Disabled when Enable AutoDelta is tep 0°C/s ¢ seconds
unchecked
Figure 13 Run Method screen
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More information

Information Reference
Consumables Chapter 1, “General information and instructions”
Using other quantification methods * “Running relative standard curve experiments” on page 145

*  “Running comparative Ct experiments” on page 198

Using alternative setup Chapter 2, “Experiment shortcuts”
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Prepare the reactions

This chapter explains how to prepare the PCR reactions for the Standard Curve example experiment.

Assemble required materials

* [tems listed in the part “Getting started” on page 17
® Samples - Human Raji cell line-derived cDNA samples (100 ng/uL)

* Example experiment reaction mix components:
— TagMan™ Fast Universal PCR Master Mix

— TagMan™ RNase P Detection Reagents Kit (Cat. No. 4316831)

Prepare the sample dilutions

To determine the quantity of the RNase P gene in the example experiment, dilute the samples (as
directed below) before adding the samples to the final reaction mix.

The stock concentration of each sample is 100 ng/pL. After dilution, the sample Pop1 has a
concentration of 6.6 ng/uL and Pop 2 has a concentration of 3.3 ng/uL. Add 2L to each reaction.

Use this table for sample dilution volumes for the example experiment.

Sample name | Stock concentration | Sample volume | Diluent volume | Total volume of diluted sample
Pop1 100.0 ng/uL 25 uL 355 L 380 pL
Pop2 100.0 ng/pL 12.5 uL 367.5uL 380 pL

Note: For your own experiment, adjust the input amounts of the template depending on the template
type and target abundance.

1. Label a separate microcentrifuge tube for each diluted sample:

* Popi
* Pop?2

2. Add the required volume of water (diluent) to each empty tube.

Tube Sample name Diluent volume
1 Pop 1 355 pL
2 Pop 2 367.5 pL
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3. Add the required volume of sample stock to each tube.

Tube Sample name Sample volume
1 Pop 1 25 L
2 Pop 2 12.5uL

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the standard dilution series

The standard concentration in stock is 20,000 copies/pL.

Standard name Dilution Source Diluent Total Standard
. Source .
(labeled tube) point volume volume volume concentration
RNase P Std. 1 1 (20,000) Stock 18 uL 18 uL 36 uL 10,000 copies/uL
RNase P Std. 1 2 (10,000) |Dilution 1 18 yL 18 L 36 pL 5,000 copies/pL
RNase P Std. 1 3 (5,000) |Dilution 2 18 pL 18 pL 36 pL 2,500 copies/uL
RNase P Std. 1 4 (2500) Dilution 3 18 uL 18 L 36 pL 1,250 copies/pL
RNase P Std. 1 5 (1250) Dilution 4 18 L 18 L 36 L 625 copies/pL

1. Prepare five standard dilutions.

Note: For dilution 1, first vortex the stock for 3 to 5 seconds, then centrifuge the RNase P Std. 1

tube briefly before pipetting stock into the tube.

Perform the following steps for each dilution:

a. Use a new pipette tip to add 18 pL of source to the tube containing the standard.

b. Vortex the tube for 3 to 5 seconds, then centrifuge the tube briefly.

2. Place the standards on ice until you prepare the reaction plate.
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For the RNase P assay (Standard Curve example experiment), the following table lists the universal
assay conditions (volume and final concentration) for using the TagMan™ Fast Universal PCR Master

Mix.
Reaction component Volume for 1 reaction | Volume for 384 reactions + 10% excess
TagMan™ Fast Universal PCR Master Mix 5L 2,112 yL
RNase P Assay (20 X) 0.5 L 2,11.2 yL
Water 3.5l 1,478.4 uL
Total reaction mix volume 9uL 3,801.6 pL

1. Label an appropriately sized tube for the reaction mix: RNase P Reaction Mix.

2. Add the required volumes of each reaction mix component to the tube.

Note: Do not add the sample or standard at this time.

3. Mix thoroughly by gently pipetting up and down several times, then cap the tube.

4. Centrifuge the tube briefly to remove air bubbles.

5. Place the reaction mix on ice until you prepare the reaction plate.

Note: You can separately add the sample to the reaction plate, as opposed to preparing individual

reaction mixes for each sample.

Prepare the reaction plate

Example experiment reaction plate components

The reaction plate for the Standard Curve example experiment contains:
* A MicroAmp™ Optical 384-Well Reaction Plate

* Reaction volume: 10 pL/well
e 288 Unknown wells ()

e 80 Standard wells (K1)

* 16 Negative Control wells ()
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Prepare the reaction plate

Figure 14 Plate layout

Prepare the reaction plate components

1. Prepare the negative control reactions for the target.
a. To an appropriately sized tube, add the volumes of reaction mix and water listed below.

: . Reaction mix volume (includes Water volume (includes 10%
Tube Reaction mix
10% overage) overage)
1 RNase P reaction mix 157.5 pL 17.5 yL

b. Mix the reaction by gently pipetting up and down, then cap the tube.
c. Centrifuge the tube briefly to remove air bubbles.

d. Add 10 pL of the negative control reaction to the appropriate wells in the reaction plate.
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2. For each replicate group, prepare the standard reactions.
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Chapter 5

Prepare the reaction plate

a. To appropriately sized tubes, add the volumes of reaction mix and standard listed below.

Reaction mix
. . . volume Standard
Tube | Standard reaction Reaction mix . Standard
(includes 10% volume
overage)
1 RNase P Std 1 RNase P reaction 157.5 yL RNase P Std 1 17.5 uL
mix
2 RNase P Std 2 RNase P reaction 157.5 yL RNase P Std 2 17.5 uL
mix
3 RNase P Std 3 RNase P reaction 157.5 yL RNase P Std 3 17.5 uL
mix
4 RNase P Std 4 RNase P reaction 157.5 yL RNase P Std 4 17.5puL
mix
5 RNase P Std 5 RNase P reaction 157.5 yL RNase P Std 5 17.5 uL
mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 pL of the standard reaction to the appropriate wells in the reaction plate.

3. For each replicate group, prepare the reactions for the unknowns.

a. To appropriately sized tubes, add the volumes of reaction mix and sample listed below.

Reaction mix Sample volume
Tube | Unknown reaction Reaction mix volume (includes |Sample P
0 (WL)
10% excess)
1 RNase P pop1 RNase P reaction 1,422 pL pop1 158 pL
mix
2 RNase P pop2 RNase P reaction 1,422 pL pop2 158 pL
mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 pL of the unknown (sample) reaction to the appropriate wells in the reaction plate.

4. Seal the reaction plate with optical adhesive film.

5. Centrifuge the reaction plate briefly to remove air bubbles.
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For more information
6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the
reaction plate again at a higher speed and for a longer period of time.

7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

For more information

Information Reference
Assigning the reaction plate components Chapter 1, “General information and instructions”
Sealing the reaction plate Chapter 1, “General information and instructions”
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Run the experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K Flex Real-Time
PCR Instrument.

IMPORTANT! Run the experiment at the same ambient temperature at which you calibrated the
instrument. Extreme variations in ambient temperature can affect the heating and cooling of the
instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the
instrument is in operation.

Start the run

1. Open the Standard Curve example file that you created using instructions in Chapter 4, “Design
the experiment”.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the run

You can monitor an experiment run in three ways:
* From the Run screen of the QuantStudio™ 12K Flex Software, while the experiment is in progress

* From the Instrument Console screen of the QuantStudio™ 12K Flex Software, to monitor an
experiment started from another computer or from the instrument touchscreen (see “Monitor a run
from the software Instrument Console screen” on page 103)

* From the instrument touchscreen (see “Monitor a run from the instrument touchscreen” on
page 108)

Monitor a run from the software Instrument Console screen

1. In the Instrument Console screen, select the icon of the instrument that you are using to run the
experiment.

2. Click Manage Instrument or double-click on the instrument icon.
3. In the Instrument Manager screen, click Monitor Running Experiment to access the Run

screen.
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View the amplification plot

You can view the progress of the run in real time. During the run, periodically view all the three plots
available from the QuantStudio™ 12K Flex Software for potential problems.

Click Ampilification Plot from the Run Experiment menu, select the Plate Layout tab, then select the
wells to view.

Figure 15 The Amplification Plot screen as it appears at the end of the example experiment
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View the temperature plot

Click Temperature Plot from the Run Experiment menu.

Figure 16 The Temperature Plot screen as it appears during the example experiment

Note: The sample temperature displayed in the Current Temperatures group is an estimated value.
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View the run method

Click Run Method from the Run Experiment menu.

Figure 17 The Run Method screen as it appears in the example experiment
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View the run data

Click View Run Data from the Run Experiment menu.

Run Data Report

Experiment Name:
Start Time:

Stop Time:

Run Duration:

User Name:
Instrument Name:
Firmware Version:
Software Version:
Instrument Serial Number:
Sample Volume:
Cover Temperature:

Block Type:

Errors Encountered:

384-Well Fast Standard Curve Example
08-06-2011 12:33:30 5GT
08-06-2011 13:15:47 5GT

42 minutes 17 seconds

DEFAULT

QuantStudioDemo

0.13.1

QuantStudio 12K Flex Software v1.0
QuantStudioDemo

20.0

105.0

384-Well Block

Figure 18 The View Run Data screen as it appears in the example experiment
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Monitor a run from the instrument touchscreen

You can view the progress of the run from the instrument touchscreen.

The following figures are for visual representation only. Actual results vary with the experiment.

Figure 19 Experiment View tab
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Figure 20 Time View tab

Figure 21 Plot View tab
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Review results and adjust
experiment parameters

The following topics are covered in this chapter:

* Review the analyzed data using several of the analysis screens and publish the data (see “Review
results” on page 110)

* Modify experiment parameters to troubleshoot problems with experiment results before rerunning
an experiment (see “Adjust parameters for re-analysis of your own experiments” on page 135)

Review results

Analyze the example experiment

1. Open the example experiment file.
See Chapter 6, “Run the experiment”.

2. Click Analyze.

Note: You can also access the experiment to analyze from the Home screen.

The software analyzes the data using the default analysis settings.

View the standard curve plot

The Standard Curve Plot screen displays the standard curve for samples designated as standards. The
QuantStudio™ 12K Flex Software calculates the quantity of an unknown target from the standard curve.
Purpose

The purpose of viewing the standard curve for the example experiment is to identify the following items:
* Slope and amplification efficiency
* R? value (correlation coefficient)

® (Cyvalues

View and assess the standard curve plot

1. From the Experiment Menu pane, select Analysis » Standard Curve.

Note: If no data are displayed, click Analyze.
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2. Display all 384 wells in the Standard Curve Plot screen by clicking the upper left corner of the plate

layout in the Plate Layout tab.

3. Enter the plot settings.

Menu Selection
Target All
Plot Color Target

— Check (default)
(This is a toggle button. When the legend is displayed, the button changes to Hide the
plot legend).
4. View the values displayed below the standard curve.
Menu Selection
Slope -3.372
R2 0.994
Amplification efficiency 97.944%
Error 0.03

5. Check that all samples are within the standard curve.

In the example experiment, as shown below, all samples (blue dots) are within the standard curve

(red dots).
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6. Check the Ct values.
a. Click the Well Table tab.

b. From the Group By menu, select Replicate.
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c. Look at the values in the Ct column.

Chapter 7 [
Review results

In the example experiment, the Ct values fall within the expected range (>8 and < 35).

Expand il

YT

* Well | Omit Flag Sample ...| Target ... | Task Dyes ct CT Mean | CT SD Quantity | Quantit.. Quantit... = MOISE ou

e
7 AT | Popl RNaseP UNKNOWN  FAM-NFQ-... 27.110 27.096 0.140 5,015.352  5,090.081 5683.712
8 A8 " | Popl RHzseP UNKNOWN  FAM-NFQ-... 27.005 27.096 0.140 5,387.923 5,000.081 565.712
9 A9 O Popl RHasep UNKNOWN ~ FAM-NFQ-... 26.937 27.096 0.140 5,645.138 5,090.081 565.712
10 AL0 O POp1 RHaseP UNKNOWN  FAM-NFQ-... 27.063 27.096 0.140  5,181.675 5,030.081 565.712
11 AlL " Popl RHasep UNKNOWN ~ FAM-NFQ-... 26.921 27.096 0.140 5,708.588 5,090.081 565.712
12 A12 [~ | Popl RHaseP UNKNOWN  FAM-NFQ-... 26.999 27.096 0.140 5,412.582 5,090.081 565.712
13 AL3 - POp1 RHaseP UNKNOWN ~ FAM-NFQ-... 26.953 27.096 0.140  5,584.070 5,090.081 565.712
14 Al4 O Popl RlaseP UNKNOWN ~ FAM-MFQ-... 27.034 27.0%6 0.140 5,284.767 5,090.081 565.712
15 Al15 [~ | Popl RlaseP UNKNOWN  FAM-NFQ-... 26.838 27.096 0.140 6,041.067 5,090.081 565.712
31 B7 | Popl RNaseP UNKNOWN  FAM-NFQ-... 27.079 27.096 0.140 5,124.039 5,050.081 563.712
32 B8 [~ | Popl RlaseP UHKNOWN ~ FAM-NFQ-... 27.167 27.096 0.140 4,824.094 5,000.081 565.712
33 B9 " | Popl RHzseP UNKNOWN  FAM-NFQ-. 27.096 0.140  5,200.990  5,000.081 565.712
34 Bl10 | Popl RNaseP UNKNOWN  FAM-MFQ-. 27.096 0.140 4,706.999 5,090.081 563.712
35 Bl " | Popl RHzseP UNKNOWN  FAM-NFQ-. 27.096 0.140  5,330.722 5,000.081 565.712
36 Bl12 O Popl RHasep UNKNOWN  FAM-NFQ-. 27.096 0.140 5,058.768 5,090.081 565.712
37 Bl13 | Popl RNaseP UNKNOWN  FAM-MFQ-... 27.099 27.096 0.140 5,052.877 5,090.081 563.712
38 Bl4 " | Popl RHaseP UNKNOWN ~ FAM-NFQ-... 27.011 27.096 0.140  5,366.522 5,000.081 565.712
3% B15 O Popl RlaseP UNKNOWN ~ FAM-MNFQ-... 27.103 27.0%6 0.140 5,041.529 5,090.081 565.712
55 C7 O Popl RHaseP UNKNOWN  FAM-NFQ-... 27.045 27.096 0.140  5,242.704  5,030.081 565.712
56 C8 O Popl RlaseP UNKNOWN ~ FAM-MNFQ-... 27.182 27.0%6 0.140 4,775.204 5,090.081 565.712
57 C9 [~ | Popl RlaseP UNKNOWN  FAM-NFQ-... 27.222 27.096 0.140 4,646.954 5,000.081 565.712
58 C10 | Popl RNaseP UNKNOWN  FAM-NFQ-... 27.153 27.096 0.140 4,871.199 5,090.081 563.712
59 Ci1 [~ | Popl RHaseP UNKNOWN  FAM-NFQ-... 27.253 27.096 0.140 4,548.860 5,090.081 565.712
60 Ci2 " | Popl RHaseP UHKNOWN  FAM-NFQ-... 27.217 27.096 0.140 4,664.264 5,090.081 565.712
61 C13 | Popl RNaseP UNKNOWN  FAM-NFQ-... 27.228 27.096 0.140 4,628.641 5,090.081 565.712
62 C14 " | Popl RHaseP UHKNOWN  FAM-NFQ-... 27.272 27.096 0.140 4,492.085 5,090.081 565.712
63 C15 " | Popl RHaseP UNKNOWN ~ FAM-NFQ-... 27.320 27.096 0.140 4,320.416 5,000.081 565.712
72 D7 | Popl RHaseP UNKNOWN  FAM-MFQ-... 27.036 27.096 0.140 5,277.137  5,090.081 563.712
80 D8 " | Popl RHaseP UNKNOWN ~ FAM-NFQ-... 27.101 27.096 0.140  5,048.800 5,000.081 565.712
81 D9 O Popl RHasep UNKNOWN  FAM-NFQ-... 27.142 27.096 0.140  4,508.571 5,090.081 565.712
82 D10 O Popl RHaseP UNKNOWN  FAM-NFQ-... 27.198 27.096 0.140  4,722.698  5,030.081 565.712
83 DI1L O Popl RHasep UNKNOWN ~ FAM-NFQ-... 27.073 27.096 0.140  5,146.530 5,080.081 565.712
B84 D12 [~ | Popl RHaseP UNKNOWN  FAM-NFQ-... 27.266 27.096 0.140 4,508.289 5,090.081 565.712

85 D13 - Popl RliaseP UNKNOWN  FAM-NFQ-... 26.935 27.096 0.140  5651.525 5,030.081 565.712 3

il >
‘Wel Summary: In Plate: 384 Set Up: 384 Aralyzed: 384 Flagged: 4 Omitted by Analyss: 0 Omitted Manualy: 0 Samples Used: 2 Targets Used: 1

Tips for analyzing your own experiments

When you analyze your own standard curve experiment, look for the following items:

* Slope and amplification efficiency values —The amplification efficiency is calculated using the
slope of the regression line in the standard curve. A slope close to —-3.3 indicates optimal, 100%
PCR amplification efficiency. The following factors affect amplification efficiency:

— Range of standard quantities—For accurate and precise efficiency measurements, use a broad
range of standard quantities, 5 to 6 logs (10° to 10° fold).

— Number of standard replicates—For accurate efficiency measurements, include replicates to
decrease the effects of pipetting inaccuracies.

- PCR inhibitors—PCR inhibitors in the reaction can reduce amplification efficiency.

* R2values (correlation coefficient)—The R? value is a measure of the closeness of fit between the
regression line and the individual Ct data points of the standard reactions. A value of 1.00 indicates
a perfect fit between the regression line and the data points. An R? value >0.99 is desirable.

® Cyvalues—The threshold cycle (Cy) is the PCR cycle number at which the fluorescence level

meets the threshold.

— A Cyvalue >8 and <35 is desirable.

— A Cq value <8 indicates that there is too much template in the reaction.

— A Gy value >35 indicates a low amount of target in the reaction. For Ct values >35, expect a

higher standard deviation.
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If your experiment does not meet the guidelines above, troubleshoot as follows:

*  Omit wells (see “Omit wells to improve CT precision” on page 140).
Or

* Rerun the experiment.

Assess amplification results using the amplification plot

Amplification plots available for viewing
The Ampilification Plot screen displays amplification of all samples in the selected wells. There are
three plots available:

* ARn vs Cycle—ARn is the magnitude of normalized fluorescence signal generated by the reporter
at each cycle during the PCR amplification. This plot displays ARn as a function of cycle number.
Use this plot to identify and examine irregular amplification and to view threshold and baseline
values for the run.

* Rn vs Cycle—Rn is the fluorescence signal from the reporter dye normalized to the fluorescence
signal from the passive reference. This plot displays Rn as a function of cycle number. Use this plot
to identify and examine irregular amplification.

®* Cyvs Well-C+ is the PCR cycle number at which the fluorescence meets the threshold in the
amplification plot. This plot displays Ct as a function of well position. Use this plot to locate
outlying amplification (outliers).

Each plot can be viewed as a linear graph or a log10 graph.

Purpose

The purpose of viewing the amplification plot for the example experiment is to identify:
* Correct baseline and threshold values
¢ CQutliers

View the amplification plot

1. In the Experiment Menu pane, click Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Display the RNase P wells in the Amplification Plot screen. Click the Plate Layout tab. Enter the
Plot Settings.

a. Select the Plate Layout tab.
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b. In the Select Wells dropdown list, select Target » RNaseP.

3. In the Amplification Plot screen, select the following.

Item Select
Plot Type dropdown list ARn vs Cycle
Plot Color dropdown list Well (default)

Check (default)

(This is a toggle button. When the legend is displayed, the button changes to Hide the
plot legend).

4. View the baseline values.
a. From the Graph Type dropdown list, select Linear.

b. Select the Baseline checkbox to show the start cycle and end cycle.
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c. Confirm that the baseline is set correctly. The end cycle should be set a few cycles before the
cycle number where significant fluorescent signal is detected. In the example experiment, the
baseline is set correctly.

5. View the threshold values.

ltem Select
Graph Type dropdown list Log
Target dropdown list RNaseP

a. Select the Threshold check box to show the threshold.
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b. Confirm that the threshold is set correctly. In the example experiment, the threshold is in the
exponential phase.

6. Locate outliers.
a. In the Plot Type dropdown list, select Ct vs. Well.
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b. Look for outliers from the ampilification plot. In the example experiment, there are no outliers
for RNase P.

Tips for analyzing your own experiments
When you analyze your own standard curve experiment, look for the following items:

* Outliers

¢ A typical amplification plot—The QuantStudio™ 12K Flex Software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a typical amplification
plot. A typical amplification plot has four distinct sections:

— Plateau phase
— Linear phase
— Exponential (geometric phase)

— Baseline
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Figure 22 Typical amplification plot

IMPORTANT! Experimental error (such as contamination or pipetting errors) can produce
atypical amplification curves that can result in incorrect baseline and threshold value
calculations by the QuantStudio™ 12K Flex Software. We recommend that you examine the
Amplification Plot screen and review the assigned baseline and threshold values for each well
after analysis.

Note: If you use the Relative Threshold algorithm to analyze an experiment that includes
amplification, select to view the analysis results using the ARn vs Cycle, Rn vs Cycle, or Crr vs
Well plot type and Linear or Log graph type. Select the Show Crt checkbox to view the derived
fractional cycle on the amplification plot.
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® Correct threshold values:
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Condition

Example

Threshold Set Correctly

The threshold is set in the exponential phase
of the amplification curve.

Threshold settings above or below the
optimum increase the standard deviation of
the replicate groups.

Threshold Set Too Low

The threshold is set below the exponential
phase of the amplification curve. The
standard deviation is significantly higher than
that for a plot where the threshold is set
correctly. Drag the threshold bar up into the
exponential phase of the curve.
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(continued)

Condition Example

Threshold Set Too High

The threshold is set above the exponential
phase of the ampilification curve. The
standard deviation is significantly higher than
that for a plot where the threshold is set
correctly. Drag the threshold bar down into
the exponential phase of the curve.
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Condition

Example

Baseline Set Correctly

The amplification curve begins after the
maximum baseline.

Baseline Set Too Low

The amplification curve begins too far to the
right of the maximum baseline. Increase the
End Cycle value.
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(continued)

Condition Example

Baseline Set Too High

The amplification curve begins before the
maximum baseline. Decrease the End Cycle
value.

If your experiment does not meet the guidelines above, troubleshoot as follows:

*  Omit wells (see “Omit wells to improve CT precision” on page 140).
Or

* Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on page 135).

Identify well problems using the well table

The Well Table displays data for each well in the reaction plate, including the following items:
* The sample name, target name, task, and dyes
* The calculated threshold cycle (Ct), normalized fluorescence (Rn), and quantity values
¢ Comments

* Flags

Purpose

The purpose of viewing the well table is to identify the following items:
¢ Quantity values
* Flags

® Cy values (including Ct standard deviation)

View the well table

1. From the Experiment Menu pane, select Analysis, then select the Well Table tab.

Note: If no data are displayed, click Analyze.
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2. Use the Group By dropdown list to group wells by a specific category. For the example
experiment, group the wells by replicate, flag, or Gt value.

Yo

Note: You can select only one category at a time.

Group by replicate

From the Group By dropdown list, select Replicate. The software groups the replicate wells: negative
controls, standards, and samples. In the example experiment, note that the quantity values within each
replicate group are similar.

Note: In the example experiment, the Quantity column, Quantity Mean column, and Quantity SD
column have been moved from their default locations to the beginning of the Well Table. To move a
column, click and drag on the column heading.

»|  Plate Layout

vin Table W

# well
Al
a2
A3
A5
Ao
A7
A8
A9
A10
A1
Al2
Al3
Al4
215
Ale
A17
Al8
210
A20
A21
A22
223
A24
Bl
E2

- - B - N T R R
ooa

LWL R R M R R I I S W P s
MHD\DG\IG\U-&&:NHDOQ\IU\U’!ANN

B3
E4
E5
E6
B7
ES
E9

Wow
B

El0
B11
E12

W
@ q

Well Summary:

Well Table

Omit

1 e

In Plate: 384

Target Name
Sample Name =
| Task b
Replicate p
Dye P
Flag s
P
T M
NOISE o
Well Position (Row) P
Well Position (Column) P
None ;
- p
Popl RMaseP
Popl RMaszeP
Pop2 RMaseP
Pop2 RHaseP
Pop2 RHaseP
Pop2 RMaseP
Pop2 RHaseP
Pop2 RMaseP
Pop2 RHaseP
Pop2 RMaseP
Pop2 RHaseP
RNaseP
RHaseP
RMaseP
RHaseP
RHaseP
RMaseP
Popl RMaseP
Popl RMaseP
Popl RHaseP
Popl RNaseP
Popl RHaseP
Popl RMaseP

Set Up: 384

et ...

Task
HTC
STANDARD
STANDARD
STANDARD
STANDARD
UNKNOWN
UNKNOWN
UNKHOWN
UMKNOWN
UNKNOWN
UNKNOWN
UNKHOWN
UNKNOWN
UNKNOWN
UNKNOWN
UNKNOWN
UNKHOWN
UNKNOWN
UNKHOWN
UMKNOWN
UNKHOWN
UNKNOWN
UNKHOWN
HTC
STANDARD
STANDARD
STANDARD
STANDARD
STANDARD
UNKNOWN
UNKNOWN
UNKHOWN
UNKNOWN
UNKNOWN
UNKNOWN

Anzhyzed: 384

Dye 3
FAM-NFG-...
FAM-NFQ-...
FAM-NFG-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-_
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-_
FAM-NFQ-...
FAM-NFQ-...
FAM-NFG-...
FAM-NFQ-...
FAM-NFG-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFG-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFQ-...
FAM-NFG-...
FAM-NFQ-...
FAM-NFG-...

Fizgged: 4

CT

CT Mean | CT SD

Undetermi...

20.012
28.102
25.999
24.996
27110
27.005
26.937
27.063
26921
26.909
26.953
27.034
26.838
25.081
25.897
26.116
26.172
25.961
25.788
26.171
25.088
26.099

20.140
28.113
26.132
25.056
27096
27.096
27.096
27.096
27096
27.096
27.096
27.096
27.096
26.101
26.101
26.101
26.101
26.101
26.101
26.101
26.101
26.101

Undetermi...

28.981
28.022
27.076
25.960
25.018
27.079
27.167
27.057
27.203
27.021
27.097

29.140
28.113
27.133
26.132
25.056
27.096
27.096
27.096
27.096
27.0%6
27.096

Omitted by Analysis: 0

0.178
0.181
0.100
0.098
0.140
0.140
0.140
0.140
0.140
0.140
0.140
0.140
0.140
0.159
0.159
0.159
0.159
0.159
0.159
0.159
0.159
0.159

0.178
0.181
0.130
0.100
0.098
0.140
0.140
0.140
0.140
0.140
0.140

Omitied Manually: 0

Quantity

1,250,000
2,500.000
10,000.000
20,000.000
5,015.352
5,387.923
5,645.138
5,181.675
5,708.598
5,412,582
5,584.070
5,284.767
6,041.067
10,849.413
11,484.034
9,801.872
0,510.561
10,997.522
12,373.380
9,523.480
10,763.900
10,008.625

1,250.000
2,500.000
5,000.000

10,000.000

20,000.000
5,124.039
4,824.004
5,200.990
4,706.999
5,330.722
5,050.768

Expand Al

Quantit... | Quantit...
5,000.081 565.712
5,090.081 565.712
5,090.081 565.712
5,000.081 565.712
5,000.081 565.712
5,000.081 565.712
5,090.081 565.712
5,090.081 565.712
5,000.081 565.712

10,053.434 1,142.832

10,053.434 1,142.832

10,053434 1,142.832

10,053.434 1,142,832

10,053.434 1,142.832

10,053.434 1,142.832

10,053.434 1,142.832

10,053.434 1,142,832

10,053434 1,142.832
5,090.081 565.712
5,000.081 565.712
5,090.081 565.712
5,090.081 565.712
5,090.081 565.712
5,090.081 565.712

Samples Used: 2
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Expand Al
# Well | Omit Flag Sample ...| Target... | Task Dyes CT CT Mean | CT SD Quantity | Quantit... | Quantit... | NOISE ouU
7 A7 ] Popl RiaseP UMKNOWN  FAM-NFQ-... 27.110 27.096 0.140 5,015.352 5,090.081 565.712
8 A8 ] Popl RiNaseP UMKNOWN  FAM-NFQ-... 27.005 27.096 0.140 5,387.923 5,090.081 565.712
9 A0 O Popl RNaseP UNKNOWN  FAM-NFQ-... 26.937 27.096 0.140 5,645.138 5,090.081 565.712
10 Al0 ] Popl RiNaseP UMKNOWN  FAM-NFQ-... 27.063 27.096 0.140 5,181.675 5,090.081 565.712
11 Al1 | Popl RNaseP UNKNOWN  FAM-NFQ-... 26.921 27.096 0.140 5,708.508 5,000.081 565.712
12 A12 | Popl RNaseP UMKNOWN  FAM-NFQ-... 26.999 27.096 0.140 5412.582 5,090.081 565.712
13 Al3 ] Popl RiNaseP UMKNOWN  FAM-NFQ-... 26.953 27.096 0.140 5,584.070 5,090.081 565.712
14 Al4 O Popl RNaseP UNKNOWN  FAM-NFQ-... 27.034 27.096 0.140 5,284.767 5,090.081 565.712
15 A15 O Popl Riasep UNKNOWN  FAM-NFQ-_. 26.838 27.006 0.140 5,041.067 5,000.081 565.712
31 E7 " | Popl RNaseP UMKNOWN  FAM-NFQ-... 27.079 27.096 0.140 5,124.039 5,090.081 565.712
32 B8 " | Popl RNaseP UMKNOWN  FAM-NFQ-... 27.167 27.096 0.140 4,824.084 5,090.081 565.712
33 E9 " | Popl RNaseP UMKNOWN  FAM-NFQ-... 27.057 27.096 0.140 5,200.990  5,090.081 565.712
34 E10 | Popl Riasep UNKNOWN  FAM-NFQ-.. 27.203 27.006 0.140 4,706.000 5,000.081 565.712
35 Bl11 " | Popl RiaseP UMKNOWN  FAM-NFQ-... 27.021 27.096 0.140 5,330.722 5,090.081 565.712
36 E12 " | Popl RNaseP UMKNOWN  FAM-NFQ-... 27.097 27.096 0.140 5,059.768 5,090.081 565.712
37 B13 " | Popl RNaseP UMKNOWN  FAM-NFQ-... 27.099 27.096 0.140 5,052.877 5,090.081 565.712
38 E14 | Popl Riasap UNKNOWN  FAM-NFQ-... 27.011 27.096 0.140 5,366.522  5,000.081 565.712
39 E15 " | Popl RNaseP UMKNOWN  FAM-NFQ-... 27.103 27.096 0.140 5,041.529 5,090.081 565.712
55 7 " | Popl RiaseP UMKNOWN  FAM-NFQ-... 27.045 27.096 0.140 5,242.704 5,090.081 565.712
o6 (8 " | Popl RNaseP UMKNOWN  FAM-NFQ-... 27.182 27.096 0.140 4,775.204 5,090.081 565.712
57 @ " | Popl Riasep UNKNOWN  FAM-NFQ... 27.222 27.006 0.140 4,646.054 5,000.081 565.712
58 C10 " | Popl RiaseP UMKNOWN  FAM-NFQ-... 27.153 27.096 0.140 4,871.199 5,090.081 565.712
59 i | Popl RNaseP UNKNOWN  FAM-NFQ-... 27.253 27.096 0.140 4,548.860 5,090.081 565.712
60 (12 " | Popl RiaseP UMKNOWN  FAM-NFQ-... 27.217 27.096 0.140 4,664.264 5,090.081 565.712
61 €13 O Popl RNaseP UNKNOWN  FAM-NFQ-... 27.228 27.096 0.140  4,628.641 5,090.081 565.712
62 (14 " | Popl RNaseP UNKNOWN  FAM-NFQ-... 27.272 27.096 0.140 4,492,085 5,090.081 565.712
63 (15 " | Popl RiNaseP UMKNOWN  FAM-NFQ-... 27.329 27.096 0.140 4,320.416 5,090.081 565.712
79 D7 | Popl RNaseP UNKNOWN  FAM-NFQ-... 27.03¢ 27.096 0.140 5,277.137 5,090.081 565.712
80 D8 O Popl RNaseP UNKNOWN  FAM-NFQ-... 27.101 27.096 0.140 5,048.890 5,090.081 565.712
81 D9 ] Popl RiNaseP UMKNOWN  FAM-NFQ-... 27.142 27.096 0.140 4,909.571 5,090.081 565.712
82 D10 " | Popl RNaseP UNKNOWN  FAM-NFQ-... 27.198 27.096 0.140 4,722.698 5,090.081 565.712
83 D11 ] Popl RiNaseP UMKNOWN  FAM-NFQ-... 27.073 27.096 0.140 5,146.530 5,090.081 565.712
84 D1z OJ Popl RNaseP UNKHOWN ~ FAM-NFQ-... 27.26G 27.096 0.140  4,508.289 5,090.081 565.712
85 D13 | Popl RNaseP UMKNOWN  FAM-NFQ-... 26.935 27.096 0.140 5,651.525 5,090.081 565.712 o
din >
Well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 4 Omitted by Analysis: [} Omitted Manualty: 0 Szmples Used: 2 Targsts Used: 1

Figure 23 Well table
Group by flag

From the Group By dropdown list, select Flag. The software groups the flagged and unflagged wells. In
the example experiment, there are four flagged wells.
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Plate Layout e

Target Name

# Well | Omit cr CT Mean | CT SD CQuantity | Quantit... | Quantit... | NOISE ou

Sample Name

7 A7 [ 2= i UNKNOWN  FAM-NFQ- 5015352 5000.081  565.712
8 8 i Replicate P UNKNOWN  FAM-NFQ-... 27.005 27.006 0140 5,387.923 5,090.081  565.712
9 A9 O Dye P UNKNOWN  FAM-NFQ-... 26.937 27.096 0.140 5,645.138 5,000.081  565.712
10 A0 [ [ Fs i UNKNOWN  FAM-NFQ-... 27.063 27.096 0140 5,181.675 5090.081  565.712
11 A1l O = P UNKNOWN  FAM-NFQ-... 26.921 37.096 0140 5708508 5000.081 565712
12 A12 O i UNKNOWN  FAM-NFQ-... 26.809 27.006 0.140 5412.582 5000.081  565.712
13 A13 ] NCISE p UNKNOWN  FAM-NFQ-... 26.953 27.096 0.140 5,584.070 5,090.081  565.712
14 Al4 O Wl Positon (Row) il UNKNOWN  FAM-NFQ-... 27.034 27.096 0.140 5,284.767 5090.081 565712
15 A15 0 Well Positon (Column) il UNKNOWN  FAM-NFQ-... 26.838 27.006 0140 6,041.067 5,000.081  565.712
31 B7 [ None i UNKNOWN  FAM-NFQ-... 27.079 27.006 0140 5124.039 5000.081  565.712
32 B3 O — p UNKNOWN ~ FAM-NFQ-.. 27.167 27.096 0140 4,824.094 5000.081  565.712
33 B9 i Papl RNaseP UNKNOWN  FAM-NFQ-... 27.057 27.096 0.140 5,200.990 5,090.081  565.712
34 B10 I:l Popl RMaseP UNKNOWRN  FAM-NFQ-... 27.203 27.096 0.140 4,706.999 5,090.081 565.712
35 Bl1 [ Popl RiaseP UNKNOWN  FAM-NFQ-... 27.021 27.096 0140 5330722 5090.081  565.712
36 B2 O Popl RNaseP UNKNOWN ~ FAM-NFQ-... 27.007 27.006 0140 5,059.768 5,000.081  565.712
37 B13 i Popt RNaseP UNKNOWN  FAM-NFQ-... 27.009 27.006 0.140 5,052.877 5,090.081  565.712
38 B14 I:l Popl RMaseP UNKNOWN  FAM-NFQ-... 27.011 27.096 0.140 5,366.522 5,090.081 565.712
39 BIS 0 Popl RiaseP UNKNOWN  FAM-NFQ-... 27.103 27.096 0.140 5,041.520 5,090.081  565.712
55 @ [ Popl RiaseP UNKNOWN  FAM-NFQ-... 27.045 27.096 0.140 5,242.704 5090.081  565.712
56 3 O Popl RNaseP UNKNOWN ~ FAM-NFQ-... 27.182 27.006 0.140 4,775.204 5,000.081  565.712
57 © [ Pop1 RNaceP UNKNOWN  FAMNFQ-... 27.222 27.006 0.140 4,646.054 5,000.081 565712
58 Clo i Papl RNaseP UNKNOWN  FAM-NFQ-... 27.153 27.006 0.140 4,871.199 5,090.081  565.712
50 11 [ Popl RiaseP UNKNOWN  FAM-NFQ-... 27.253 27.096 0.140 4,548.860 5,090.081  565.712
60 C12 [ Popl RNaseP UNKNOWN ~ FAM-NFQ-... 27.217 27.006 0.140 4,664.264 5000.081  565.712
61 C12 [ Pop1 RNaseP UNKNOWN  FAM NFQ-.. 27.228 27.006 0.140 4,628.641 5,000.081 565712
62 Cl4 O Popl RNaseP UNKNOWN  FAM-NFQ-.. 27.272 27.096 0140 4,492.085 5090.081  565.712
63 CI5 0 Papl RNaseP UNKNOWN  FAM-NFQ-... 27.329 27.096 0.140 4,320.416 5,090.081  565.712
79 D7 [ Popl RiaseP UNKNOWN  FAM-NFQ-... 27.036 27.096 0140 5277.137 5090.081  565.712
80 D8 i Pop1 RNaseP UNKNOWN  FAM-NFQ-... 27.101 27.006 0140 5,048.800 5,090.081  565.712
81 Do O Popl RNaseP UNKNOWN ~ FAM-NFQ-... 27.142 27.006 0.140 4,900.571 5000.081  565.712
82 D10 i Papl RNaseP UNKNOWN  FAM-NFQ-... 27.198 27.006 0.140 4,722.698 5,090.081  565.712
83 DIl 0 Popl RiaseP UNKNOWN  FAM-NFQ-... 27.073 27.096 0.140 5,146.530 5,090.081  565.712
84 D1z I:l Popl RMaseP UNKNOWN  FAM-NFQ-... 27.260 27.096 0.140 4,508.289 5,090.081 565.712
85 D13 [ Popl RiaseP UNKNOWN  FAM-NFQ-... 26.935 27.096 0.140 5,651.525 5090.081  565.712 3
< >
Well Summary: In piste: 384 satUp: 384 Anshyzsd: 384 Fisgged: 4 Onmitted by Ansiysis: 0 Onitted Manusly: 0 Samples Used: 2 Targets Used: 1

Group by Ct value

From the Group By dropdown list, select Cy. The software groups the wells by Ct value: low, medium,
high, and undetermined. In the example experiment, the Ct values are within the expected range
(greater than 8 and less than 35).
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Plate Layout

Well Table

Expand &l B Collapse all

Target Name

well | Omit cT CT Mean  CT SD Quantity | Quantit... | Quantit... | NOISE ou
Sample Name
Low (CT les| ~
= Madium (C3 2=
2 A2 ] Replicate P STANDARD FAM-NFQ-.. 29.012 20,140 0.178 1,250.000
3 A3 ] Dye P STANDARD FAM-NFQ-... 28.102 28.113 0.181 2,500.000
4 A4 " | Flag P STANDARD FAM-NFQ-... 26.788 27.133 0.130 5,000.000
5 A5 I} p STANDARD FAM-NFQ-.. 25.909 26.122 0.100 10,000.000
6 A O o k P STANDARD FAM-NFQ-.. 24.996 25.056 0.098 20,000.000
7 A7 ] NCISE P UNKNOWN ~ FAM-NFQ-... 27.110 27.096 0.140 5015352 5,090.081  565.712
8 AB a Well Positon (Row) P UNKHNOWN  FAM-NFQ-... 27.005 27.096 0.140 5,387.923 5,090.081 565.712
o A0 I} well Positon {Calumn) p UNKNOWN ~ FAM-NFQ-... 26.037 37.006 0.140 5,645.138 5,000.081 565.712
10 Al0 | Nane P UNKNOWN ~ FAM-MFQ-... 27.063 27.096 0.140 5,181.675 5,090.081 565.712
11 A1l ] = P UNKHMOWN  FAM-NFQ-... 26.921 27.096 0.140 5,708.598 5,090.081 565.712
12 A12 " | Paopl RMNaseP UNKHMOWN  FAM-NFQ-... 26.999 27.096 0.140 5,412.582 5,090.081 565.712
12 A12 I} Papl Rhlacap UNKNOWN ~ FAM-NFQ-... 26.053 37.006 0.140 5,584.070 5,000.081 565.712
14 Al4 | Papl RMaseP UNKMOWN  FAM-MFQ-... 27.034 27.096 0.140 3,284.767 5,090.081 565.712
15 Al5 ] Popl RNasep UNKNOWN  FAM-NFQ-... 26.838 27.096 0.140 6,041.067 5,090.081 565.712
16 Als | Paop2 RMNaseP UNKHMOWN  FAM-NFQ-... 25.981 26.101 0.159 10,849.413 10,053.434 1,142.832
17 A17 I} Pap2 Rhlasap UNKNOWN ~ FAM-NFQ-... 25.807 26.101 0.150 11,484,034 10,053.434 1,142.832
18 Als " | Pap2 RMaseP UNKNOWN  FAM-NFQ-... 26.116 26.101 0.159 09,891.872 10,053.434 1,142.832
19 Alg ] Pop2 RNaseP UNKHMOWN  FAM-NFQ-... 26.172 26.101 0.159 9,519.561 10,053.434 1,142.832
20 A0 | Pap2 RMNasep UNKHMOWN  FAM-NFQ-... 25.961 26.101 0.159 10,997.522 10,053.434 1,142.832
21 A21 I} Pap2 Rilasap UNKNOWN ~ FAM-NFQ-... 25.788 26.101 0.150 12,372.380 10,053.434 1,142.832
22 A22 " | Pap2 RMNaseP UNKHMOWN  FAM-NFQ-... 26.171 26.101 0.159 9,523.480 10,053.434 1,142.832
23 A3 O Pop2 RMaseP UNKNOWN  FAM-NFQ-... 25.988 26.101 0.159 10,793.909 10,053.434 1,142.832
24 A4 ] Paop2 RMNasep UNKHMOWN  FAM-NFQ-... 26.099 26.101 0.159 10,008.625 10,053.434 1,142.832
26 B2 I} RNaseP STANDARD FAM-NFQ-.. 28.981 20.140 0.178 1,250.000
27 B3 " | RNaseP STANDARD FAM-NFQ-... 28.022 28.113 0.181 2,500.000
28 B4 | RMaseP STANDARD FAM-NFQ-... 27.076 27.133 0.130  5,000.000
29 B3 ] RNasep STANDARD FAM-NFQ-... 25.960 26.132 0.100 10,000.000
30 Bs I} RNaseP STANDARD FAM-NFQ-... 25.018 25.056 0.098 20,000.000
31 B7 " | Papl RNaseP UNKNOWN  FAM-NFQ-... 27.079 27.096 0.140 5,124.039 5,090.081 565.712
32 B8 | Paopl RMaseP UNKNOWN  FAM-NFQ-... 27.167 27.096 0.140 4,824.094  5,090.081 565.712
33 B2 ] Popl RNasep UNKMOWN  FAM-NFQ-... 27.057 27.096 0.140 5,200.990 5,090.081 565.712
34 B10O I} Paopl RNasep UNKNOWN  FAM-NFQ-.. 27.203 27.096 0.140 4,706.999 5,000.081 565.712
35 Bl1 " | Paopl RMNaseP UNKHOWN  FAM-NFQ-... 27.021 27.096 0.140 5,330.722 5,090.081 565.712 2
e >
Well Summary: In Plate: 384 Set Up: 384 Anzhyzed: 384 Flagged: 4 Omitted by Anahysis: [ Omitted Manualhy: 0 Samples Used: 2 Targets Used: 1

Tips for analyzing your own experiments

Replicate —The software groups the wells by replicate: negative controls, standards, and samples.
Look in the quantity columns to make sure the quantity values for each replicate group are similar
indicating tight C precision.

Flag—The software groups the flagged and unflagged wells. A flag indicates that the software has
found a potential error in the flagged well. For a description of the flags, see “Flag settings” on
page 137.

Ct—The threshold cycle (Cy) is the PCR cycle number at which the fluorescence level meets the
threshold. A Cy value greater than 8 and less than 35 is desirable. A Ct value less than 8 indicates
that there is too much template in the reaction. A C+ value greater than 35 indicates a low amount
of target in the reaction. For Ct values greater than 35, expect a higher standard deviation.
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Confirm accurate dye signal using the multicomponent plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected
well over the duration of the PCR run.

Purpose

In the standard curve example experiment, you review the Multicomponent Plot for the following items:
* ROX™ dye (passive reference)
* FAM™ dye (reporter)
* Spikes, dips, and/or sudden changes
* Amplification in the negative control wells

View the multicomponent plot

1. From the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

2. Display the unknown and standard wells one at a time in the Multicomponent Plot screen.
a. Click the Plate Layout tab.

b. Select one well in the plate layout. The well is displayed in the Multicomponent Plot.

Note: If you select multiple wells, the Multicomponent Plot displays the data for all selected
wells simultaneously.

3. From the Plot Color dropdown list, select Dye.

4. Click [7] Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.

5. Check the ROX™ dye signal.

In the example experiment, the ROX™ dye signal remains constant throughout the PCR process.
Aa constant ROX™ dye signal indicates typical data.

6. Check the FAM™ dye signal.

In the example experiment, the FAM™ dye signal increases throughout the PCR process; increase
in FAM™ dye signal indicates normal amplification.
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7. Select the negative control wells one at time and check for amplification.
In the example experiment, there is no amplification in the negative control wells.
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Tips for confirming dye accuracy in your own experiment

When you analyze your own standard curve experiment, look for the following items:

* Passive reference—The passive reference dye fluorescence level should remain relatively constant
throughout the PCR process.

* Reporter dye—The reporter dye fluorescence level should display a flat region corresponding to
the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.

* Irregularities in the signal—There should not be any spikes, dips, and/or sudden changes in the
fluorescent signal.

¢ Negative Control wells —There should not be any amplification in the negative control wells.

Determine signal accuracy using the raw data plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter
for the selected wells during each cycle of the real-time PCR.

Purpose

In the standard curve example experiment, you review the Raw Data Plot for a stable increase in signal
(no abrupt changes or dips) from the appropriate filter.

QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide 131



=% Chapter7

| /] ”
Review results

View the raw data plot

1. From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate
layout in the Plate Layout tab.

3. Click [7] Show a legend for the plot (default).

The legend displays the color code for each row of the reaction plate (see the legend in the Raw
Data Plot shown below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example experiment, there
is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.
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Run Method

Reaction Volume per Welt 20| pL
oo I
PCR Filter =
Ermission Filter
ml(520+15) m2({558=+11) m3(586+10) m4({623+14) m5(682+14) m6(711+12)

¥1(470+15)

12(520410)

¥3(950£11)

Excitation Filter

¥{5E1£10)

H5(64010)

x6(662+10)

Melt Curve Filter -

Emission Filter

m1(52015) m2(558=11) m3(536+10) ma(623=14) m5(632+14) m6(711=12)
K1(470415)

¥2(920£10)

¥3(550+11)

Excitation Filte

¥4(58010)

¥3(640£10)

X6(BE2+10)

Figure 24 filters used for the example experiment

Tips for determining signal accuracy in your own experiments

When you analyze your own standard curve experiment, look for the following items in each filter:
® Characteristic signal growth
* No abrupt changes or dips

Review the flags in the QC summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the flag
frequency and location for the open experiment.

1. From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the
experiment. If the frequency is greater than 0, the flag appears somewhere in the experiment. The
well position is listed in the Wells column.

In the example experiment, there are four flagged wells.
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3. In the Flag Details table, click each flag with a frequency greater than 0 to display detailed
information about the flag. In the example experiment, the Frequency column displays 0 for all
flags.

4. (Optional) For those flags with frequency greater than 0, click the troubleshooting link to view
information on correcting the flag.

Possible flags

The flags listed below might be triggered by the experiment data.

Note: To change the flag settings, see “Flag settings” on page 137.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification
NOISE Noise higher than others in plate
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(continued)

Flag Description
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL C+ algorithm failed

AMPSCORE | Ampilification in the linear region is below a certain threshold, corresponding to the score set
in the analysis settings

Secondary analysis flags

OUTLIERRG Outlier in replicate group
AMPNC Amplification in negative control
HIGHSD High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL
flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed
in the Frequency column for each flag).

For more information

Information Reference

Publishing data Chapter 1, “General information and instructions”

Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle (C7), flags, and
advanced options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your
experiment.
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View the analysis settings
1. From the Experiment Menu pane, select Analysis.
2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab.

® (7 Settings

Flag Settings

Advanced Settings

Standard Curve Settings

Figure 25 Analysis Settings dialog box for a Standard Curve experiment

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” on page 137).

Note: You can save the changes to the analysis settings to the Analysis Settings Library for later
use. For more information, see “About the analysis settings library” on page 62.
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4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to Default Analysis
Settings.

Adjust analysis settings
Ct settings

e Data Step Selection
Use this feature to select one stage/step combination for Ct analysis when there is more than one
data collection point in the run method.

* Algorithm Settings
You can select the algorithm that determines the C+ values. There are two algorithms: Baseline
Threshold (the default) and Relative Threshold.
The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline
component and sets a fluorescent threshold in the exponential region for quantification.

The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency
and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no
dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a
threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold
will not affect the analysis.

* Default Ct Settings
Use the default Cy settings feature to calculate Cy for the targets that do not have custom settings.
To edit the default settings, click Edit Default Settings.

® Cy Settings for Target
When you manually set the threshold and baseline, we recommend the following settings:

Setting Recommendation

Threshold | Enter a value for the threshold so that the threshold is:
— Above the background.
— Below the plateau and linear regions of the amplification curve.

— Within the exponential phase of the amplification curve.

Baseline | Select the Start Cycle and End Cycle values so that the baseline ends before significant
fluorescent signal is detected.

Note: Selecting Automatic Threshold implies selection of automatic setting of the baseline.
However, if Automatic Threshold is deselected, then you can choose between setting the baseline
either automatically or manually.

Flag settings
Use the Flag Settings tab to perform the following tasks:

* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the QuantStudio™ 12K Flex Software.
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1. In the Use column, select the checkboxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying
the flag.

Note: If you choose to adjust the setting for applying a flag, make minor adjustments as you
evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the
flag.

Note: After you have rejected the flagged wells, analysis results depend on factors such as the
experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments
using the Standard Deviation calculations might change the result of Ct SD. For some flags,
analysis results calculated before the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box.
If the run status is complete, the data are reanalyzed.

Figure 26 Flag Settings tab
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Advanced settings

Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative Threshold
algorithm.

The following steps describe the use of custom baseline settings for a well-target combination.
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target checkbox.

3. Define the custom baseline settings:
* For automatic baseline calculations, select the Automatic Baseline checkbox.

* To define the baseline, deselect the Automatic Baseline checkbox, then enter the baseline
start cycle and baseline end cycle.
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Standard curve settings

Use this tab to review the settings of the current standard curve experiment or to import the standard
curve from an external experiment (with the same samples and targets) and apply it to the current
experiment.

Note: The run method must be the same. We recommend using the standard curve from the current
experiment.

For the example experiment, the settings from the current experiment have been used.

Omit wells to improve Ct precision

Experimental error might cause some wells to be amplified insufficiently or not at all. These wells
typically produce Cr values that differ significantly from the average for the associated replicate wells.
If included in the calculations, these outliers can result in erroneous measurements. To support Ct
precision, omit the outliers from the analysis.

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.
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2. In the Amplification Plot screen, select Ct vs Well from the Plot Type dropdown list.
3. Select the Well Table tab.

4. In the Well Table, view outliers.
a. From the Group By dropdown list, select Replicate.

b. Look for any outliers in the replicate group (make sure they are flagged).

c. Select the Omit checkbox next to outlying well or outlying wells, as shown below.

5. Click Analyze to reanalyze the experiment data with the outlying well or outlying wells removed
from the analysis.

Note: You can also omit undesirable wells in an experiment from the Plate Layout screen. To omit
a well from the Plate Layout screen, right-click the well, then click Omit.
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Export analysis results

. Open a Standard Curve example experiment file that has been analyzed.
For information about analysis, see Chapter 7, “Review results and adjust experiment parameters”.

. In the Experiment Menu pane, click Export.

Note: To export data automatically after analysis, select the Auto Export checkbox during
experiment setup or before running the experiment. The Auto Export checkbox is unchecked
for the example experiment.

. In the Format dropdown list, select QuantStudio 12K Flex format.
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4. Complete the Export dialog box as shown below.

Field or Selection Entry
Select Data to export/Select Content | Results
Export Data To options One File radio button
Export File Name field Enter a file name or use the default file name
File Type dropdown list "ixt
Export File Location field Use the default file location or click Browse to select a different
location

Figure 27 Export screen
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Figure 28 Exported file
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Running relative standard curve
experiments
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About relative standard curve
experiments

IMPORTANT! First-time users of the QuantStudio™ 12K Flex Real-Time PCR System, see the part
“Getting started” on page 17 and Appendix A, “Documentation and support”. The sections provide
information and general instructions that are applicable to all the experiments described in this
document.

Note: For more information about any of the topics discussed in this guide, access the Help from
within the QuantStudio™ 12K Flex Software by pressing F1, clicking  in the toolbar, or selecting
Help » QuantStudio 12K Flex Software Help.

About relative standard curve experiments

The Relative Standard Curve method is used to determine relative target quantity in samples. The
QuantStudio™ 12K Flex Software measures amplification of the target and of the endogenous control in
samples, in a reference sample, and in a standard dilution series. Measurements are normalized using
the endogenous control. Data from the standard dilution series are used to generate the standard curve.
Using the standard curve, the software interpolates target quantity and endogenous control quantity

in the samples and the reference sample. For each sample and reference sample, the target quantity

is normalized by endogenous control quantity (quantity of target/quantity of endogenous control). The
normalized quotient from samples is divided by the quotient from the reference sample to get relative
quantification (fold change). The software determines the relative quantity of target in each sample by
comparing target quantity in each sample to target quantity in the reference sample.

Relative Standard Curve experiments are commonly used to perform the following tasks:
* Compare expression levels of a gene in different tissues
* Compare expression levels of a gene in a treated sample and an untreated sample
* Compare expression levels of wild-type alleles and mutated alleles

* Analyze the gene expression changes over time under specific treatment conditions
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Assemble the required components

¢ Sample—The tissue group that you are testing for a target gene.

* Reference sample (also called a calibrator) —The sample used as the basis for relative
quantification results. For example, in a study of drug effects on gene expression, an untreated
control is an appropriate reference sample.

* Standard—A sample that contains known quantities of the target; used in quantification
experiments to generate standard curves.

¢ Standard dilution series—A set of standards containing a range of known quantities. The
standard dilution series is prepared by serially diluting standards.

* Endogenous control—A gene that is used to normalize template input differences, and sample-to-
sample or run-to-run variation.

* Replicates—The total number of identical reactions containing identical components and identical
volumes.

* Negative Controls—Wells that contain water or buffer instead of sample template. No
amplification of the target should occur in the negative control wells.

PCR options

When performing real-time PCR, choose between:
* Singleplex PCR and multiplex PCR (see “Singleplex and multiplex PCR” on page 147)
and
* 1-step RT-PCR and 2-step RT-PCR (see “1- and 2-step RT-PCR” on page 148)

Singleplex and multiplex PCR

You can perform a PCR reaction using either:
¢ Singleplex PCR—In singleplex PCR a single primer and probe set is present in the reaction tube or
well. Only one target or endogenous control can be amplified per reaction.
Or
¢ Multiplex PCR—In multiplex PCR, two or more primer and probe sets are present in the reaction
tube or well. Each set amplifies a specific target or endogenous control.

One example is a probe that is labeled with FAM™ dye detects the target and a probe that is
labeled with VIC™ dye detects the endogenous control.

IMPORTANT! SYBR™ Green reagents cannot be used for multiplex PCR.

QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide 147



58 Chapter 9
About the example experiment

1- and 2-step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in separate reactions
(2-step). The reagent configuration you use depends on whether you are performing 1- or 2-step
RT-PCR.

* 1-step PCR—In 1-step RT-PCR, RT and PCR take place in one buffer system. Using one buffer
system provides the convenience of a single-tube preparation for RT and PCR amplification.
However, you cannot use Fast PCR Master Mix or the carryover prevention enzyme, AmpErase™
UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

o 2-step PCR—2-step RT-PCR is performed in two separate reactions. First, total RNA is reverse-
transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful for detecting
multiple transcripts from a single cDNA template or for storing cDNA aliquots for later use. The
AmpErase™ UNG enzyme can be used to prevent carryover contamination.

About the example experiment

To illustrate how to perform a Relative Standard Curve, this guide leads you through the process of
designing and performing an example experiment. The example experiment represents a typical setup
that you can use to quickly familiarize yourself with the QuantStudio™ 12K Flex Real-Time PCR System.

The objective of the Relative Standard Curve example experiment is to compare the expression of the
HPRT transcriptional factor (an oncoprotein that activates the transcription of growth-associated genes)
in Human cDNA tissues.

In the Relative Standard Curve example experiment:
* The samples are 1, 10, 100, 1000, 10000, Heart, and Kidney.
* The target is HPRT.
* The endogenous control is FAS.
® The reference sample is Kidney.

* One standard curve is set up for HPRT. The standard used for the standard dilution series is a
Human cDNA sample of known total concentration.

* One standard curve is set up for FAS (endogenous control). The standard used for the standard
dilution series is a Human Male Raji cDNA sample of known total concentration.

* Reactions are set up for 2-step RT-PCR. The SuperScript™ VILO™ cDNA Synthesis Kit is used for
reverse transcription. The TagMan™ Gene Expression Master Mix is used for PCR.

® Select primer and probe sets from the TagMan™ Gene Expression Assay product line:
— For the target assay (HPRT), select assay ID Hs99999909_m1.
— For the endogenous control assay (FAS), select assay ID Hs00907759_m1.
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Design the experiment

This chapter explains how to design the example experiment from the Setup menu in the Experiment

Menu pane.

Note: To automatically export the analyzed data to a specified location, select the Auto Export
checkbox in the Export screen, before running the experiment. For more information on Auto Export,
the part “Getting started” on page 17.

Define the experiment properties

In the Experiment Menu pane, click Setup » Experiment Properties.

Enter or select the following information.

Field or Selection

Entry

Experiment Name field

Enter 96-Well Relative Std Curve Example.

Barcode field

Leave the Barcode field empty.

User Name field

Enter Example User or enter a user name.

Comments field

Enter Relative Standard Curve example.

Block Select 96-Well (0.2 mL).
Experiment Type Select Relative Standard Curve.
Reagents Select TagMan Reagents.
Properties Select Standard.

Save the experiment.
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Figure 29 Experiment Properties screen

Define targets, samples, and biological replicates

1. Click Define to access the Define screen.

2. Enter the following target information.

Target name | Reporter | Quencher Color

FAS FAM |NFQ-MGB .

HPRT FAM |NFQ-MGB

3. Enter the following sample information.

Sample name Color

| .

10

100
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Define targets, samples, and biological replicates

Chapter 10

Sample name

Color

1000

10000

Heart

Kidney

4. In the Passive Reference dropdown list, select ROX .

5. Enter the following analysis settings.

Field Select
Reference Sample field Kidney
Endogenous Control field FAS

Figure 30 Define screen

Note: This example experiment does not define biological replicate groups. Leave the Biological

Replicate Groups pane blank.
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Assign targets, samples, and biological groups

Note: To automatically set up and assign standards, click to open the Define and Set
Up Standards dialog box.

1. Click Assign to access the Assign screen.

2. For the first standard for the FAS target:
a. Click-drag to select wells A1-A3.

b. In the Targets list, select the checkbox for the row that is labeled FAS.
c. In the Task dropdown list, select S.
d. In the Quantity field, enter 70,000.

e. Repeat steps a on page 152 to ¢ on page 152 for each of the standards for the FAS target, as
displayed in Table 2 on page 152.

3. Repeat step 2 on page 152 for each standard for the HPRT target.

Table 2 Targets

Target name Well number Task Quantity Sample name
FAS A12 Negative None None
B4 - B6 Unknown Determined by run Kidney
B7 - B9 Unknown Determined by run Heart
Al -A3 Standard 10,000 10,000
A4 - A6 Standard 1,000 1,000
A7 - A9 Standard 100 100
A10-A12 Standard 10 10
B1-B3 Standard 1 1
HPRT D12 Negative None None
D4 - D6 Unknown Determined by run Kidney
D7 - D9 Unknown Determined by run Heart
C1-C3 Standard 10,000 10,000
C4-C6 Standard 1,000 1,000
C7-C9 Standard 100 100
C10-C12 Standard 10 10
D1-D3 Standard 1 1
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Figure 31 Assign screen

Set up the run method

Chapter 10 ¥
Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View

tab. Enter the following information:
* Reaction Volume Per Well: 20 uL
* Thermal Profile

Stage Step | Ramp rate | Temperature Time
Hold Stage Step1| 1.6°C/s 50°C 2 minutes
Step2| 1.6°C/s 95°C 10 minutes
PCR Stage Step1| 1.6°C/s 95°C 15 seconds
Number of Cycles: 40
Enable AutoDelta: Unchecked (default) i
Step 2| 1.6°C/s 60°C 1 minute
Starting Cycle: Disabled when Enable AutoDelta is
unchecked
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Figure 32 Run Method screen

Tips for designing your own experiment

We recommend the following items for your own experiments:

154

Set up a standard curve for each target assay in the reaction plate.

Identify each target assay with a unique name and color. You can enter up to 100 characters in the
Target Name field.

Identify each sample using a unique name and color. You can enter up to 100 characters in the
Sample Name field.

Select an endogenous control for each sample. The endogenous control is a target that is present
in all samples under investigation. It should be expressed equally in all sample types, regardless
of treatment or tissue origin (examples of endogenous controls are B-actin, GAPDH, and 18S
ribosomal RNA [18S rRNA]). The endogenous control is used to normalize the PCR results. The
endogenous control corrects for variable sample mass, nucleic acid extraction efficiency, reverse
transcription efficiency, and pipette calibration errors.

Note: Each sample type (for example, each tissue in a study comparing multiple tissues) requires
an endogenous control.

Enter at least five dilution points for each standard curve in the reaction plate.

Enter at least three replicates (identical reactions) for each point in the standard curve and for each
sample reaction.

Enter at least three negative control reactions for each target assay.
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* (Carefully consider the appropriate range of standard quantities for your assay because the range of
standard quantities affects the amplification efficiency calculations.
— For more accurate measurements of amplification efficiency, use a broad range of standard
quantities, spanning between 5 and 6 logs. If you do so, use a PCR product or a highly
concentrated template, such as a cDNA clone.

— If you have a limited amount of cDNA template and/or if the target is a low-copy number
transcript, or known to fall within a given range, a narrow range of standard quantities may be
necessary.

* Minimally run a five-point curve of 1:10 dilutions to minimize the effects of small pipetting errors.

* Select a reference sample from your previously defined samples. Amplification results from the
samples and from the reference sample are compared to determine relative expression.

* Select an endogenous control from your previously defined target assays. Amplification results
from the endogenous control are used to normalize the amplification results from the target for
differences in the amount of template added to each reaction.

More information

Information Reference
Consumables Chapter 1, “General information and instructions”
Using other quantification methods * “Running standard curve experiments” on page 86

*  “Running comparative Ct experiments” on page 198

Using alternative setup Chapter 2, “Experiment shortcuts”
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Prepare the reactions

This chapter explains how to prepare the PCR reactions for the Relative Standard Curve example
experiment.

Assemble required materials

* ltems listed in the part “Getting started” on page 17
e Samples—Total RNA isolated from kidney, heart, liver, and brain tissues
* Example experiment reaction mix components:

— TagMan™ Gene Expression Master Mix (2 X)

— FAS Assay Mix (20 X)

— HPRT Assay Mix (20X)

Prepare the template

Prepare the template for the PCR reactions (both samples and standards) using a cDNA synthesis kit.
One option is SuperScript™ VILO™ cDNA Synthesis Kit (Cat. No. 11754250).

Example experiment settings

For the Relative Standard Curve example experiment, the template for the PCR reactions is cDNA
reverse-transcribed from total RNA samples.

Prepare the template

Use the SuperScript™ VILO™ cDNA Synthesis Kit (Cat. No. 11754250). Follow the procedures for the kit.

1. Isolate total RNA from cells a sample preparation kit appropriate to the tissue or cell type.
2. Quantify and perform quality control on the RNA.

3. Convert the RNA to cDNA by reverse transcription.
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Prepare the sample dilutions

For the Relative Standard Curve example experiment, no more than 10% of your reaction should
consist of the undiluted cDNA.

1. Label a separate microcentrifuge tube for each diluted sample.
¢ Kidney
* Heart

2. Add the required volume of water (diluent) to each empty tube.

Tube Sample name Diluent volume
1 Kidney 76 pL
2 Heart 76 pL

3. Add the required volume of sample stock (100 ng/pL) to each empty tube:

Tube Sample name Diluent volume
1 Kidney 4 pL
2 Heart 4 puL

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the standard dilution series for FAS and HPRT
assays

The same standard materials are used to prepare the exact same dilutions for both the target genes.
The prepared standards are then used to generate the two standard curves.

* The stock concentration for cDNA is 100 ng/pL.

® The volumes calculated for both the FAS and HPRT assays are:

Standard name Dilution Source Diluent Total Standard
. Source .
(labeled tube) point volume volume volume concentration
Std. 1 1 Stock 20 uL 20 uL 40 pyL 100 ng/pL
Std. 2 2 Dilution 1 20 uL 20 pL 40 pL 50 ng/pL
Std. 3 3 Dilution 20 uL 20 yL 40 pL 25 ng/pL
Std. 4 4 Dilution 3 20 uL 20 yL 40 pL 12.5 ng/puL
Std. 5 5 Dilution 4 20 uL 20 yL 40 pyL 6.25 ng/pL
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1. Label ten separate microcentrifuge tubes for each diluted standard:
* FAS (FAS Std. 1 - FAS Std. 5)
e HPRT (HPRT Std. 1 - HPRT Std. 5)

2. Prepare five standard dilutions each for FAS and HPRT:

Note: For dilution 1, first vortex the stock for 3 to 5 seconds, then centrifuge both the Std. 1 tubes
briefly before pipetting 10 L stock into each Std. 1 tube.

3. For each subsequent dilution, add source to the standard:

a. Use a new pipette tip to add 10 pL of source to the FAS and HPRT tubes containing the
standard.

b. Vortex the tubes for 3 to 5 seconds, then centrifuge the tubes briefly.

4. Place the standards on ice until you prepare the reaction plate.

Prepare the reaction mix

1. Label an appropriately sized tube for each reaction mix:
* FAS Reaction Mix
* HPRT Reaction Mix

2. For the FAS assay, add the required volumes of each component to the FAS Reaction Mix tube:

Note: Extra volume is already factored in for pipetting error

Component Volume for 1 reaction | Volume for 30 reactions
TagMan™ Gene Expression Master Mix (2 X) 10 L 300 pL
FAS Assay Mix (20 X) 1 pL 30 pL
Water 8 L 240 pL
Total Reaction Mix Volume 19 uL 570 pyL

3. For the HPRT assay, add the required volumes of each component to the HPRT Reaction Mix tube:

Component Volume for 1 reaction | Volume for 30 reactions
TagMan™ Gene Expression Master Mix (2 X) 10 yL 300 pL
HPRT Assay Mix (20X 1L 30 pL
Water 8 uL 240 uL
Total Reaction Mix Volume 19 uL 570 pyL

4. Mix the reaction in each tube by gently pipetting up and down, then cap each tube.

5. Centrifuge the tubes briefly to remove air bubbles.
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6. Place the reaction mixes on ice until you prepare the reaction plate.
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Note: Do not add the sample or standard at this time.

Prepare the reaction plate

Example experiment reaction plate components

The reaction plate for the Relative Standard Curve example experiment contains:

Figure 33 Plate layout for example experiment

To prepare the reaction plate components

1.

A MicroAmp™ Optical 96-Well Reaction Plate

Reaction volume: 20 yL/well

12 Unknown wells

30 Standard wells £
2 Negative Control wells [

52 Empty wells

For each target, prepare the negative control reactions:

a. To an appropriately sized tube, add the volumes of reaction mix and water listed below.

Tube Reaction mix Reaction mix volume Water volume
1 FAS Reaction Mix 19 puL 1L
2 HPRT Reaction Mix 19 pL 1uL
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b. Mix the reaction by gently pipetting up and down, then cap the tube.

¢. Centrifuge the tube briefly to remove air bubbles.

d. Add 20 pL of the negative control reaction to the appropriate wells in the reaction plate.

2. For each replicate group, prepare the standard reactions:

a. To appropriately sized tubes, add the volumes of reaction mix and standard listed below.

Tube | Standard rection Reaction mix Reaction mix Standard | Standard volume
volume
1 FAS Std. 1 FAS Reaction Mix 76 pL FAS Std. 1 4 L
2 FAS Std. 2 FAS Reaction Mix 76 pL FAS Std. 2 4L
3 FAS Std. 3 FAS Reaction Mix 76 pL FAS Std. 3 4 L
4 FAS Std. 4 FAS Reaction Mix 76 pL FAS Std. 4 4L
5 FAS Std. 5 FAS Reaction Mix 76 pL FAS Std. 5 4 L
6 HPRT Std. 1 | HPRT Reaction Mix 76 pL HPRT Std. 1 4L
7 HPRT Std. 2 HPRT Reaction Mix 76 pL HPRT Std. 2 4 L
8 HPRT Std. 3 | HPRT Reaction Mix 76 pL HPRT Std. 3 4L
9 HPRT Std. 4 HPRT Reaction Mix 76 pL HPRT Std. 4 4 L
10 HPRT Std. 5 | HPRT Reaction Mix 76 pL HPRT Std. 5 4L

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 20 L of the standard reaction to the appropriate wells in the reaction plate.

3. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample listed below:

Tube | Unknown reaction Reaction mix Reaction mix volume | Sample | Sample volume
1 FAS Kidney FAS Reaction Mix 76 pL Kidney 4 uL
2 FAS Heart FAS Reaction Mix 76 pL Heart 4 uL
3 HPRT Kidney HPRT Reaction Mix 76 pL Kidney 4 uL
4 HPRT Heart HPRT Reaction Mix 76 pL Heart 4 uL

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 20 pL of the unknown (sample) reaction to the appropriate wells in the reaction plate.

4. Seal the reaction plate with optical adhesive film.
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5. Centrifuge the reaction plate briefly to remove air bubbles.

6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the
reaction plate again at a higher speed and for a longer period of time.

7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing templates

When you prepare your own Relative Standard Curve experiment, we recommend the following
templates:

e Complementary DNA (cDNA)—cDNA reverse-transcribed from total RNA samples.
* Genomic DNA (gDNA)—Purified gDNA already extracted from tissue or sample

Tips for preparing sample dilutions
When you prepare your own Relative Standard Curve experiment, for optimal performance of the

TagMan™ Gene Expression Assay or the Custom TagMan™ Gene Expression Assay, use 10-100 ng of
cDNA template per 10—pL reaction.

Tips for preparing the reaction mix

If your experiment includes more than one target assay, prepare the reaction mix for each target assay
separately.

Tips for preparing the reaction plate

When you prepare your own Relative Standard Curve experiment, make sure the arrangement of the
PCR reactions matches the plate layout displayed in the QuantStudio™ 12K Flex Software.

More information

Information Reference
Assigning the reaction plate components Chapter 1, “General information and instructions”
Sealing the reaction plate Chapter 1, “General information and instructions”
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Run the experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K Flex Real-Time
PCR Instrument.

IMPORTANT! Run the experiment at the same ambient temperature at which you calibrated the
instrument. Extreme variations in ambient temperature can affect the heating and cooling of the
instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the
instrument is in operation.

Start the run

1. Open the Relative Standard Curve example file that you created.
See Chapter 10, “Design the experiment”.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the run

You can monitor an experiment run in three ways:
* From the Run screen of the QuantStudio™ 12K Flex Software, while the experiment is in progress

* From the Instrument Console screen of the QuantStudio™ 12K Flex Software, to monitor an
experiment started from another computer or from the instrument touchscreen (see “Monitor a run
from the software Instrument Console screen” on page 162)

* From the instrument touchscreen (see “Monitor a run from the instrument touchscreen” on
page 165)

Monitor a run from the software Instrument Console screen

1. In the Instrument Console screen, select the icon of the instrument that you are using to run the
experiment.

2. Click Manage Instrument or double-click on the instrument icon.

3. In the Instrument Manager screen, click Monitor Running Experiment to access the Run
screen.
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View the amplification plot

You can view the progress of the run in real time. During the run, periodically view all the three plots
available from the QuantStudio™ 12K Flex Software for potential problems.

Click Amplification Plot from the Run Experiment menu, select the Plate Layout tab, then select the
wells to view.

Figure 34 The Amplification Plot screen as it appears at the end of the example experiment

View the temperature plot

Click Temperature Plot from the Run Experiment menu.

Figure 35 The Temperature Plot screen as it appears during the example experiment

Note: The sample temperature displayed in the Current Temperatures group is an estimated value.
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View the run method

Click Run Method from the Run Experiment menu.

Figure 36 The Run Method screen as it appears in the example experiment

View run data

Click View Run Data from the Run Experiment menu.

Figure 37 The View Run Data screen as it appears in the example experiment
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Monitor a run from the instrument touchscreen

You can view the progress of the run from the instrument touchscreen.

The following figures are for visual representation only. Actual results vary with the experiment.

Figure 38 Experiment View tab
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Figure 39 Time View tab

Figure 40 Plot View tab
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Review results and adjust
experiment parameters

The following topics are covered in this chapter:

* Review the analyzed data using several of the analysis screens and publish the data (see “Review
results” on page 167)

* Modify experiment parameters to troubleshoot problems with experiment results before rerunning
an experiment (see “Adjust parameters for re-analysis of your own experiments” on page 189)

Review results

Analyze the example experiment

1. Open the example experiment file.
See Chapter 12, “Run the experiment”.

2. Click Analyze.

Note: You can also access the experiment to analyze from the Home screen.

The software analyzes the data using the default analysis settings.

View the standard curve plot

The Standard Curve Plot screen displays the standard curve for samples designated as standards. The
QuantStudio™ 12K Flex Software calculates the quantity of an unknown target from the standard curve.
Example experiment standard curve values

The purpose of viewing the standard curve for the example experiment is to identify the following items:
* Slope and amplification efficiency
* R? value (correlation coefficient)

® (Cyvalues

View and assess the standard curve plot

1. From the Experiment Menu pane, select Analysis » Standard Curve.

Note: If no data are displayed, click Analyze.
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2. Display all 96 wells in the Standard Curve Plot screen by clicking the upper left corner of the plate

layout in the Plate Layout tab.

3. Enter the plot settings.

It

plot legend.)

(This is a toggle button. When the legend is displayed, the button changes to Hide the

Menu Selection
Target All
Plot Color Default
Check (default)

4. View the values displayed below the standard curve.

In the example experiment, the values for each target fall within the acceptable ranges.

Target Slope R2 Value Ampilification efficiency (Eff%)
FAS -3.38 0.998 97.612
HPRT -3.652 0.983 87.858

5. Check that all samples are within the standard curve.

In the example experiment, all samples (blue dots) are within the standard curve (red dots).

6. Check the Cy values.

a. Click the Well Table tab.

b. From the Group By menu, select Replicate.
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c. Look at the values in the Ct column.
In the example experiment, the Ct values fall within the expected range (>8 and <35).

Tips for analyzing your own experiments

When you analyze your own Relative Standard Curve experiment, look for the following items:

* Slope/amplification efficiency values—The amplification efficiency is calculated using the slope
of the regression line in the standard curve. A slope close to — 3.3 indicates optimal, 100% PCR
amplification efficiency. The following factors affect amplification efficiency:

— Range of standard quantities—For more accurate and precise efficiency measurements, use a
broad range of standard quantities, 5 to 6 logs (10° to 108 fold).

— Number of standard replicates —For more accurate efficiency measurements, include
replicates to decrease the effects of pipetting inaccuracies.

— PCR inhibitors—PCR inhibitors in the reaction can alter amplification efficiency.

* R2values (correlation coefficient)—The R? value is a measure of the closeness of fit between the
regression line and the individual Ct data points of the standard reactions. A value of 1.00 indicates
a perfect fit between the regression line and the data points. An R? value >0.99 is desirable.

® Cyvalues—The threshold cycle (Cy) is the PCR cycle number at which the fluorescence level
meets the threshold.

— A Gy value >8 and <35 is desirable.
— A Gy value <8 indicates that there is too much template in the reaction.
— A Gy value >35 indicates a low amount of target in the reaction. For Ct values >35, expect a
higher standard deviation.
If your experiment does not meet the guidelines above, troubleshoot as follows:

*  Omit wells (see “Improve CT precision by omitting wells” on page 194).
Or

* Rerun the experiment.
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Assess amplification results using the amplification plot

Amplification plots available for viewing
The Amplification Plot screen displays amplification of all samples in the selected wells. There are
three plots available:

* ARn vs Cycle—ARn is the magnitude of normalized fluorescence signal generated by the reporter
at each cycle during the PCR amplification. This plot displays ARn as a function of cycle number.
Use this plot to identify and examine irregular amplification and to view threshold and baseline
values for the run.

* Rn vs Cycle—Rn is the fluorescence signal from the reporter dye normalized to the fluorescence
signal from the passive reference. This plot displays Rn as a function of cycle number. Use this plot
to identify and examine irregular amplification.

® Cyvs Well—C+ is the PCR cycle number at which the fluorescence meets the threshold in the
amplification plot. This plot displays Ct as a function of well position. Use this plot to locate
outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

Purpose

The purpose of viewing the amplification plot for the example experiment is to identify:
* Correct baseline and threshold values
® Quitliers

View the amplification plot

1. In the Experiment Menu pane, click Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Display the FAS wells in the Amplification Plot screen.
a. Click the Plate Layout tab.
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b. In the Select Wells dropdown list, select Target » FAS.

Figure 41 Plate Layout screen

3. In the Amplification Plot screen, select the following.

Item Select
Plot Type dropdown list ARn vs Cycle
Plot Color dropdown list Well (default)

Check (default)

(This is a toggle button. When the legend is displayed, the button changes to Hide the
plot legend).

4. View the baseline values.
a. From the Graph Type dropdown list, select Linear.

b. Select the Baseline checkbox to show the start cycle and end cycle.
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c. Confirm that the baseline is set correctly. The end cycle should be set a few cycles before the
cycle number where significant fluorescent signal is detected. In the example experiment, the
baseline is set correctly.

5. View the threshold values.

ltem Select
Graph Type dropdown list Log
Target dropdown list RNaseP

a. Select the Threshold check box to show the threshold.
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b. Confirm that the threshold is set correctly. In the example experiment, the threshold is in the
exponential phase.

6. Locate outliers.
a. In the Plot Type dropdown list, select Ct vs. Well.

b. Look for outliers from the amplification plot. In the example experiment, there are no outliers
for FAS.

7. Repeat step 2 to step 6 for the HPRT wells.
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Tips for analyzing your own experiments
When you analyze your own Relative Standard Curve experiment, look for the following items:

e OQutliers

* A typical amplification plot—The QuantStudio™ 12K Flex Software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a typical amplification
plot. A typical amplification plot has four distinct sections:

— Plateau phase
— Linear phase
— Exponential (geometric phase)

— Baseline

Figure 42 Typical amplification plot

IMPORTANT! Experimental error (such as contamination or pipetting errors) can produce atypical
amplification curves that can result in incorrect baseline and threshold value calculations by the
QuantStudio™ 12K Flex Software. We recommend that you examine the Amplification Plot screen
and review the assigned baseline and threshold values for each well after analysis completes.

Note: If you use the Relative Threshold algorithm to analyze an experiment that includes
amplification, select to view the analysis results using the ARn vs Cycle, Rn vs Cycle, or Cgr
vs Well plot type and Linear or Log graph type. Also select the Show Crt checkbox to view the
derived fractional cycle on the amplification plot.
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® Correct threshold values

Condition Example

Threshold Set Correctly

The threshold is set in the exponential phase of the
amplification curve.

Threshold settings above or below the optimum increase
the standard deviation of the replicate groups.

Threshold Set Too Low

The threshold is set below the exponential phase

of the amplification curve. The standard deviation is
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar up into
the exponential phase of the curve.

Threshold Set Too High

The threshold is set above the exponential phase

of the amplification curve. The standard deviation is
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar down
into the exponential phase of the curve.
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Condition

Example

Baseline Set Correctly

The amplification curve begins after the maximum
baseline.

Baseline Set Too Low

The amplification curve begins too far to the right of the
maximum baseline. Increase the End Cycle value.

Baseline Set Too High

The amplification curve begins before the maximum
baseline. Decrease the End Cycle value.

If your experiment does not meet the guidelines above, troubleshoot as follows:

* Omit wells (see “Improve CT precision by omitting wells” on page 194).

Or

* Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on page 189).
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Assess the gene expression profile using the gene expression plot

The Gene Expression Plot screen displays the results of relative quantification calculations in the gene
expression profile. There are two plots available:

* RQ vs Target—Groups the relative quantification (RQ) values by target. Each sample is plotted for
each target. You can view the plot as the linear, log10, Ln, and log2 graph types.

Figure 43 Gene Expression plot when viewed as a linear graph

178 QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide



Chapter 13 ¥y

Review results

* RAQ vs Sample—Groups the relative quantification (RQ) values by sample. Each target is plotted for
each sample. You can view the plot as the linear, 1og10, Ln, and log2 graph types.

Figure 44 Gene Expression plot when viewed as a linear graph

Example experiment values

Review each target in the Gene Expression Plot screen for the expression level (or fold change) of the
target sample relative to the reference sample.

View the gene expression plot

1. In the Experiment Menu pane, click Analysis » Gene Expression.

Note: If no data are displayed, click Analyze.

2. Select the following items in the Gene Expression Plot screen.
a. In the Plot Type dropdown list, select RQ vs Sample.

b. In the Graph Type dropdown list, select Log10.

c. In the Orientation dropdown list, select Vertical Bars.
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3. Click Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.

In the example experiment, the expression level of HPRT in heart is displayed relative to its expression
level in the reference sample (kidney). Since the reference sample is compared to itself, the relative
expression level is 1. When the result is displayed in the Log10 graph type, the expression level of the
reference sample appears as 0 in the graph (log10 of 1 = 0).

Assessing the gene expression plot in your own experiments

When you analyze your own Relative Standard Curve experiment, look for differences in gene
expression (as a fold change) relative to the reference sample.

Identify well problems using the well table

The Well Table displays data for each well in the reaction plate, including the following items:

* The sample name, target name, task, and dyes
* The calculated threshold cycle (Cy), normalized fluorescence (Rn), and quantity values

* Flags
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Example experiment values and flags

Review the Well Table to evaluate the Ct precision of the replicate groups.

View the well table
1. In the Experiment Menu pane, select Analysis » Amplification Plot, then click the Well Table tab.
2. In the Group By dropdown list, select Replicate.

3. Look at the Gt SD column to evaluate the Ct precision of the replicate groups.
In the example experiment, the Ct SD have the expected value of < 0.5.

Note: To show or hide columns in the Well Table, select or deselect respectively the column name from
the Show in Table dropdown list.

Assess the well table in your own experiments

When you analyze your own Relative Standard Curve experiment, look for standard deviation in the
replicate groups (Ct SD values). If needed, omit outliers (“Improve CT precision by omitting wells” on
page 194).
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Confirm accurate dye signal using the multicomponent plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected
well over the duration of the PCR run.

Purpose

In the Relative Standard Curve example experiment, you review the Multicomponent Plot screen for the
following items:

ROX™ dye (passive reference)

FAM™ dye (reporter for RNase P)

Spikes, dips, and/or sudden changes
Amplification in the negative control wells

View the multicomponent plot

1.

182

In the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

Display the unknown and standard wells one at a time in the Multicomponent Plot screen.
a. Click the Plate Layout tab.

b. Select one well in the plate layout. The well is shown in the Multicomponent Plot.

Note: If you select multiple wells, the Multicomponent Plot displays the data for all selected
wells simultaneously.

In the Plot Color dropdown list, select Dye.

Click "] Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.

Check the FAM™ dye signal.

In the example experiment, the FAM™ dye signal increases throughout the PCR process, indicating
normal amplification.
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6. Check the ROX™ dye signal.

g ye

In the example experiment, the ROX™ dye signal remains constant throughout the PCR process

indicating typical data.

7. Select the negative control wells one at time and check for amplification.

In the example experiment, there is no amplification in any of the negative control wells.
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Tips for confirming dye accuracy in your own experiment

When you analyze your own Relative Standard Curve experiment, look for the following items:

* Passive reference—The passive reference dye fluorescence level should remain relatively constant
throughout the PCR process.

* Reporter dye—The reporter dye fluorescence level should display a flat region corresponding to
the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.

* Irregularities in the signal—There should not be any spikes, dips, and/or sudden changes in the
fluorescent signal.

* Negative Control wells—There should not be any amplification in the negative control wells.

Determine signal accuracy using the raw data plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter
for the selected wells during each cycle of the real-time PCR.

About the example experiment

In the Relative Standard Curve example experiment, you review the Raw Data Plot screen for a stable
increase in signal (no abrupt changes or dips) from the appropriate filter.

View the raw data plot

1. In the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate
layout in the Plate Layout tab.
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3. Click [7] Show a legend for the plot (default).

The legend displays the color code for each row of the reaction plate (see the legend in the Raw
Data Plot shown below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example experiment, there
is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.

Figure 45 Filters used for the example experiment
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Tips for determining signal accuracy in your own experiment

When you analyze your own Relative Standard Curve experiment, look for the following item in each
filter:

® Characteristic signal growth
* No abrupt changes or dips

View the endogenous control profile using the QC plot

186

In the Relative Standard Curve experiment, the QC Plot screen displays the Endogenous Control Profile
plot for all the targets in the experiment. The QC Plot serves as a tool to help users choose the best
endogenous control for that experiment. The endogenous control profile plot is a visual display of the
Cr values of the endogenous control across each sample. You can view up to four endogenous controls
at a time. The sample is plotted on the X-axis, and the Ct is plotted on the Y-axis. Each candidate
control is viewed as a color and shape combination in the plot. Endogenous controls are also known as
reference genes.

1. In the Experiment Menu pane, select Analysis » QC Plot.

Note: If no data are displayed, click Analyze.

2. In the QC Plot screen, click Target Table to select a target to profile.

a. In the Candidate Control column, select the check box of the target of the endogenous
control profile to plot.

In the example experiment, the endogenous control is FAS.
b. Select a color from the Color dropdown list.
c. Select a shape from the Shape dropdown list.
3. Click the View Replicate Results Table tab.
4. Select the checkbox associated with the samples you want to plot.

5. Click [7] Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.
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Figure 46 QC Plot in the Relative Standard Curve example experiment
This example experiment does not define Biological Groups.

Review the QC flags in the QC summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the flag
frequency and location for the open experiment.

View the QC summary

1. In the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the
experiment. If the frequency is greater than 0, the flag appears somewhere in the experiment. The
well position is listed in the Wells column.

In the example experiment, there are no flagged wells.
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3. In the Flag Details table, click each flag with a frequency greater than 0 to display detailed
information about the flag. In the example experiment, the Frequency column displays 0 for all
flags.

4. (Optional) For those flags with frequency greater than 0, click the troubleshooting link to view
information about correcting the flag.

Figure 47 QC Summary screen for the example experiment

Possible flags

The flags listed below may be triggered by the experiment data.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification

NOISE Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed
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(continued)

Flag Description
THOLDFAIL Thresholding algorithm failed
CTFAIL Cr algorithm failed

AMPSCORE | Ampilification in the linear region is below a certain threshold, corresponding to the score set
in the analysis settings

Secondary analysis flags

OUTLIERRG Outlier in replicate group
AMPNC Ampilification in the negative control
HIGHSD High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL
flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed
in the Frequency column for each flag).

More information

Information Reference

Publishing data Chapter 1, “General information and instructions”

Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle (C7), flags, and
advanced options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your
experiment.
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View the analysis settings

1. In the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
® (7 Settings
* Flag Settings
* Relative Quantification Settings
¢ Advanced Settings
* Standard Curve Settings

Figure 48 Analysis Settings dialog box for a Relative Standard Curve experiment

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” on page 191).

Note: You can save the changes to the analysis settings to the Analysis Settings Library for later
use. For more information, see “About the analysis settings library” on page 62.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to Default Analysis
Settings.
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Adjust analysis settings
Cr settings

¢ Data Step Selection
Use this feature to select one stage/step combination for Ct analysis when there is more than one
data collection point in the run method.

* Algorithm Settings
You can select the algorithm that determines the Ct values. There are two algorithms: Baseline
Threshold (the default) and Relative Threshold.
The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline
component and sets a fluorescent threshold in the exponential region for quantification.

The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency
and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no
dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a
threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold
will not affect the analysis.

* Default Ct Settings
Use the default Cy settings feature to calculate C+ for the targets that do not have custom settings.
To edit the default settings, click Edit Default Settings.

® Cy Settings for Target
When you manually set the threshold and baseline, we recommend the following settings:

Setting Recommendation

Threshold | Enter a value for the threshold so that the threshold is:
— Above the background.
— Below the plateau and linear regions of the amplification curve.

— Within the exponential phase of the amplification curve.

Baseline | Select the Start Cycle and End Cycle values so that the baseline ends before significant
fluorescent signal is detected.

Note: Selecting Automatic Threshold implies selection of automatic setting of the baseline.
However, if Automatic Threshold is deselected, then you can choose between setting the baseline
either automatically or manually.

Flag settings

Use the Flag Settings tab to perform the following tasks:
* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the QuantStudio™ 12K Flex Software.
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1. Inthe Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying
the flag.

Note: If you choose to adjust the setting for applying a flag, make minor adjustments as you
evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the
flag.

Note: After you have rejected the flagged wells, analysis results depend on factors such as the
experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments
using the Standard Deviation calculations might change the result of Ct SD. For some flags,
analysis results calculated before the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box.
If the run status is complete, the data are reanalyzed.

Figure 49 Flag Settings tab
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Relative quantification settings

Use the Relative Quantification Settings tab to perform the following tasks:
* Change the type of analysis, singleplex or multiplex.
* (Change the reference sample and/or endogenous control.
* Reject Outliers with ACt values less than or equal to the entered value.

Note: The Outlier Rejection settings apply only to multiplex reactions.

¢ Select the algorithm to use to determine the relative quantification minimum and maximum values
(error bars):

— Confidence Level—Select to calculate the RQ minimum and maximum values based on the
selected confidence level. Select the confidence level to use.

— Standard Deviations —Select to calculate the RQ minimum and maximum values based on
the selected number of standard deviations. Select the number of standard deviations to use.

Advanced settings

Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative Threshold setting.

The following steps describe the use of custom baseline settings for a well-target combination.
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target checkbox.

3. Define the custom baseline settings:
* For automatic baseline calculations, select the Automatic Baseline checkbox.

* To define the baseline, deselect the Automatic Baseline checkbox, then enter the baseline
start cycle and baseline end cycle.
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Standard curve settings

Use this tab to review the settings of the current standard curve experiment or to import the standard
curve from an external experiment (with the same samples and targets) and apply it to this current
experiment.

Note: The run method must be the same. We recommend using the standard curve from the current
experiment.

For the example experiment, the settings from the current experiment have been used.

Improve Ct precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all. These wells typically
produce Cy values that differ significantly from the average for the associated replicate wells. If included
in the calculations, these outliers can result in erroneous measurements. To support Ct precision, omit
the outliers from the analysis.

Note: In the Relative Standard Curve example experiment, there are no outliers. No wells need to be
removed from analysis.

1. In the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.
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2. In the Amplification Plot screen, select Ct vs Well from the Plot Type dropdown list.
3. Select the Well Table tab, select replicates to omit:

4. |n the Well Table, view the outliers:
a. From the Group By dropdown list, select Replicate.

b. Look for outliers in the replicate group (make sure they are flagged).

c. Select the Omit checkbox next to outlying well or outlying wells, as shown below.

5. Click Analyze to reanalyze the experiment data with the outlying well or outlying wells removed
from the analysis.

Note: You can also omit undesirable wells in an experiment from the Plate Layout screen. To omit
a well from the Plate Layout screen, right-click the well, then click Omit.
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Export analysis results

. Open a Relative Standard Curve example experiment file that has been analyzed.

For information about analysis, see Chapter 13, “Review results and adjust experiment
parameters”.

In the Experiment Menu pane, click Export.

Note: To export data automatically after analysis, select the Auto Export checkbox during
experiment setup or before running the experiment. The Auto Export checkbox is unchecked
for the example experiment.

- In the Format dropdown list, select QuantStudio 12K Flex format.

Note: In the Format dropdown list, select 7900 if you want to export the Clipped Data.

. Complete the Export dialog box as shown below.

Field or Selection Entry
Select Data to export/Select Content | Results
Export Data To options One File radio button
Export File Name field 96-Well Relative Std Curve Example_QuantStudio_export
File Type dropdown list "ixt
Export File Location field Use the default file location or click Browse to select a different
location
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Figure 50 Export screen

Figure 51 Exported file
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Overview of comparative Ct
experiments

IMPORTANT! First-time users of the QuantStudio™ 12K Flex Real-Time PCR System, see the part
“Getting started” on page 17 and Appendix A, “Documentation and support”. The sections provide
information and general instructions that are applicable to all the experiments described in this
document.

Note: For more information about any of the topics discussed in this guide, access the Help from
within the QuantStudio™ 12K Flex Software by pressing F1, clicking  in the toolbar, or selecting
Help » QuantStudio 12K Flex Software Help.

Overview of comparative Ct experiments

The Comparative CT (AACT) method is used to determine the relative target quantity in samples. With
the comparative Ct method, the QuantStudio™ 12K Flex Software measures amplification of the target
and of the endogenous control in samples and in a reference sample. Measurements are normalized
using the endogenous control. The software determines the relative quantity of target in each sample by
comparing normalized Ct (ACy) in each sample to normalized Ct (ACy) in the reference sample.
Comparative Gy experiments are commonly used to perform the following tasks:

* Compare expression levels of a gene in different tissues

* Compare expression levels of a gene in a treated sample and an untreated sample

* Compare expression levels of wild-type alleles and mutated alleles

* Analyze the gene expression changes over time under specific treatment conditions

Assemble required components

¢ Sample—The tissue group that you are testing for a target gene.

* Reference sample (also called a calibrator) —The sample used as the basis for relative
quantification results. For example, in a study of drug effects on gene expression, an untreated
control is an appropriate reference sample.

* Endogenous control—A gene that is used to normalize template input differences, and sample-to-
sample or run-to-run variation.

* Replicates—The total number of identical reactions containing identical components and identical
volumes.

* Negative Controls—Wells that contain water or buffer instead of sample template. No
amplification of the target should occur in negative control wells.
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PCR options

When performing real-time PCR, choose between:
* Singleplex PCR and multiplex PCR (see “Singleplex and multiplex PCR” on page 200)
and
* 1-step RT-PCR and 2-step RT-PCR (see “1- and 2-step RT-PCR” on page 200
)

Singleplex and multiplex PCR

You can perform a PCR reaction using either:
¢ Singleplex PCR—In singleplex PCR a single primer and probe set is present in the reaction tube or
well. Only one target or endogenous control can be amplified per reaction.
Or
* Multiplex PCR—In multiplex PCR, two or more primer and probe sets are present in the reaction
tube or well. Each set amplifies a specific target or endogenous control.

One example is a probe that is labeled with FAM™ dye detects the target and a probe that is
labeled with VIC™ dye detects the endogenous control.

IMPORTANT! SYBR™ Green reagents cannot be used for multiplex PCR.

1- and 2-step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in separate reactions
(2-step). The reagent configuration you use depends on whether you are performing 1- or 2-step
RT-PCR.

* 1-step RT-PCR—In 1-step RT-PCR, RT and PCR take place in one buffer system. Using one
buffer system provides the convenience of a single-tube preparation for RT and PCR amplification.
However, you cannot use Fast PCR Master Mix or the carryover prevention enzyme, AmpErase™
UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

* 2-step RT-PCR—2-step RT-PCR is performed in two separate reactions. First, total RNA is
reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful for
detecting multiple transcripts from a single cDNA template or for storing cDNA aliquots for later
use. The AmpErase™ UNG enzyme can be used to prevent carryover contamination.
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About the example experiment

To illustrate how to perform comparative Cy experiment, this guide leads you through the process of
designing and performing an example experiment. The example experiment represents a typical setup
that you can use to quickly familiarize yourself with the QuantStudio™ 12K Flex Real-Time PCR System.

The objective of the comparative C; example experiment is to compare the expression of GH1, LPINT,
TGFB1, LIPC, ACTB, and CCKAR in liver, heart, brain, and lung tissues.

The samples are liver, heart, lung, and brain tissues.

The targets are GH1, LPIN1, TGFB1, LIPC, ACTB, and CCKAR.
The reference sample is brain.

The endogenous control is ACTB.

The experiment is designed for singleplex PCR, where the targets and endogenous control assays
are performed in separate wells.

Reactions are set up for 2-step RT-PCR. The SuperScript™ VILO™ cDNA Synthesis Kit is used for
reverse transcription. The TagMan™ Fast Universal PCR Master Mix is used for PCR.

Primer and probe sets are selected from the TagMan™ Gene Expression Assay product line:
- GH1 Assay Mix: Hs00236859_m1

— LPIN1 Assay Mix: Hs00299515_m1
— LIPC Assay Mix: Hs00165106_m1

— ACTB Assay Mix: Hs99999903_m1
— TGFB1 Assay Mix: Hs00998133_m1
— CCKAR Assay Mix: Hs00167891_m1
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Design the experiment

This chapter explains how to design the example experiment from the Setup menu in the Experiment

Menu pane.

Note: To automatically export the analyzed data to a specified location, select the Auto Export
checkbox in the Export screen, before running the experiment. For more information on Auto Export,
see the part “Getting started” on page 17.

Define the experiment properties

In the Experiment Menu pane, click Setup » Experiment Properties.

Enter or select the following information.

Field or Selection

Entry

Experiment Name field

Enter 96-Well Fast Comparative CT Example.eds.

Barcode field

Leave the Barcode field empty.

User Name field

Enter Example User or enter a user name.

Comments field

Enter Comparative CT example.

Block Select 96-Well (0.2 mL).
Experiment Type Select Comparative Ct (AACy).
Reagents Select TagMan Reagents.
Ramp speed Select Fast.

Save the experiment.
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Figure 52 Experiment Properties screen
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Define targets, samples and biological replicates

Define targets, samples and biological replicates

1. Click Define to access the Define screen.

2. Enter the following target information.

Target name | Reporter | Quencher Color
GHA1 FAM | NFQ-MGB .
LP1N1 FAM |NFQ-MGB
Il
TGFBH FAM |NFQ-MGB
N
L1PC FAM |NFQ-MGB
ACTB FAM |NFQ-MGB .
CCKAR FAM | NFQ-MGB .
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3. Enter the following sample information.

Sample Name Color

Brain

R

Liver

Heart .

4. In the Passive Reference dropdown list, select ROX .
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5. Enter the following analysis settings.
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Field Select
Reference Sample field Brain
Endogenous Control field ACTB

Figure 53 Define screen

Note: This example experiment does not define biological replicate groups. Leave the Biological

Replicate Groups pane blank.
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Assign targets, samples and biological groups

Click Assign to access the Assign screen.

Enter the following targets and samples.

Target name Well number Task Sample name
GH1 A1, B1, C1 Unknown Heart
A2, B2, C2 Unknown Brain
E1, F1, G1 Unknown Lung
E2, F2, G2 Unknown Liver
D1, D2, H1, H2 Negative Heart, Brain, Lung, Liver
LP1N1 A3, B3, C3 Unknown Heart
A4, B4, C4 Unknown Brain
E3, F3, G3 Unknown Lung
E4, F4, G4 Unknown Liver
D3, D4, H3, H4 Negative Heart, Brain, Lung, Liver
TGFB1 A5, B5, C5 Unknown Heart
A6, B6, C6 Unknown Brain
E5, F5, G5 Unknown Lung
E6, F6, G6 Unknown Liver
D5, D6, H5, H6 Negative Heart, Brain, Lung, Liver
L1PC A7, B7, C7 Unknown Heart
A8, B8, C8 Unknown Brain
E7, F7, G7 Unknown Lung
ES8, F8, G8 Unknown Liver
D7, D8, H7, H8 Negative Heart, Brain, Lung, Liver
ACTB A9, B9, C9 Unknown Heart
A10, B10, C10 Unknown Brain
E9, F9, G9 Unknown Lung
E10, F10, G10 Unknown Liver
D9, D10, H9, H10 Negative Heart, Brain, Lung, Liver
CCKAR A11, B11, C11 Unknown Heart
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(continued)
Target name Well number Task Sample name
CCKAR A12,B12, C12 Unknown Brain
E11, F11, G11 Unknown Lung
E12, F12, G12 Unknown Liver
D11, D12, H11, H12 Negative Heart, Brain, Lung, Liver

Figure 54 Assign screen

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View
tab. Enter the following information:

* Reaction Volume Per Well: 20 uL

* Thermal Profile
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Stage Step | Ramp rate | Temperature Time
Hold Stage Step 1| 2.05°C/s 95°C 20 seconds
PCR Stage Step 1| 2.05°C/s 95°C 1 second
Number of Cycles: 40 Step 2| 1.71°C/s 60°C 22 seconds

Enable AutoDelta: Unchecked (default)

Starting Cycle: Disabled when Enable AutoDelta is
unchecked

Figure 55 Run Method screen

Tips for designing your own experiment

We recommend the following items for your own experiments:
* |dentify each target assay with a unique name and color. You can enter up to 100 characters in the
Target Name field.
¢ |dentify each sample using a unique name and color. You can enter up to 100 characters in the
Sample Name field.
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* Select an endogenous control for each sample. The endogenous control is a target that is present
in all samples under investigation. It should be expressed equally in all sample types, regardless
of treatment or tissue origin (examples of endogenous controls are 3-actin, GAPDH, and 18S
ribosomal RNA [18S rRNA]). The endogenous control is used to normalize the PCR results; the
endogenous control corrects for variable sample mass, nucleic acid extraction efficiency, reverse
transcription efficiency, and pipette calibration errors. Note that:

— Each sample type (for example, each tissue in a study comparing multiple tissues) requires an

endogenous control.

— If samples are spread across multiple plates, each plate must have an endogenous control.

Additionally, every plate must include an endogenous control for every sample type on the

plate.

* Select an endogenous control from your previously defined target assays. Amplification results
from the endogenous control are used to normalize the ampilification results from the target for
differences in the amount of template added to each reaction.

* Select a reference sample from your previously defined samples. Amplification results from the
samples and from the reference sample are compared to determine relative expression.

For more information

Information

Reference

Consumables

Chapter 1, “General information and instructions”

Using the Standard Curve quantification
methods

“Running standard curve experiments” on page 86

Using the Relative Standard Curve
quantification method

“Running relative standard curve experiments” on
page 145

Using alternative setup

Chapter 2, “Experiment shortcuts”
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Prepare the reactions

This chapter explains how to prepare the PCR reactions for the Comparative Ct (AACy) example
experiment.

Assemble required materials

* ltems listed in the part “Getting started” on page 17
* Samples—Total RNA isolated from liver, heart, brain, and lung tissues
* Example experiment reaction mix components:

— TagMan™ Fast Universal PCR Master Mix (2X)

— ACTB Assay Mix (20X)

- TGFB1 Assay Mix (20X)

— GH1 Assay Mix (20X)

— LIPN1 Assay Mix (20X)

— LIPC Assay Mix (20X)

— CCKAR Assay Mix (20X)

Prepare the template

Prepare the template for the PCR reactions using the High-Capacity cDNA Reverse Transcription Kit or
the SuperScript™ VILO™ cDNA Synthesis Kit to perform reverse transcription.

Example experiment settings

For the Comparative Cy example experiment, the template for the PCR reactions is cDNA reverse-
transcribed from total RNA samples.

Prepare the template

Use the SuperScript™ VILO™ cDNA Synthesis Kit (Cat. No. 11754250). Follow the procedures for the kit.

1. Prepare the RT master mix.
2. Prepare the cDNA reactions.

3. Perform reverse transcription on a thermal cycler.
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Prepare the sample dilutions

Chapter 17 @
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Prepare the sample dilutions

For the Comparative Ct example experiment, no more than 10% of your reaction should consist of the
undiluted RT product.

1. Label a separate microcentrifuge tube for each diluted sample.

2. Add the required volume of water (diluent) to each empty tube.

Liver
Heart
Brain
Lung

i/

Tube Sample name Diluent volume
1 Liver 19 uL
2 Heart 19 pL
3 Brain 19 uL
4 Lung 19 pL

3. Add the required volume of cDNA sample stock (100 ng/pL) to each empty tube.

Tube Sample nhame Volume
1 Liver 1.0 pL
2 Heart 1.0puL
3 Brain 1.0pL
4 Lung 1.0puL

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the reaction mix

1. Label an appropriately sized tube for each reaction mix.
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ACTB Reaction Mix
TGFB1 Reaction Mix
GH1 Reaction Mix
LPIN1 Reaction Mix
LIPC Reaction Mix
CCKAR Reaction Mix
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2. For the ACTB assay, add the required volumes of each component to the ACTB Reaction Mix tube.

Component Volume for 1 reaction Volume _lfgz /: i‘:z?:;i:)ns (plus
TagMan™ Fast Universal PCR Master Mix (2 X) 10.0 yL 176.0 pL
ACTB Assay Mix (20 X) 1.0puL 17.6 pL
Water 8 uL 140.8 L
Total reaction mix volume 19.0 uL 158.4 uL

3. Mix the reaction mix in each tube by gently pipetting up and down, then cap each tube.
4. Centrifuge the tubes briefly to remove air bubbles.
5. Place the reaction mixes on ice until you prepare the reaction plate.

6. Repeat step 2 to step 5 for the TGFB1, GH1, LPIN1, LIPC, and CCKAR assays.

Note: Do not add the sample at this time.

Prepare the reaction plate

Example experiment reaction plate components

The reaction plate for the Comparative Ct example experiment contains:
* A MicroAmp™ Optical 96-Well Reaction Plate
* Reaction volume: 20 pL/well

* The reaction plate contains:
— 72 Unknown wells

— 24 Negative Control wells [
— 0 Empty wells
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Figure 56 Plate layout for example experiment

Prepare the reaction plate components

1.

2.

Add 1 pL of each cDNA to the appropriate wells.

Pipette 1 uL of sterile water into the NTC wells.

Add 19 pL of the appropriate assay-specific reaction mix to the wells.
Seal the reaction plate with optical adhesive film.

Centrifuge the reaction plate briefly to remove air bubbles.

Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the
reaction plate again at a higher speed and for a longer period of time.

Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.
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Tips for preparing reactions for your own experiments

Tips for preparing templates

When you prepare your own Comparative Ct experiment, we recommend the following templates:
¢ Complementary DNA (cDNA)—cDNA reverse-transcribed from total RNA samples.
* Genomic DNA (gDNA)—Purified gDNA already extracted from tissue or sample.

Tips for preparing the reaction mix

If your experiment includes more than one target assay, prepare the reaction mix for each target assay
separately.

Tips for preparing the reaction plate

When you prepare your own Comparative Ct experiment, make sure the arrangement of the PCR
reactions matches the plate layout displayed in the QuantStudio™ 12K Flex Software.

For more information

Information Reference
Assigning the reaction plate components Chapter 1, “General information and instructions”
Sealing the reaction plate Chapter 1, “General information and instructions”
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Run the experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K Flex Real-Time
PCR Instrument.

IMPORTANT! Run the experiment at the same ambient temperature at which you calibrated the
instrument. Extreme variations in ambient temperature can affect the heating and cooling of the
instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the
instrument is in operation.

Start the run

1.

Open the Comparative Ct example file that you created.
See Chapter 16, “Design the experiment”.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the run

You can monitor an experiment run in three ways:

From the Run screen of the QuantStudio™ 12K Flex Software, while the experiment is in progress

From the Instrument Console screen of the QuantStudio™ 12K Flex Software, to monitor an
experiment started from another computer or from the instrument touchscreen (see “Monitor a run
from the software Instrument Console screen” on page 215)

From the instrument touchscreen (see “Monitor a run from the instrument touchscreen” on
page 220)

Monitor a run from the software Instrument Console screen

1.

In the Instrument Console screen, select the icon of the instrument that you are using to run the
experiment.

Click Manage Instrument or double-click on the instrument icon.

In the Instrument Manager screen, click Monitor Running Experiment to access the Run
screen.
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View the amplification plot

You can view the progress of the run in real time. During the run, periodically view all the three plots
available from the QuantStudio™ 12K Flex Software for potential problems.

Click Ampilification Plot from the Run Experiment menu, select the Plate Layout tab, then select the
wells to view.

Figure 57 The Amplification Plot screen as it appears at the end of the example experiment
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View the temperature plot

Click Temperature Plot from the Run Experiment menu.

Figure 58 The Temperature Plot screen as it appears during the example experiment

Note: The sample temperature displayed in the Current Temperatures group is an estimated value.
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View the run method

Click Run Method from the Run Experiment menu.

Figure 59 The Run Method screen as it appears in the example experiment
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View run data

Click View Run Data from the Run Experiment menu.

Figure 60 The View Run Data screen as it appears in the example experiment
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Monitor a run from the instrument touchscreen

You can view the progress of the run from the instrument touchscreen.

The following figures are for visual representation only. Actual results vary with the experiment.

Figure 61 Experiment View tab
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Figure 62 Time View tab

Figure 63 Plot View tab
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Review results and adjust
experiment parameters

The following topics are covered in this chapter:

* Review the analyzed data using several of the analysis screens and publish the data (see “Review
results” on page 222)

* Modify experiment parameters to troubleshoot problems with experiment results before rerunning
an experiment (see “Adjust parameters for re-analysis of your own experiments” on page 244)

Review results

Analyze the example experiment

1. Open the example experiment file.
See Chapter 18, “Run the experiment”.

2. Click Analyze.

Note: You can also access the experiment to analyze from the Home screen.

The software analyzes the data using the default analysis settings.
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Assess the gene expression profile using the gene expression plot

The Gene Expression Plot screen displays the results of relative quantification calculations in the gene
expression profile. There are two plots available:

* RQ vs Target—Groups the relative quantification (RQ) values by target. Each sample is plotted for
each target. You can view the plot as the linear, log10, Ln, and log2 graph types.

Figure 64 Gene Expression plot when viewed as a linear graph
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* RAQ vs Sample—Groups the relative quantification (RQ) values by sample. Each target is plotted for
each sample. You can view the plot as the following graph types: linear, log10, Ln, log2.

Figure 65 Gene Expression plot when viewed as a linear graph

Example experiment values

Review each target in the Gene Expression Plot screen for the expression level (or fold change) of the
target sample relative to the reference sample.

View the gene expression plot

1. In the Experiment Menu pane, click Analysis » Gene Expression.

Note: If no data are displayed, click Analyze.

2. Select the following items in the Gene Expression Plot screen.
a. In the Plot Type dropdown list, select RQ vs Sample.

b. In the Graph Type dropdown list, select Log10.

c. In the Orientation dropdown list, select Vertical Bars.
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3. Click Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.

In the example experiment, as shown below, the expression level of each target gene in liver, heart,
and lung is displayed relative to its respective expression level in the reference sample (brain).
Since the reference sample is compared to itself, the relative expression level is 1. When the result
is displayed in the Log10 graph type, the expression level of the reference sample appears as 0 in
the graph (log10 of 1 = 0).

Assessing the gene expression plot your own experiments
When you analyze your own Comparative Ct experiment, look for differences in gene expression (as a
fold change) relative to the reference sample.

Identify well problems using the well table

The Well Table displays data for each well in the reaction plate, including:
* The sample name, target name, task, and dyes
* The calculated threshold cycle (Ct), normalized fluorescence (Rn), and quantity values
* Flags
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Example experiment values and flags

Review the Well Table to evaluate the Ct precision of the replicate groups.

View the well table

1. In the Experiment Menu pane, select Analysis » Amplification Plot,, then click the Well Table
tab.

2. In the Group By dropdown list, select Replicate.

3. Look at the Gt SD column to evaluate the Ct precision of the replicate groups.

In the example experiment, there are ten outliers. These wells are omitted in the troubleshooting
section (“Improve CT precision by omitting wells” on page 248).

Note: To show or hide columns in the Well Table, select or deselect respectively the column name from
the Show in Table dropdown list.

Assessing the well table in your own experiments

When you analyze your own Comparative Ct experiment, look for standard deviation in the replicate
groups (Ct SD values). If needed, omit outliers (see “Improve CT precision by omitting wells” on
page 248).
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Assess amplification results using the amplification plot

Amplification plots available for viewing
The Amplification Plot screen displays amplification of all samples in the selected wells. There are
three plots available:

* ARn vs Cycle—ARn is the magnitude of normalized fluorescence signal generated by the reporter
at each cycle during the PCR amplification. This plot displays ARn as a function of cycle number.
Use this plot to identify and examine irregular amplification and to view threshold and baseline
values for the run.

* Rn vs Cycle—Rn is the fluorescence signal from the reporter dye normalized to the fluorescence
signal from the passive reference. This plot displays Rn as a function of cycle number. Use this plot
to identify and examine irregular amplification.

® Cyvs Well-C+ is the PCR cycle number at which the fluorescence meets the threshold in the
amplification plot. This plot displays Ct as a function of well position. Use this plot to locate
outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

Purpose

The purpose of viewing the amplification plot for the example experiment is to identify:
* Correct baseline and threshold values
® Quitliers

View the amplification plot

1. In the Experiment Menu pane, click Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Display the LP1N1 wells in the Amplification Plot screen.
a. Click the Plate Layout tab.
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b. In the Select Wells dropdown list, select Target » LP1N1.

Figure 66 Plate Layout screen

3. In the Amplification Plot screen, select the following.

Item Select
Plot Type dropdown list ARn vs Cycle
Plot Color dropdown list Well (default)
Check (default)
(This is a toggle button. When the legend is displayed, the button changes to Hide the
plot legend).

4. View the baseline values.
a. From the Graph Type dropdown list, select Linear.

b. Select the Baseline checkbox to show the start cycle and end cycle.
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c. Confirm that the baseline is set correctly. The end cycle should be set a few cycles before the
cycle number where significant fluorescent signal is detected. In the example experiment, the
baseline is set correctly.

5. View the threshold values.

Item Select
Graph Type dropdown list Log
Target dropdown list LP1N1

a. Select the Threshold check box to show the threshold.
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b. Confirm that the threshold is set correctly. In the example experiment, the threshold is in the
exponential phase.

6. Locate outliers.
a. In the Plot Type dropdown list, select Ct vs. Well.
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b. Look for outliers from the amplification plot. In the example experiment, there are no outliers
for LP1N1.

7. Repeat step 2 to step 6 for the GH1, TGFB1, LIPC, ACTB, and CCKAR wells.

In the example experiment, there is seven outliers for CCKAR and three outliers for GH1. These
wells are omitted in the troubleshooting section (“Improve CT precision by omitting wells” on
page 248).

Tips for analyzing your own experiments
When you analyze your own Comparative Ct experiment, look for the following items:

* Outliers

* A typical amplification plot—The QuantStudio™ 12K Flex Software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a typical amplification
plot. A typical amplification plot has four distinct sections:

— Plateau phase

— Linear phase

— Exponential (geometric phase)
— Baseline
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Figure 67 Typical amplification plot

IMPORTANT! Experimental error (such as contamination or pipetting errors) can produce atypical
amplification curves that can result in incorrect baseline and threshold value calculations by the
QuantStudio™ 12K Flex Software. We recommend that you examine the Amplification Plot screen
and review the assigned baseline and threshold values for each well after analysis completes.

Note: If you use the Relative Threshold algorithm to analyze an experiment that includes
amplification, select to view the analysis results using the ARn vs Cycle, Rn vs Cycle, or Crr

vs Well plot type and Linear or Log graph type. Also select the Show Crt check box to view the
derived fractional cycle on the amplification plot.
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® Correct threshold values

Condition Example

Threshold Set Correctly

The threshold is set in the exponential phase of the
amplification curve.

Threshold settings above or below the optimum increase
the standard deviation of the replicate groups.

Threshold Set Too Low

The threshold is set below the exponential phase

of the amplification curve. The standard deviation is
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar up into
the exponential phase of the curve.

Threshold Set Too High

The threshold is set above the exponential phase

of the amplification curve. The standard deviation is
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar down
into the exponential phase of the curve.
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Condition

Example

Baseline Set Correctly

The amplification curve begins after the maximum
baseline.

Baseline Set Too Low

The amplification curve begins too far to the right of the
maximum baseline. Increase the End Cycle value.

Baseline Set Too High

The amplification curve begins before the maximum
baseline. Decrease the End Cycle value.
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* View the analyzed data using the relative threshold settings

The QuantStudio™ 12K Flex Software provides the Relative Threshold method to view the analyzed
data. The relative threshold algorithm lets you compare the data per well and per target. These
options allow analysis of a single gene across samples or, alternatively, a single sample across
genes with no dependency on targets, thereby reducing variability.

To view the analyzed data using the relative threshold settings, see “Adjust analysis settings” on
page 244.
If your experiment does not meet the guidelines above, troubleshoot as follows:

* Omit wells (see “Improve CT precision by omitting wells” on page 248).
Or

* Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on page 244).

Confirm accurate dye signal using the multicomponent plot

236

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected
well over the duration of the PCR run.

Purpose

In the Comparative Ct example experiment, you review the Multicomponent Plot screen for the
following items:

* ROX™ dye (passive reference)

* FAM™ dye (reporter)

* Spikes, dips, and/or sudden changes

* Amplification in the negative control wells

View the multicomponent plot

1. In the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

2. Display the unknown and standard wells one at a time in the Multicomponent Plot screen.
a. Click the Plate Layout tab.

b. Select one well in the plate layout. The well is shown in the Multicomponent Plot.

Note: If you select multiple wells, the Multicomponent Plot displays the data for all selected
wells simultaneously.

3. In the Plot Color dropdown list, select Dye.

4. Click [] Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.
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5. Check the FAM™ dye signals.

In the example experiment, the FAM™ dye signal increases throughout the PCR process, indicating
normal amplification.

6. Select the negative control wells one at time and check for amplification.
In the example experiment, there is no amplification in the negative control wells.

QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide 237



PPN Chapter 19

11O -
Review results

Tips for confirming dye accuracy in your own experiment

When you analyze your own Comparative Cy experiment, look for the following items:

* Passive reference—The passive reference dye fluorescence level should remain relatively constant
throughout the PCR process.

* Reporter dye—The reporter dye fluorescence level should display a flat region corresponding to
the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.

* Irregularities in the signal—There should not be any spikes, dips, and/or sudden changes in the
fluorescent signal.

* Negative Control wells—There should not be any amplification in the negative control wells.

Determine signal accuracy using the raw data plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter
for the selected wells during each cycle of the real-time PCR.

About the example experiment

In the Comparative Ct example experiment, you review the Raw Data Plot screen for a stable increase
in signal (no abrupt changes or dips) from the appropriate filter.
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View the raw data plot

1. In the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

2. Display all 48 wells in the Raw Data Plot screen by clicking the upper left corner of the plate
layout in the Plate Layout tab.

3. Click [7] Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.

Note: The legend displays the color code for each row of the reaction plate (see the legend in the
Raw Data Plot shown below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example experiment, there
is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.
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Figure 68 Filters used for the example experiment

Tips for determining signal accuracy in your own experiment

When you analyze your own Comparative Ct experiment, look for the following in each filter:
¢ Characteristic signal growth
* No abrupt changes or dips

View the endogenous control profile using the QC plot

240

In the Comparative Ct experiment, the QC Plot screen displays the Endogenous Control Profile plot for
all the targets in the experiment. The QC Plot serves as a tool to help you choose the best endogenous
control for that experiment. The endogenous control profile plot is a visual display of the C+ level of the
endogenous control across the sample. You can view up to four endogenous controls at a time. The
sample is plotted on the X-axis, and Cr is plotted on the Y-axis. The expression is viewed as a color and
shape combination in the plot. Endogenous controls are also known as reference genes.

Example experiment settings

In the example experiment, you can view the endogenous control profile of GH1, LP1N1, TGFB1, L1PC,
ACTB, and CCKAR in the QC Plot screen.

View the QC plot

1. In the Experiment Menu pane, select Analysis » QC Plot.

Note: If no data are displayed, click Analyze.
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2. In the QC Plot screen, click Target Table to select a target to profile.

a. In the Candidate Control column, select the check box of the target of the endogenous
control profile to plot.

In the example experiment, the endogenous controls selected are GH1, LP1N1, TGFB1, and
L1PC.

b. Select a color from the Color dropdown list.
c. Select a shape from the Shape dropdown list.
3. Click the View Replicate Results Table tab.

4. Select the check box of the samples to plot.
In the example experiment, all the four samples, Brain, Heart, Liver, and Lung are selected.

5. Click [] Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.

Figure 69 QC Plot in the Comparative Ct example experiment
This example experiment does not define Biological Groups.
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Review the flags in the QC summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the flag
frequency and location for the open experiment.

Review the QC Summary screen in the Comparative Ct example experiment for any flags triggered by
the experiment data. Wells A11, B11, C11, E1, F1, and G1 have data that triggered the HIGHSD flag.
Wells E11, E12, F11, and F12 have data that triggered the NOAMP flag. Wells E11, E12, F12, and G12
have data that triggered the EXPFAIL flag.

View the QC summary

1. In the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the
experiment. If the frequency is greater than 0, the flag appears somewhere in the experiment. The
well position is listed in the Wells column.

In the example experiment, there are ten flagged wells.

3. In the Flag Details table, click each flag with a frequency greater than 0 to display detailed
information about the flag.

In the example experiment. The HIGHSD flag appears six times, in the wells A11, B11, C11, E1,
F1, and G1, indicating high standard deviation in the replicate group. The NOAMP flag appears
four times, in the wells E11, E12, F11, and F12, indicating no amplification in the replicate group.
The EXPFAIL flag appears in the wells E11, E12, F12, and G12, indicating that the exponential
algorithm failed.

Note: The HIGHSD flag appears because the Ct values exceed the expected range due to low
expression of the CCKAR gene in the Heart sample and the GH1 gene in the Lung sample.
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4. (Optional) For those flags with frequency greater than 0, click the troubleshooting link to view

information on correcting the flag.

Figure 70 QC Summary screen for the example experiment

Possible flags

The flags listed below may be triggered by the experiment data.

Chapter 19
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Flag

Description

Pre-processing flag

OFFSCALE

Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification

NOISE Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
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(continued)
Flag Description
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL Cr algorithm failed

AMPSCORE | Ampilification in the linear region is below a certain threshold, corresponding to the score set
in the analysis settings

Secondary analysis flags

OUTLIERRG Outlier in replicate group
AMPNC Amplification in the negative control
HIGHSD High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL
flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed
in the Frequency column for each flag).

For more information

Information Reference

Publishing data Chapter 1, “General information and instructions”

Adjust parameters for re-analysis of your own experiments

Adjust analysis settings
The Analysis Settings dialog box displays the analysis settings for the threshold cycle (Cy), flags, and
advanced options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your
experiment.
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View the analysis settings

1. In the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
® (Ct Settings
* Flag Settings
* Relative Quantification Settings
¢ Advanced Settings

Figure 71 Analysis Settings dialog box for a Comparative Ct experiment

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” on page 246).

Note: You can save the changes to the analysis settings to the Analysis Settings Library for later
use. For more information, see “About the analysis settings library” on page 62.
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4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to Default Analysis
Settings.

Adjust analysis settings
Ct settings

e Data Step Selection
Use this feature to select one stage/step combination for Ct analysis when there is more than one
data collection point in the run method.

* Algorithm Settings
You can select the algorithm that determines the C+ values. There are two algorithms: Baseline
Threshold (the default) and Relative Threshold.
The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline
component and sets a fluorescent threshold in the exponential region for quantification.

The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency
and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no
dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a
threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold
will not affect the analysis.

* Default Ct Settings
Use the default Cy settings feature to calculate Cy for the targets that do not have custom settings.
To edit the default settings, click Edit Default Settings.

® Cr Settings for Target
When you manually set the threshold and baseline, we recommend the following settings:

Setting Recommendation

Threshold | Enter a value for the threshold so that the threshold is:
— Above the background.
— Below the plateau and linear regions of the amplification curve.

— Within the exponential phase of the amplification curve.

Baseline | Select the Start Cycle and End Cycle values so that the baseline ends before significant
fluorescent signal is detected.

Note: Selecting Automatic Threshold implies selection of automatic setting of the baseline.
However, if Automatic Threshold is deselected, then you can choose between setting the baseline
either automatically or manually.

Flag settings
Use the Flag Settings tab to perform the following tasks:

* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the QuantStudio™ 12K Flex Software.
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1. Inthe Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying
the flag.

Note: If you choose to adjust the setting for applying a flag, make minor adjustments as you
evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the
flag.

Note: After you have rejected the flagged wells, analysis results depend on factors such as the
experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments
using the Standard Deviation calculations may change the result of C; SD. For some flags, analysis
results calculated before the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box.
If the run status is complete, the data are reanalyzed.

Figure 72 Flag Settings tab
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Relative quantification settings

Use the Relative Quantification Settings tab to:
* Change the type of analysis, singleplex or multiplex.
* (Change the reference sample and/or endogenous control.
* Reject Outliers with ACt values less than or equal to the entered value.

Note: The Outlier Rejection settings apply only to multiplex reactions.

¢ Select the algorithm to use to determine the relative quantification minimum and maximum values
(error bars):
— Confidence Level—Select to calculate the RQ minimum and maximum values based on the
selected confidence level. Select the confidence level to use.

— Standard Deviations —Select to calculate the RQ minimum and maximum values based on
the selected number of standard deviations. Select the number of standard deviations to use.

Advanced settings

Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative Threshold setting.

The following steps describe the use of custom baseline settings for a well-target combination.

1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target checkbox.

3. Define the custom baseline settings:
* For automatic baseline calculations, select the Automatic Baseline checkbox.

* To define the baseline, deselect the Automatic Baseline checkbox, then enter the baseline
start cycle and baseline end cycle.

Improve Ct precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all. These wells typically
produce Ct values that differ significantly from the average for the associated replicate wells. If included
in the calculations, these outliers can result in erroneous measurements. To support Ct precision, omit
the outliers from the analysis.

In the Comparative Ct example experiment, there are seven outliers.

1. In the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select Ct vs Well from the Plot Type dropdown lit.

3. Select the Well Table tab.
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4. In the Well Table, identify outliers.
a. From the Group By dropdown list, select Replicate.

b. Look for outliers in the replicate group (make sure they are flagged). In the example
experiment, wells A11, B11, C11, E1, F1, E11, E12, F11, F12, and G12 have outliers.
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c. Select the Omit checkbox next to outlying well or outlying wells.

5. Click Analyze to reanalyze the experiment data with the outlying well or outlying wells removed
from the analysis.

Note: You can also omit undesirable wells in an experiment from the Plate Layout screen. To omit
a well from the Plate Layout screen, right-click the well, then click Omit.
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Export analysis results

. Open the Comparative Ct example experiment file that has been analyzed.

For information about analysis, see Chapter 19, “Review results and adjust experiment
parameters”.

- In the Experiment Menu pane, click Export.

Note: To export data automatically after analysis, select the Auto Export checkbox during
experiment setup or before running the experiment. The Auto Export checkbox is unchecked
for the example experiment.

- In the Format dropdown list, select QuantStudio 12K Flex format.

Note: In the Format dropdown list, select 7900 if you want to export the Clipped Data.

. Complete the Export dialog box as shown below.

Field or Selection Entry
Select Data to export/Select Content | Results
Export Data To options One File radio button
Export File Name field 96-Well Fast Comparative CT Example_QuantStudio_export
File Type dropdown list "ixt
Export File Location field Use the default file location or click Browse to select a different
location
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Figure 73 Export screen
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Figure 74 Exported file
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Overview of genotyping experiments

IMPORTANT! First-time users of the QuantStudio™ 12K Flex Real-Time PCR System, see the part
“Getting started” on page 17 and Appendix A, “Documentation and support”. The sections provide
information and general instructions that are applicable to all the experiments described in this
document.

Note: For more information about any of the topics discussed in this guide, access the Help from
within the QuantStudio™ 12K Flex Software by pressing F1, clicking  in the toolbar, or selecting
Help » QuantStudio 12K Flex Software Help.

Overview of data collection

Genotyping experiments are performed to detect single nucleotide polymorphism (SNP) variants of a
target nucleic acid sequence in samples. The PCR reactions contain primers designed to amplify the
sequence containing the SNP and reagents to detect two different alleles.

You can collect the results of a genotyping experiment in two different ways: At the end of the
experiment, or continuously during the experiment. Data collection at the end of the experiment is
called end-point data collection. Data collection during the experiment run is considered real-time PCR.
The real-time data helps further data analysis.

In end-point data collection, the normalized intensity of the reporter dye, or Rn, is the data collected.
Some end-point experiments also include pre-PCR (data collected before the amplification process)
data collection. The system calculates the delta Rn (ARn) value per the following formula:

ARN = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized readings.

Overview of the TagMan™ SNP Genotyping Assay

A genotyping assay detects variants of a single nucleic acid sequence, without quantifying the target.
The presence of two probes in each reaction allows genotyping of the two possible variants at the
single nucleotide polymorphism (SNP) site in a target sequence.

Each TagMan™ SNP Genotyping Assay consists of a single, ready-to-use tube containing the following
items:

* Two sequence-specific primers for amplifying the polymorphism of interest

* Two allele-specific TagMan™ MGB probes for detecting the alleles for the specific polymorphism of
interest
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Overview of TagMan™ MGB probes

Each allele-specific TagMan™ MGB probe has:
* Avreporter dye at its 5' end:
— VIC™ dye is linked to the 5' end of the Allele 1 probe.
— FAM™ dye is linked to the 5' end of the Allele 2 probe.
The Allele 1 VIC™ dye-labeled probe corresponds to the first nucleotide inside the square brackets of
the context sequence in the assay information file (AlIF) shipped with each order. The Allele 2 FAM™
dye-labeled probe corresponds to the second nucleotide inside the square brackets of the context

sequence in the AIF. For the context sequence ATCGATT[G/T]ATCC, the VIC™ dye-labeled probe binds
to the G allele, and the FAM™ dye-labeled probe to the T allele.

* A minor groove binder (MGB), which increases the melting temperature (T,,,) for a given probe
length and allows the design of shorter probes. The use of shorter probes results in greater
differences in T,,, values between matched and mismatched probes, and more robust genotyping.

* A non-fluorescent quencher (NFQ) at its 3' end, which allows for detection of the reporter dye
fluorescence with greater sensitivity than with a fluorescent quencher.

Overview of the 5' nuclease assay

The figure below is a schematic depiction of the 5' nuclease assay. During PCR:

* Each TagMan™ MGB probe anneals specifically to its complementary sequence between the
forward and reverse primer sites.

* When the oligonucleotide probe is intact, the proximity of the quencher dye to the reporter dye
quenches the reporter signal.

* AmpliTag Gold™ DNA polymerase extends the primers bound to the genomic DNA template.

* AmpliTag Gold™ DNA polymerase (with its 5' nuclease activity) cleaves probes that are hybridized
to the target sequence.

* (Cleavage of the probes hybridized to the target sequence separates the quencher dye from the
reporter dye, resulting in increased fluorescence by the reporter. The fluorescence signal generated
by PCR ampilification indicates which alleles are present in the sample.
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Minimizing non-specific fluorescence

In TagMan™ assays, fluorescence from nonspecifically bound probes is reduced, because nucleotide
mismatches between a probe and a sequence reduce the chances that the probe will be cleaved. The
short length of the probe means that a one-base-pair mismatch will a have a larger negative effect

on the binding. The mismatched probe will not bind tightly to the allele. The AmpliTagq Gold™ DNA
polymerase will likely displace the probe without cleaving the dye.

Reading and analyzing the plates

The QuantStudio™ 12K Flex Software genotypes the DNA samples from the reaction plate
simultaneously. First, the software normalizes the fluorescence of the reporter dyes to the fluorescence
of the passive reference dye in each well. Next, the software plots the normalized intensities (Rn) of

the reporter dyes in each sample well on an Allelic Discrimination Plot, which contrasts the reporter
dye intensities of the allele-specific probes. Finally, the QuantStudio™ 12K Flex Software algorithmically
clusters the sample data, and assigns a genotype call to the samples of each cluster according to its
position on the plot.

Note: The QuantStudio™ 12K Flex Software clustering algorithm does not call genotypes when only
one genotype is present in an experiment.
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The clustering of datapoints can vary along the horizontal axis (Allele 1), vertical axis (Allele 2),
or diagonal (Allele 1/Allele 2). This variation results from differences in the extent of reporter

dye fluorescent intensity after PCR amplification. The table below shows the correlation between
fluorescence signals and sequences in a sample.
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Observation Indication
VIC™ dye-labeled probe fluorescence only Homozygosity for Allele 1
FAM™ dye-labeled probe fluorescence only Homozygosity for Allele 2
Both VIC™ and FAM™ dye-labeled probes fluorescence Allele 1-Allele 2 heterozygosity

About the example experiment

To illustrate how to perform genotyping experiments, this guide leads you through the process of
designing and performing an example experiment. The example experiment represents a typical setup
that you can use to quickly familiarize yourself with a QuantStudio™ 12K Flex Real-Time PCR System.

The objective of the example genotyping experiment is to investigate SNP rs8039, where possible
genotypes are AA, AC, and CC. In the example, 19 unknown genomic DNA (gDNA) samples

were genotyped using TagMan™ Drug Metabolism Genotyping Assay ID C___1240647_1_and
C___1213693_10. The reactions were set up so that the PCR primers and probes that target both
alleles of SNP rs8039 were present in the same well. The PCR was performed using the TagMan™
Genotyping Master Mix.
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Design the experiment

This chapter explains how to design the example experiment from the Setup menu in the Experiment

Menu pane.

Note: To automatically export the analyzed data to a specified location, select the Auto Export
checkbox in the Export screen, before running the experiment. For more information on Auto Export,
see the part “Getting started” on page 17.

Define the experiment properties

In the Experiment Menu pane, click Setup » Experiment Properties.

Enter or select the following information.

Field or selection

Entry

Experiment Name field

Enter 96-Well Genotyping Example.

Barcode field

Leave the Barcode field empty.

User Name field

Enter Example User or enter a user name.

Comments field

Enter Genotyping example.

Block Select 96-Well (0.2 mL).
Experiment Type Select Genotyping.
Reagents Select TagMan Reagents.
Ramp speed Select Standard.

Select all three data collection check boxes.

* Pre-PCR Read checkbox
¢ Amplification checkbox
¢ Post-PCR Read checkbox

Save the experiment.
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Figure 75 Experiment Properties screen
Define SNPs and samples
1. Click Define to access the Define screen.
2. Enter the following SNP assay information.
SNP
assay NOIEERIR) aeng ) A1GE Reporter | Quencher | Allele 2 | Reporter | Quencher | Color
reference | sequence 1
name
SNP 1] 1] Allele VIC NFQ-MGB | Allele2| FAM |NFQ-MGB
Assay 1 .
1
SNP - -] Allele VIC NFQ-MGB | Allele2| FAM |NFQ-MGB -
Assay 1
2

' The NCBI SNP reference and Context sequence fields are optional fields and are used for reference. They are not required to
run an experiment.

3. Enter the following sample information.

Sample name

Color

Sample name Color
Sample 1 . Sample 11
Sample 2 Sample 12
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(continued)
Sample name Color Sample name Color
Sample 3 . Sample 13 .
Sample 4 Sample 14 .
Sample 5 Sample 15 .
Sample 6 . Sample 16 .
Sample 7 . Sample 17 .
Sample 8 . Sample 18 .
Sample 9 . Sample 19 .
Sample 10 — —

4. In the Passive Reference dropdown list, select ROX .
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Figure 76 Define screen
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Note: This example experiment does not define biological replicate groups. Leave the Biological
Replicate Groups pane blank.

Assign markers and samples

Click Assign to access the Assign screen.

Enter the following SNPs and samples.

Table 3 SNP Assay 1

Target name Well number Task Sample

SNP Assay 1 A1, E1 Unknown Sample 1
A2, E2 Sample 2

A3, E3 Sample 3

A4, E4 Sample 4

A5, E5 Sample 5
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Table 3 SNP Assay 1 (continued)

Target name Well number Task Sample

SNP Assay 1 A6, E6 Unknown Sample 6
B1, F1 Sample 7
B2, F2 Sample 8
B3, F3 Sample 9
B4, F4 Sample 10
B5, F5 Sample 11
B6, F6 Sample 12
C1, G1 Sample 13
C2, G2 Sample 14
C3, G3 Sample 15
C4, G4 Sample 16
C5, G5 Sample 17
Ce6, G6 Sample 18
D1, H1 Sample 19

SNP Assay 1 D2 - D6 No Template Control -
H2 - H6

Table 4 SNP Assay 2

Target name Well number Task Sample
SNP Assay 2 A7, E7 Unknown Sample 1
A8, E8 Sample 2

A9, E9 Sample 3

A10, E10 Sample 4

A11, E11 Sample 5

A12, E12 Sample 6

B7, F7 Sample 7

B8, F8 Sample 8

B9, F9 Sample 9

B10, F10 Sample 10
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Target name Well number Task Sample
SNP Assay 2 B11, F11 Unknown Sample 11
B12, F12 Sample 12
Cc7,G7 Sample 13
C8, G8 Sample 14
C9, G9 Sample 15
C10,G10 Sample 16
C11, G11 Sample 17
C12, H12 Sample 18
D7, H7 Sample 19
SNP Assay 2 D8 - D12 No Template Control —
H8 - H12

Figure 77 Assign screen
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Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View
tab. Enter the following information:

¢ Reaction Volume Per Well: 50 uL
® Thermal profile

Stage Step | Ramp rate | Temperature Time
Pre-Read Stage Step1| 1.6°C/s 60°C 30 seconds
Hold Stage Step1| 1.6°C/s 95°C 10 minutes
PCR Stage Step1| 1.6°C/s 95°C 15 seconds

* Number of Cycles: 40 (default)
¢ Enable AutoDelta: Unchecked (default)

¢ Starting Cycle: Disabled when Enable AutoDelta is Step2| 1.6°C/s 60°C 1 minute
unchecked
Post-Read Stage Step1| 1.6°C/s 60°C 30 seconds

Figure 78 Run Method screen

266 QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide



Chapter 22 =9

) - 1))
For more information

For more information

Information Reference
Consumables Chapter 1, “General information and instructions”
Using alternative setup Chapter 2, “Experiment shortcuts”
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Prepare the reactions

This chapter explains how to prepare the PCR reactions for the Genotyping example experiment.

Assemble required materials

* [tems listed in the part “Getting started” on page 17
* Samples—Sample 1 to Sample 19

* Example experiment reaction mix components:
- TagMan™ Genotyping Master Mix (2X)

— SNP 1 Assay Mix (20X)
— SNP 2 Assay Mix (20X)

Prepare the sample dilutions

For the example experiment, two targets are assigned to 38 wells each. Each well contains 20 ng of
Coriell DNA. The stock concentration is 10 ng/pL.

1. Label a separate microcentrifuge tube for each sample to be diluted.

Note: You can also use a MicroAmp™ Optical 96-Well Reaction Plate to prepare the sample
dilutions.

2. Add 2 pL of sample stock to each empty tube.

3. Add 48 pL of sterile water (diluent) to each tube, such that each working stock tube has a final
concentration of 10 ng/puL

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the reaction mix

1. Label an appropriately sized tube for each reaction mix.
* SNP 1 Reaction Mix
* SNP 2 Reaction Mix
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Prepare the reaction plate

2. For SNP Assay 1, prepare a reaction mix by adding the required volumes of each component to

the SNP 1 reaction tube.

Reaction volume
Per well 38 Reactions + 10% overage
Reaction component
Dry Wet Dry Wet

TagMan™ Genotyping Master Mix (2 X) 10.0 L 10.0 L 420.0 pL 420.0 pL
SNP Assay Mix (20 X) 1.0 uL 1.0 uL 42.0 uL 42.0 uL
Water, DNase-free 39.0 uL 37.0 yL 1,638.0 pL 1,5654.0 yL
Total reaction mix volume 50.00 pL | 48.00 pL 2,100.0 yL 2,016.0 pL

3. Gently pipette the reaction mix up and down, then cap the tube.

4. Centrifuge the tube briefly.

5. Place the reaction mixes on ice until you prepare the reaction plate.

6. Repeat step 2 to step 5 for the SNP 2 assay.

Note: Do not add the sample at this time.

Prepare the reaction plate

Example experiment reaction plate components

The reaction plate for the Genotyping example experiment contains:

* A MicroAmp™ Optical 96-Well Reaction Plate

* Reaction volume: 50 pL/well
® 76 Unknown wells
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Prepare the reaction plate

Figure 79 Plate layout for example experiment

To prepare the reaction plate: dried gDNA

270

1.

Pipette 2.0 pL of the appropriate sample (20 ng of purified genomic DNA) into each well of the
reaction plate.

All wells belonging to the same Genotyping assay must contain approximately the same quantity of
sample or control.

Note: While preparing the reaction plate for your own Genotyping experiment, add between 1 ng
and 20 ng of purified DNA per reaction.

Dry down the samples by evaporation at room temperature in a dark, amplicon-free location.
Cover the reaction plate with a lint-free tissue while drying.

Transfer 48 pL of reaction mix to each well.

IMPORTANT! Ensure sure that no cross-contamination occurs from well to well.

Seal the reaction plate with adhesive film.

Vortex the reaction plate for 3-5 seconds.
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6. Briefly centrifuge the reaction plate.

7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the plate
again at a higher speed and for a longer period of time.

To prepare the reaction plate: wet gDNA
1. Add 2 pL of DNA to the appropriate wells.
2. Add 2 pL of water to wells containing the NTCs.
3. Transfer 48 L of reaction mix to the appropriate wells.
4. Seal the reaction plate with optical adhesive film.
5. Vortex the reaction plate for 3-5 seconds, then briefly centrifuge it.
6. Centrifuge the reaction plate briefly.

7. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

Tips for preparing reactions for your own experiments

Tips for preparing samples

When you prepare the samples for your own experiment, we recommend the following items:
* Use DNase-free water to dilute the samples.

* Use the same quantity of DNA per well for each experiment.

Tips for preparing the reaction mix

When you prepare the reaction mix for your own experiment, prepare the reactions for each SNP
separately.

* Mix the master mix thoroughly by swirling the bottle.
* Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

* Thaw frozen samples by placing them on ice. When thawed, resuspend the samples by vortexing,
then centrifuge the tubes briefly.

Tips for preparing the reaction plate

* Ensure sure the reaction locations match the plate layout in the QuantStudio™ 12K Flex Software.
* Load 1-20 ng of purified genomic DNA per reaction

* All wells belonging to the same Genotyping assay must contain approximately the same quantity of
sample or control.

¢ Multiple assays may be run on one reaction plate, but must be analyzed separately.
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For more information

Information Reference
Assigning the reaction plate components Chapter 1, “General information and instructions”
Sealing the reaction plate Chapter 1, “General information and instructions”
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Run the experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K Flex Real-Time
PCR Instrument.

IMPORTANT! Run the experiment at the same ambient temperature at which you calibrated the
instrument. Extreme variations in ambient temperature can affect the heating and cooling of the
instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the
instrument is in operation.

Start the run

. Open the Genotyping example file that you created.

See Chapter 22, “Design the experiment”.
Load the reaction plate into the instrument.

Start the run.

Note: To collect real-time data during a run, click  on the Run Method screen in the Setup
menu.

Monitor the run

You can monitor an experiment run in three ways:

From the Run screen of the QuantStudio™ 12K Flex Software, while the experiment is in progress

From the Instrument Console screen of the QuantStudio™ 12K Flex Software, to monitor an
experiment started from another computer or from the instrument touchscreen (see “Monitor a run
from the software Instrument Console screen” on page 274)

From the instrument touchscreen (see “Monitor a run from the instrument touchscreen” on
page 277)
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Monitor a run from the software Instrument Console screen

1. In the Instrument Console screen, select the icon of the instrument that you are using to run the
experiment.

2. Click Manage Instrument or double-click on the instrument icon.

3. In the Instrument Manager screen, click Monitor Running Experiment to access the Run
screen.

View the amplification plot

You can view the progress of the run in real time. During the run, periodically view all the three plots
available from the QuantStudio™ 12K Flex Software for potential problems.

Click Amplification Plot from the Run Experiment menu, select the Plate Layout tab, then select the
wells to view.

Note: The Amplification Plot is not available for experiments that do not include the PCR process.

Figure 80 The Amplification Plot screen as it appears at the end of the example experiment
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View the temperature plot

Click Temperature Plot from the Run Experiment menu.

Figure 81 The Temperature Plot screen as it appears during the example experiment

Note: The sample temperature displayed in the Current Temperatures group is an estimated value.
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View the run method

Click Run Method from the Run Experiment menu.

Figure 82 The Run Method screen as it appears in the example experiment

View run data

Click View Run Data from the Run Experiment menu.

Figure 83 The View Run Data screen as it appears in the example experiment
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Monitor a run from the instrument touchscreen

You can view the progress of the run from the instrument touchscreen.

The following figures are for visual representation only. Actual results vary with the experiment.

Figure 84 Experiment View tab
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Figure 85 Time View tab

Figure 86 Plot View tab

Note: The plot view is available only if your experiment includes the PCR process.
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Review results and adjust
experiment parameters

The following topics are covered in this chapter:

* Review the analyzed data using several of the analysis screens and publish the data (see “Review
results” on page 279)

* Modify experiment parameters to troubleshoot problems with experiment results before rerunning
an experiment (see “Adjust parameters for re-analysis of your own experiments” on page 301)

Note: Additional analysis can be performed with TagMan™ Genotyper Software.

Review results

Analyze the example experiment

1. Open the example experiment file.
See Chapter 24, “Run the experiment”.

2. Click Analyze.

Note: You can also access the experiment to analyze from the Home screen.

The software analyzes the data using the default analysis settings.

View clusters in the allelic discrimination plot
The Allelic Discrimination Plot contrasts the normalized reporter dye fluorescence (Rn) for the allele-
specific probes of the SNP assay.

View the allelic discrimination plot to identify the following items:

¢ Clusters for the three possible genotypes (Allele 1 homozygous, Allele 2 homozygous, and Allele
1/2 heterozygous)

* A cluster for the no template controls
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View and assess the allelic discrimination plot

1. From the Experiment Menu pane, select Analysis » Allelic Discrimination Plot.

2. Click the Plate Layout tab, then click any empty well to select it.

No

te: In the Allelic Discrimination Plot, the software highlights all wells that are selected in the

Plate Layout tab. If the plot displays a single color for all wells, then all wells in the plate layout are
selected.

3. In the allelic discrimination plot, select SNP Assay 1 from the SNP Assay dropdown list.

4. Ensure that the autocaller is enabled.

a

b.

g.

. Click Analysis Settings.
In the Analysis Settings dialog box, select the Call Settings tab.

. In the Default Call Settings section, see the Autocaller Enabled field.
The Autocaller Enabled field should display Yes.

To enable the autocaller if it is not enabled, click Edit Default Settings.
In the Edit Default Call Settings dialog box, select the Autocaller Enabled checkbox.
Click Save Changes.

In the Analysis Settings dialog box, click Apply Analysis Settings.

If the autocaller is not enabled, the Allelic Discrimination Plot displays a crossmark (X —

Un

determined) for each sample.

The Allelic Discrimination Plot displays allele symbols for each sample evaluated for the selected

SNP. The samples are grouped on the plot as follows:
Genotype Symbol Location
Homozygous for Allele 1 of the selected SNP assay | e (red) X-axis of the plot
Homozygous for Allele 2 of the selected SNP assay | @ (blue) Y-axis of the plot
Heterozygous for both alleles of the selected SNP (green)| Midway between the homozygote
assay (Allele 1 and Allele 2) clusters
No Template Control H (black) Bottom-left corner of the plot
Undetermined * (black) Anywhere on plot

5. Review each cluster in the plot.

a

. Click and drag a box around the cluster to select the associated wells in the plate layout and
well table.
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b. Confirm that the expected wells are selected in the well table.

For example, if you select the cluster at the bottom-left corner of the plot, only the no template
controls should be selected. The presence of an unknown among the no template controls
may indicate that the sample failed to amplify.

c. Repeat substep 5a and substep 5b for all other clusters in the plot.
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d. The table below describes the elements of the Allelic Discrimination Plot.

Element Description
SNP Assay Determines the SNP assay data that the QuantStudio™ 12K Flex Software
dropdown list displays in the plot.
Plot Type Determines the type of plot (Cartesian or Polar) that the QuantStudio™ 12K
dropdown list Flex Software uses to display the data.
Apply Call When a datapoint is selected, this menu allows you to assign an allele call
dropdown list to the datapoint within the scatterplot.
Toolbar Contains tools for viewing the scatterplot:

e [l —Selection tool
® [~ —Selection tool
¢ [ —Repositioning tool

e [& —Zooms in

. —Zooms out
Legend Explains the symbols in the scatterplot.
Options The Reveal Traces option allows you to trace the clusters throughout the

PCR process.
This option is not activated for the example experiment. To activate the
feature, see “Adjust analysis settings” on page 303.
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Figure 87 The Allelic Discrimination plot for the example experiment

Troubleshoot clustering on the allelic discrimination plot

Do all controls have the correct genotype?

In the example experiment and in your own experiments, confirm that data points cluster as expected.
Clustering in positive controls

1. From the well table, select the wells containing a positive control to highlight the corresponding
data points (symbols) in the Allelic Discrimination Plot.

2. Check that the data points for the positive controls cluster along the expected axis of the plot. For
example, if you select the Positive Control Allele 1/Allele 1, then the controls should cluster along
the X-axis.

3. Repeat steps 1 on page 283 and 2 on page 283 for the wells containing the other positive controls.

Failed amplification in the unknown samples

1. Select the data points of the cluster in the lower left corner of the Allelic Discrimination Plot to
select the corresponding wells in the well table.

2. Check that the selected wells in the well table are the no template controls, and not unknown
samples.
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Samples clustered with the no template controls

Samples that clustered with the no template controls may:
¢ Contain no DNA
* Contain PCR inhibitors
* Be homozygous for a sequence deletion

Confirm the results of these samples by retesting them.

Are outliers present?

If the Allelic Discrimination Plot contains clusters other than the three representative genotype clusters
(heterozygous, homozygous allele 1, and homozygous allele 2), then those can be classified as outliers.

Confirm the results of the associated samples by retesting them.

Note: The results displays are synchronized. For example, selecting a well in the plate layout selects
the corresponding data in the well table and Allelic Discrimination Plot.

Confirm setup accuracy using plate layout

Review the experiment results in the Plate Layout tab. The plate layout displays the assay-specific
setup and analysis properties for the experiment in a well format corresponding to the type of reaction
plate used for the run.

Example experiment plate layout values

For the example experiment, confirm that the software made the following calls:
* 24 samples as Allele 1 homozygous ( ®)
¢ 38 samples as Allele 2 homozygous (®)
* 14 samples as heterozygous (®)
* (0 samples as undetermined (X)

Confirm that no wells of the reaction plate triggered QC flags (= ). The example experiment does not
display any flags.
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View the layout

1. Click < beside the Allelic Discrimination Plot to maximize the plate layout.

2. Click  Show in Wells, then select or deselect a parameter that you want the wells to display.
Repeat this step until the plate layout contains all of the desired parameters.

Parameter Description
Sample Name The name of the sample applied to the well.
Task The task assigned to the well:

—Unknown

&1 —No Template Control
— Positive Control - Allele 1
—Positive Control - Allele 2
—Positive Control - Allele 1/2

SNP Assay Name The name of the SNP evaluated by the well.
Assay ID The Assay ID number of the SNP evaluated by the well.
Allele 1/ Allele 2 The name of the associated allele for the SNP evaluated by the well
Allele 1 Dyes / Allele 2 | The name of the reporter and quencher dyes of the associated allele for the
Dyes SNP evaluated by the well
SNP Assay Color The color of the SNP evaluated by the well.
Sample Color / Task | The color of the sample or task applied to the well.
Color
Genotype Call The allele call assigned to the sample:
* ® —Homozygous 1/1
e @ —Homozygous 2/2
. —Heterozygous 1/2
* N —No Template Control
¢ X—Undetermined
Flag The number of QC flags the well triggered as listed in the . symbol.
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Figure 88 Plate layout of the example genotyping experiment

Tips for troubleshooting plate setup in your own experiment

Adjust your view of the plate layout.

Note the location of any samples that trigger QC flags (. ). Understanding the position of errors
can aid in diagnosing any failures that may occur.

You can select the entire reaction plate, areas of the reaction plate, or specific wells:
— Click the upper left corner of the reaction plate to select all 96 wells.

— Left-click the mouse and drag across the area to select it.

— Select Sample, SNP Assay, or Task from the Select Wells dropdown list in the Plate Layout
tab to select wells of a specific type using the well-selection criteria.

Use the (Zoom In) button, the (Zoom Out) button, and the (Fit Plate) button to magnify
or compress the view of the wells shown.

Use the < button to expand the plate layout to cover the entire screen.

QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide



Chapter25 7=
Review results

Assess amplification results using the amplification plot

IMPORTANT! Amplification plots are not used to make SNP calls. Examine the plots to help with
troubleshooting and quality control.

If you collected real-time data for your experiment, review the amplification data to further understand
the flags triggered by the experiment data.

About amplification plots

The Amplification Plot screen displays amplification of all samples in the selected wells. Use the
amplification plots to confirm the results of the experiment:

ARnN vs. Cycle—ARn is the difference in normalized fluorescence signal generated by the reporter
between the pre-PCR read and the post-PCR read. This plot displays ARn as a function of cycle
number. You can use this plot to identify and examine irregular amplification and to view threshold
and baseline values for the run.

Note: Viewing the ARn vs. Cycle plot is discussed in this booklet as an example of how to view the
plot.

Rn vs. Cycle—Rn is the fluorescence signal from the reporter dye normalized to the fluorescence
signal from the passive reference. This plot displays Rn as a function of cycle number. You can use
this plot to identify and examine irregular amplification.

Ct vs. Well -C+ is the PCR cycle number at which the fluorescence meets the threshold in the
amplification plot. This plot displays Ct as a function of well position. You can use this plot to
locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

View the ARn vs. cycle plot

1.

In the Experiment Menu pane, click Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Select the plot type and format.

Item Select
Plot Type dropdown list ARn vs Cycle
Plot Color dropdown list Target
Check (default)
(This is a toggle button. When the legend is displayed, the button changes to Hide the
plot legend).
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3. View the baseline values.
a. From the Graph Type dropdown list, select Linear.
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b. Select the Baseline checkbox to show the start cycle and end cycle.

4. View the threshold values.
a. From the Graph Type dropdown list, select Log.

b. From the Target dropdown list, select SNP Assay 1-Allele 2.
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c. Select the Threshold checkbox to show the threshold.

Note: If you use the Relative Threshold algorithm to analyze an experiment that includes
amplification, select to view the analysis results using the ARn vs Cycle, Rn vs Cycle, or Crt
vs Well plot type and Linear or Log graph type. Also select the Show Crt checkbox to view

the derived fractional cycle on the ampilification plot.
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Identify well problems using the well table

Review the details of the experiment results in the Well Table and identify any flagged wells. The Well
Table displays the assay-specific setup and analysis properties for the experiment in a tabular format.

Example experiment values and flags

For the example experiment, look for wells that triggered QC flags (. ). The example experiment has no
flags.

View the well table
1. Select the Well Table tab.

2. Click the Flag column header to sort the data so that the wells that triggered flags appear at the
top of the table.

3. Confirm the integrity of the controls.

a. In the Group By dropdown list, select Task to organize the table rows by their function on the
reaction plate.

b. Confirm that each of the controls does not display a flag ( ).
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c. Click H to collapse the negative and positive controls.

Figure 89 The well table of the example Genotyping experiment

The following table gives the names and description of the columns in the well table.

Column Description
Well column The position of the well on the reaction plate.
Omit column A check mark indicates that the well has been removed from the analysis.
Flag column A . symbol indicates that the well triggered the number of flags listed

inside the symbol.

Sample Name column The name of the sample.

SNP Assay Name column The name of the SNP assay evaluated by the well.

Assay ID The Assay ID number of the SNP evaluated by the well.

Task column The task assigned to the well (Unknown, No Template Control, or Positive
Control).

Allele 1 column and Allele 2 The name of the associated allele for the SNP evaluated by the well.

column
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Column

Description

Allele 1 Dye column and Allele
2 Dye column

The name of the reporter and quencher dyes of the associated allele for
the SNP evaluated by the well.

Allele 1 R,, column and Allele 2
R, column

Normalized signal (R,,) of the reporter dye of the associated allele for the
SNP evaluated by the well.

Passive Reference column

The signal of the passive reference dye for the well.

Call column

The allele call assigned to the sample, where possible calls are:
* ®Homozygous 1/1 —Homozygous for allele 1
* ® Homozygous 2/2—Homozygous for allele 2
. Heterozygous 1/2—Heterozygous
¢ H Negative Control (NC)
¢ X Undetermined

Quality (%) column

The quality value calculated for the genotype call.

Method column

The method used to assign the call to the sample (Auto if assigned by the
software, or Manual if applied by a user).

Comments column

Comments entered for the associated sample well.

Allele 1 Gt column and Allele 2
Ct column

Threshold cycle (Cy) of the sample for the associated allele for the SNP
evaluated by the well.

Identify quality control (QC) problems

The Well Table displays columns for QC flags that are triggered by the experimental data. If the
experiment data does not trigger a QC flag, then the software does not display a corresponding column

for the flag.
A . symbol in one of the following columns indicates that the associated well triggered the flag.
Flag Description
BADROX The well produced a passive reference signal greater than the limit defined in the analysis
settings.
OFFSCALE | The well produced a level of fluorescence greater than the QuantStudio™ 12K Flex Real-Time
PCR System can measure.
NOSIGNAL | The well did not produce a detectable level of fluorescence.
CLUSTER# | For the SNP evaluated by the well, the number of clusters generated from the experiment
data is greater than the limit defined in the analysis settings.
PCFAIL The positive control did not produce an R,, for the associated allele greater than the limit
defined in the analysis settings indicating that the control may have failed to amplify.
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Flag Description

SMCLUSTER | The number of data points in the associated cluster is less than the limit defined in the
analysis settings.

AMPNC The negative control has produced an R, greater than the limit defined in the analysis
settings indicating possible amplification.

NOAMP The well did not produce an R,, for either allele that is greater than the limit defined in the
analysis settings indicating that the well may have failed to amplify.

NOISE The background fluorescence (noise) produced by the well is greater than the other wells on
the reaction plate by a factor greater than the limit defined in the analysis settings.

SPIKE The amplification plot for the well contains one or more data points inconsistent with the
other points in the plot.

EXPFAIL The software cannot identify the exponential region of the amplification plot for the well.

BLFAIL The software cannot calculate the best fit baseline for the data for the well.

THOLDFAIL | The software cannot calculate a threshold for the associated well.

CTFAIL The software cannot calculate a threshold cycle (Cy) for the associated well.

AMPSCORE | Amplification in the linear region is below a certain threshold, corresponding to the score set
in the analysis settings

Tips for analyzing your own experiments
Confirm the integrity of positive controls

When you analyze the example experiment or your own experiment, if you are using positive controls,
confirm the integrity of the positive controls.

1. In the Group By dropdown list, select Task to organize the table rows by their function on the
reaction plate

2. Confirm that the positive controls do not display flags (- ) and that their normalized reporter dye
fluorescence (R,) is appropriate for the genotype (for example, if evaluating the Positive Control
Allele 1/Allele 1, you would expect to see significant increase in R, for the Allele 1 probe and very
little for the Allele 2 probe).

Adjust the well table
¢ Review the data for the Unknown samples. For each row that displays the . symbol in the Flag
column, note the data and the flag or the flags triggered by the associated well.

* Select areas of the table or wells of a specified type by the following parameters:
- Left-clicking the mouse and dragging across the area you want to select an area of the table.

— Selecting Sample, SNP Assay, or Task from the Select Wells dropdown list in the Well Table
tab to select wells of a specific type using the well-selection tool.
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Group the rows of the plate layout by selecting an option from the Group By dropdown list. You
can then collapse or expand the lists either by clicking the + button or the — next to individual lists,
or by clicking Collapse All or Expand All.

Omit a well from the analysis by selecting the Omit checkbox for that well. To include the well in
the analysis, deselect the Omit checkbox.

Note: You must reanalyze the experiment each time you omit or include a well.

Confirm accurate dye signal using the multicomponent plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected
well over the duration of the PCR run.

Purpose

In the example experiment, you review the Multicomponent Plot screen for:

ROX™ dye (passive reference)

FAM™ dye (reporter)

VIC™ dye (reporter)

Spikes, dips, and/or sudden changes
Amplification in the no template control wells

View the multicomponent plot

1.

In the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

Display the unknown wells in the plate layout to display the corresponding data in the
Multicomponent Plot screen.

a. Click the Plate Layout tab.

b. Select one well in the plate layout. The well is shown in the Multicomponent Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays the data for all
selected wells simultaneously.

In the Plot Color dropdown list, select Dye.

Click [] Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.

Check the ROX™ dye signal.

In the example experiment, the ROX™ dye signal remains constant throughout the PCR process. A
constant ROX™ dye signal indicates typical data.
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6. Check the FAM™ dye signal.

In the example experiment, the FAM™ dye signal increases throughout the PCR process. The
increase in FAM™ dye signal indicates normal amplification.

7. Select the no template control wells one at time and check for ampilification.

Wells with the no template control should not show amplification. In the example experiment the
wells with no template controls do not show any amplification.

Tips for confirming dye accuracy in your own experiment
When you analyze your own Genotyping experiment, look for the following items:
1. Passive Reference—The passive reference dye fluorescence level should remain relatively

constant throughout the PCR process.

2. Reporter Dye—The reporter dye fluorescence level should display a flat region corresponding to
the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.

3. Irregularities in the signal—There should not be any spikes, dips, and/or sudden changes in the
fluorescent signal.

4. No Template Control wells—There should not be any amplification in the no template control
wells.
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Determine signal accuracy using the raw data plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter
for the selected wells during each cycle of the real-time PCR.

Purpose

In the Genotyping example experiment, you review the Raw Data Plot screen for a stable increase in
signal (no abrupt changes or dips) from the appropriate filter.

View the raw data plot

1. In the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

2. Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner of the plate
layout in the Plate Layout tab.
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3. Click [7] Show a legend for the plot (default).
The legend displays the color code for each row of the reaction plate (see Figure 90 on page 298).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 42.

In the example experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Figure 90 Raw data plot
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Figure 91 Filters

Tips for determining signal accuracy in your own experiment

When you analyze your own Genotyping experiment, look for the following in each filter:
* Characteristic signal growth
* No abrupt changes or dips

Review the flags in the QC summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the flag
frequency and location for the open experiment.

For Genotyping experiments, flag appearance is triggered by experiment data or the assay. If a flag has

been triggered by the assay, the Plate Layout does not display the icon. The flag details appear in
the QC Summary.

In the example experiment, there are no flags.

View the QC summary

1. In the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.
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2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the
experiment. If the frequency is greater than 0, the flag appears somewhere in the experiment. The
well position is listed in the Wells column.

3. In the Flag Details table, click each flag with a frequency greater than 0 to display detailed
information about the flag.

4. (Optional) For those flags with frequency greater than 0, click each flag with a frequency greater
than 0 to display detailed information about the flag.

Possible flags

The flags listed below may be triggered by the experiment data or the assay.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal
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(continued)

Flag Description
NOAMP No amplification
NOISE Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL Cr algorithm failed
AMPSCORE Amplification in the linear region is below a certain threshold, corresponding to the score

set in the analysis settings

Secondary analysis flags

AMPNC Amplification in negative control
PCFAIL Positive Control failed
SMCLUSTER# Small number of samples in clusters

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL
flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed
in the Frequency column for each flag).

For more information

Information Reference

Publishing data

Chapter 1, “General information and instructions”

Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold cycle (Cq), flags,
and advanced options.

You can change the settings in the Analysis Settings dialog box, then reanalyze your experiment.
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View the analysis settings

1. In the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
* (Call Settings
¢ (g Settings
* Flag Settings
* Advanced Settings

Figure 92 Analysis Settings dialog box for a Genotyping experiment

3. View and, if necessary, change the analysis (see “Adjust analysis settings” on page 303).

Note: You can save the changes to the analysis settings to the Analysis Settings Library for later
use. For more information, see “About the analysis settings library” on page 62.
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4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to Default Analysis
Settings.

Adjust analysis settings

Call settings

* Change the default data analysis settings. You can select from the following items:

Analyze Data from Post-PCR Read Only radio button—Select if you do not want to use data
from the pre-PCR read to determine genotype calls.

Analyze Data from Pre-PCR Read and Post-PCR Read radio button—If you included the
pre-PCR read in the run, select if you want to use data from the pre-PCR read to determine
genotype calls.

Analyze Real-Time Rn Data radio button—If you included amplification in the run, select
if you want to use the normalized reporter (Rn) data from the cycling stage to determine
genotype calls.

Analyze Real-Time Rn - Median (Rna to Rnb) radio button—If you included amplification in
the run, select if you want to use the subtracted median of the normalized reporter (Rn) data
from the cycling stage to determine genotype calls, where Rna to Rnb refers to all the cycles
from the Start Cycle Number to the End Cycle Number. The average subtraction provides
improved data accuracy.

Note: To activate the Reveal Traces feature on the Allelic Discrimination Plot screen, select
the Analyze Real-Time Rn Data radio button or the Analyze Real-Time Rn - Median (Rna to
Rnb) radio button.

* Edit the default call settings. Click Edit Default Settings, then specify the default settings in the
Edit Default Call Settings dialog box.

Autocaller Enabled checkbox—Select for the software to make genotype calls using the
autocaller algorithm.

Keep Manual Calls from Previous Analysis checkbox—If the autocaller is enabled, select to
maintain manual calls after reanalysis

Quality Value field —Enter a value to use to make genotype calls. If the confidence value is
less than the call setting, the call is undetermined.

Call Cycle field—The cycle number at which genotyping calls are evaluated.

¢ Use custom call settings for a SNP assay.

Select one or more SNP assays in the table, then deselect the Default Settings checkbox.
The checkboxes and fields in the right pane are editable when the Default Settings checkbox
is deselected.

In the right pane, specify the settings for each SNP assay. The settings are the same settings
that are available in the Edit Default Call Settings dialog box.
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Cr settings

¢ Data Step Selection
Use this feature to select one stage/step combination for Ct analysis when there is more than one
data collection point in the run method.

* Algorithm Settings
You can select the algorithm that determines the C+ values. There are two algorithms: Baseline
Threshold (the default) and Relative Threshold.

The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline
component and sets a fluorescent threshold in the exponential region for quantification.

The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency
and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no
dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a
threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold
will not affect the analysis.

* Default Ct Settings
Use the default Cy settings feature to calculate Cy for the alleles that do not have custom settings.
To edit the default settings, click Edit Default Settings.

® Cr Settings for Target
When you manually set the threshold and baseline, we recommend the following settings:

Setting Recommendation

Threshold | Enter a value for the threshold so that the threshold is:
— Above the background.
— Below the plateau and linear regions of the amplification curve.

— Within the exponential phase of the amplification curve.

Baseline | Select the Start Cycle and End Cycle values so that the baseline ends before significant
fluorescent signal is detected.

Note: Selecting Automatic Threshold implies selection of automatic setting of the baseline.
However, if Automatic Threshold is deselected, then you can choose between setting the baseline
either automatically or manually.

Flag settings
Use the Flag Settings tab to perform the following tasks:

* Adjust the sensitivity so that more wells or fewer wells are flagged.
¢ Change the flags that are applied by the QuantStudio™ 12K Flex Software.
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1. Inthe Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying
the flag.

Note: If you choose to adjust the setting for applying a flag, make minor adjustments as you
evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject wells with the
flag.

Note: After you have rejected the flagged wells, analysis results depend on factors such as the
experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments
using the Standard Deviation calculations may change the result of C; SD. For some flags, analysis
results calculated before the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box.

Figure 93 Flag Settings tab
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Advanced settings

Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative Threshold setting.

The following steps describe the use of custom baseline settings for a well-target combination.
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target checkbox.

3. Define the custom baseline settings

* For automatic baseline calculations, select the Automatic Baseline checkbox.

* To define the baseline, deselect the Automatic Baseline checkbox, then enter the baseline
start cycle and baseline end cycle.
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Export analysis results

1. Open the Genotyping example experiment file has been analyzed.

For information about analysis, see Chapter 25, “Review results and adjust experiment

parameters”.

2. In the Experiment Menu pane, click

Export.

Note: To export data automatically after analysis, select the Auto Export checkbox during
experiment setup or before running the experiment. The Auto Export checkbox is unchecked

for the example experiment.

3. In the Format dropdown list, select QuantStudio 12K Flex format.

4. Complete the Export dialog box as shown below.

Field or Selection

Entry

Select Data to export/Select Content

Results

Export Data To options

One File radio button

Export File Name field

96-Well Genotyping Example_QuantStudio_export

File Type dropdown list

*

Ixt

Export File Location field

Use the default file location or click Browse to select a different

location
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Figure 94 Export screen
Your exported file when opened in Notepad should look like this:
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About presence/absence
experiments

IMPORTANT! First-time users of the QuantStudio™ 12K Flex Real-Time PCR System, see the part
“Getting started” on page 17 and Appendix A, “Documentation and support”. The sections provide
information and general instructions that are applicable to all the experiments described in this
document.

Note: For more information about any of the topics discussed in this guide, access the Help from
within QuantStudio™ 12K Flex Software by pressing F1, clicking in the toolbar, or selecting
Help » QuantStudio™ 12K Flex Software Help.

About data collection

Presence/Absence experiments are end-point experiments that are performed to detect a target nucleic
acid sequence in a sample.

You can collect the experiment data at the end of the run or continuously in real time.

End-point PCR data

The QuantStudio™ 12K Flex Real-Time PCR System collects data at an end-point, that is after the
process has completed.

The data collected is the normalized intensity of the reporter dye, or Rn.

Note: Some end-point experiments also include pre-PCR (data collected before the amplification
process) datapoints. If so, the system calculates the delta Rn (ARn) value per the following formula:

ARN = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized readings.
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Real-Time PCR data

The QuantStudio™ 12K Flex Real-Time PCR System provides the option of collecting real-time data,
during the PCR process.

Note: Real-time data collection is used only for troubleshooting, and not for Presence/Absence
analysis.

Setting up PCR reactions

With Presence/Absence experiments, you prepare PCR reactions that contain primers and probes to
amplify the target and a reagent to detect amplification of the target. You can set up the PCR reactions
for the Presence/Absence experiments two different ways.

Note: The example experiment uses IPC (internal positive control) setup for setting up the PCR
reactions.

IPC setup

Use an internal positive control (IPC) to monitor the PCR progress and ensure that a negative result is
not caused by failed PCR in the sample. The PCR contains two primer/probe sets:

* One to detect the unknown target (unknown target primer set and TagMan™ probe to detect the
unknown target)

* One to detect the IPC (IPC primer set and a VIC™ dye-labeled TagMan™ probe to detect the IPC
template)

There are three well types with this setup:

1. Unknown-IPC wells contain sample template and IPC template. The presence of the target is not
known.

2. Negative control-IPC wells contain IPC template and water or buffer instead of sample template
in the PCR reaction. Only the IPC template should amplify in negative control-IPC wells because
the reaction contains no sample template. This is also called IPC+.

3. Negative control-blocked IPC wells do not contain sample template in the PCR reaction.
Amplification is prevented by a blocking agent. As a result, no amplification should occur in
negative control-blocked IPC wells because the reaction contains no sample template and
amplification of the IPC is blocked. The negative control-blocked IPC is called no amplification
control (NAC).

If the run method includes amplification, real-time data are plotted in an amplification plot.

No IPC, singleplex setup

Omit the IPC from your Presence/Absence experiment. PCR reactions contain one primer/probe set.
PCR reactions do not contain the IPC. With this setup, there are two well types:

* Unknown wells—Wells contain sample template. The presence of the target is not known.

* Negative controls—Wells contain water or buffer instead of sample template.
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About the instrument run

With Presence/Absence experiments, the instrument runs can include:
* Pre-PCR read—Perform the pre-PCR read on the QuantStudio™ 12K Flex Software before PCR
amplification to collect baseline fluorescence data.

* Amplification—Perform amplification on the QuantStudio™ 12K Flex Software to collect
fluorescence data during PCR amplification. If you do not include amplification in the run method,
perform amplification on another instrument.

* Post-PCR read —To determine the results for Presence/Absence experiments, perform the post-
PCR read on the instrument after PCR ampilification to collect endpoint fluorescence data.

Fluorescence data collected during the instrument run are stored in an experiment data file (EDS).

About the analysis

Data from the instrument run are used to determine Presence/Absence calls. Results are plotted in a
Presence/Absence plot. If the experiment includes amplification, results are plotted in an amplification
plot.

* Pre-PCR read—If included, the data collected from the pre-PCR read can be used to normalize
data collected from the post-PCR read.

* Amplification—If included, the data collected from the amplification can be used to troubleshoot.

* Post-PCR read—The data collected from the post-PCR read are used to make Presence/Absence
calls:

— Presence—The target amplified above the target's threshold. The target is present in the
sample.

— Absence—The target did not amplify above the target's threshold. The target is absent in the
sample.

- Unconfirmed—The data collected is below the target threshold, and the intensity of IPC is
below the IPC threshold.
With the IPC setup, the data collected form the post-PCR read are used to make the following calls:

¢ |PC Failed—The IPC target did not amplify in the IPC wells and/or the IPC target amplified in the
blocked IPC wells.

¢ |PC Succeeded—The IPC target amplified in the IPC wells and the IPC target did not amplify in the
blocked IPC wells.
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About the example experiment

To illustrate how to perform Presence/Absence experiments, this guide leads you through the process
of designing and performing an example experiment. The example experiment represents a typical
setup that you can use to quickly familiarize yourself with a QuantStudio™ 12K Flex Real-Time PCR
System.

The objective of the Presence/Absence example experiment is to determine if a pathogen is present or
absent in each batch of ground beef.

* DNA is extracted from samples using the PrepMan™ Ultra Sample Preparation Reagent (Cat.
No. 4318930). The DNA is extracted from each of the four samples of ground beef or from the
bacteria found in the ground beef.

* The target is a pathogen.

* The experiment is designed for duplex PCR, where each reaction contains two primer/probe sets.
One set detects the pathogen sequence, TGFB (primer set and FAM™ dye-labeled probe to detect
the TGFB sequence). The other primer/probe set detects the IPC primer set and VIC™ dye-labeled
TagMan™ probe detects the IPC template.
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Design the experiment

This chapter explains how to design the example experiment from the Setup menu in the Experiment

Menu pane.

Note: To automatically export the analyzed data to a specified location, select the Auto Export
checkbox in the Export screen, before running the experiment. For more information on Auto Export,
see the part “Getting started” on page 17.

Define the experiment properties

In the Experiment Menu pane, click Setup » Experiment Properties.

Enter or select the following information.

Field or selection

Entry

Experiment Name field

Enter 96-Well Presence Absence Example.

Barcode field

Leave the Barcode field empty.

User Name field

Enter Example User or enter a user name.

Comments field

Enter Presence/Absence example.

Block Select 96-Well (0.2 mL).
Experiment Type Select Presence/Absence.
Reagents Select TagMan Reagents.
Ramp speed Select Standard.

Select all three data collection check boxes.

* Pre-PCR Read checkbox
* Amplification checkbox
¢ Post-PCR Read checkbox

Save the experiment.
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Figure 95 Experiment Properties screen

Define targets and samples

1. Click Define to access the Define screen.

2. Enter the following target information.

Target Name | Reporter | Quencher Color

TGFB FAM |NFQ-MGB

IPC ViC TAMRA .
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3. Enter the following sample information.
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Sample Name Color
(+) .

(-) .

NAC

NTC .
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4. In the Passive Reference dropdown list, select ROX .

Figure 96 Define screen
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Assign targets and samples

Click Assign to access the Assign screen.

Enter the following targets and samples.

Target Name Well Number Task Sample
TGFB A1 - A4 (Columns 1 - 4) Negative NAC
IPC No IPC
TGFB A5 - A8 (Columns 5 - 8) IPC NTC
IPC Negative
TGFB B1-B10 (Columns 1 - 10) Unknown +)
IPC IPC
TGFB C1-C10 (Columns 1 - 10) Unknown (-)
IPC IPC

Figure 97 Assign screen
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Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the Graphical View
tab. Enter the following information:

¢ Reaction Volume Per Well: 25 uL
® Thermal Profile

Stage Step | Ramp rate | Temperature Time
Pre-Read Stage Step1| 1.6°C/s 60°C 30 seconds
Hold Stage Step1| 1.6°C/s 95°C 10 minutes
PCR Stage Step1| 1.6°C/s 95°C 15 seconds

* Number of Cycles: 40 (default)
¢ Enable AutoDelta: Unchecked (default)

¢ Starting Cycle: Disabled when Enable AutoDelta is Step2 | 1.6°C/s 60°C 1 minute
unchecked
Post-Read Stage Step1| 1.6°C/s 60°C 30 seconds

Figure 98 Run Method screen
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For more information

Information Reference
Consumables Chapter 1, “General information and instructions”
Using alternative setup Chapter 2, “Experiment shortcuts”
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Prepare the reactions

This chapter explains how to prepare the PCR reactions for the Presence/Absence example experiment.

Assemble required materials

* [tems listed in the part “Getting started” on page 17
¢ Samples—DNA extracted from ground beef (100 ng/pL)
* Example experiment reaction mix components:

— TagMan™ Universal PCR Master Mix

- 10X IPC Mix

- 50X IPC DNA

— 20X Primer/Probe Mix

Prepare the reaction mix

For the Presence/Absence example experiment, four reaction mixes are used.
MG
* 0

NTC/IPC+

NAC/IPC-

The following tables list the universal assay conditions (volume and final concentration) for using the
TagMan™ Universal PCR Master Mix for the four reaction mixes.

Volume for 11
. . . Volume for 1 .
Reaction mix Reaction component . reactions (10 wells +
reaction
10% overage)
Reaction mix 1 for Sample (+) | TagMan™ Universal PCR Master 12.50 pL 137.50 pL
Mix (2.0X)
10X IPC Mix 2.50 yL 27.5 L
50X IPC DNA 0.50 pL 5.5puL
20X Primer/Probe Mix 1.25 uL 13.75 yL
Water/Buffer 5.75 UL 63.25 L
Diluted unknown 1 25uL 27.5 L
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Prepare the reaction mix

Reaction mix

Reaction component

Volume for 1

Volume for 11
reactions (10 wells +

reaction 10% overage)
Reaction mix 1 for Sample (+) Total reaction mix volume 25.0 yL 275 yL
Reaction mix 2 for Sample (-) | TagMan™ Universal PCR Master 12.50 yL 137.50 pL
Mix (2.0 X)
10X IPC Mix 2.50 pL 27.5 pL
50X IPC DNA 0.50 pL 5.5 uL
20X Primer/Probe Mix 1.25 L 13.75 pL
Water/Buffer 5.75 L 63.25 L
Diluted unknown 2 25uL 27.5 uL
Total reaction mix volume 25.0 yL 275 yL
Volume for 5
Reaction mix Reaction component Volume_for 1 reactions (4 wells +
reaction 10% overage)
Reaction mix 3 for NTC/IPC+| TagMan™ Universal PCR Master 12.50 pL 62.5 pL
Mix (2.0X)
10X IPC Mix 2.50 pL 12.5 L
50X IPC DNA 0.50 pL 2.5l
20X Primer/Probe Mix 1.25 L 6.25 pL
Water/Buffer 8.25 pL 41.25 pL
Total reaction mix volume 25.0 yL 125.0 yL
Reaction mix 4 for NAC/IPC- | TagMan™ Universal PCR Master 12.50 pL 62.5 pL
Mix (2.0X)
10X IPC Mix 2.50 pL 12.5 uL
50X IPC DNA 0.50 pL 2.5 L
20X Primer/Probe Mix 1.25 L 6.25 pL
IPC Block 2.5 L 12.5 L
Water/Buffer 5.75 uL 28.75 pL
Total reaction mix volume 25.0 yL 125.0 yL
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1. Label four appropriately sized tubes for the reaction mixes.
e Sample (+)
e Sample (-)
e NTC
* NAC

2. Add the required volumes of each reaction mix component to the tube.
3. Mix the contents thoroughly by gently pipetting up and down several times, then cap the tube.
4. Centrifuge the tube briefly to remove air bubbles.

5. Place the reaction mix on ice until you prepare the reaction plate.

Note: You can separately add the sample to the reaction plate, as opposed to preparing individual
reaction mixes for each sample.

Prepare the reaction plate

The reaction plate for the Presence/Absence example experiment contains the following items:
* A MicroAmp™ Optical 96-Well Reaction Plate (0.2 mL)
* Reaction volume of 25 uL/well
* 10 (+) wells
* 10 Sample (-) wells
* 4 NTC/IPC+
* 4 NAC/IPC-

324 QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide



J
\)

=
=

Chapter29 P75
Prepare the reaction plate

Figure 99 Plate layout

1. Add 25 pL of reaction mix 1 to wells B1 - B10.

2. Add 25 pL of reaction mix 2 to wells C1 - C10.
3. Add 25 pL of reaction mix 3 to wells A5 - A8.

4. Add 25 pL of reaction mix 4 to wells A1 - A4.

5. Seal the reaction plate with optical adhesive film.

6. Centrifuge the reaction plate briefly to remove air bubbles.
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7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the
reaction plate again at a higher speed and for a longer period of time.

8. Until you are ready to perform the run, place the reaction plate at 4°C, in the dark.

For more information

Information Reference
Assigning the reaction plate components Chapter 1, “General information and instructions”
Sealing the reaction plate Chapter 1, “General information and instructions”
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Run the experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K Flex Real-Time
PCR Instrument.

IMPORTANT! Run the experiment at the same ambient temperature at which you calibrated the
instrument. Extreme variations in ambient temperature can affect the heating and cooling of the
instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the
instrument is in operation.

Start the run

1.

Open the Presence/Absence example file that you created.
See Chapter 28, “Design the experiment”.

2. Load the reaction plate into the instrument.

3. Start the run.

Monitor the run

You can monitor an experiment run in three ways:

From the Run screen of the QuantStudio™ 12K Flex Software, while the experiment is in progress

From the Instrument Console screen of the QuantStudio™ 12K Flex Software, to monitor an
experiment started from another computer or from the instrument touchscreen (see “Monitor a run
from the software Instrument Console screen” on page 327)

From the instrument touchscreen (see “Monitor a run from the instrument touchscreen” on
page 331)

Monitor a run from the software Instrument Console screen

1.

In the Instrument Console screen, select the icon of the instrument that you are using to run the
experiment.

Click Manage Instrument or double-click on the instrument icon.

In the Instrument Manager screen, click Monitor Running Experiment to access the Run
screen.
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View the temperature plot

Click Temperature Plot from the Run Experiment menu.

Figure 100 The Temperature Plot screen as it appears during the example experiment

Note: The sample temperature displayed in the Current Temperatures group is an estimated value.
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View the run method

Click Run Method from the Run Experiment menu.

Figure 101 The Run Method screen as it appears in the example experiment
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View run data

Click View Run Data from the Run Experiment menu.

Figure 102 The View Run Data screen as it appears in the example experiment
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Monitor the run

Monitor a run from the instrument touchscreen

You can view the progress of the run from the instrument touchscreen.

The following figures are for visual representation only. Actual results vary with the experiment.

Figure 103 Experiment View tab
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Figure 104 Time View tab

Figure 105 Plot View tab

Note: You will see the Plot View only if your experiment includes the PCR process.
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Review results and adjust
experiment parameters

The following topics are covered in this chapter:

* Review the analyzed data using several of the analysis screens and publish the data (see “Review
results” on page 333)

* Modify experiment parameters to troubleshoot problems with experiment results before rerunning
an experiment (see “Adjust parameters for re-analysis of your own experiments” on page 353)

Review results

Analyze the example experiment

1. Open the example experiment file.
See Chapter 30, “Run the experiment”.

2. Click Analyze.

Note: You can also access the experiment to analyze from the Home screen.

The software analyzes the data using the default analysis settings.

View the presence/absence plot

The Presence/Absence Plot displays the intensity of the fluorescence for each well position. There are
four Presence/Absence plot views available:

All Calls
* Presence calls only

* Absence calls only
* Unconfirmed calls

For each view you can choose to perform the following tasks:
¢ Show IPC
* Show Controls
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Purpose
The purpose of viewing the Presence/Absence Plot for the example experiment is to confirm the
following items:

* The target is absent in samples NTC and Sample (-)

* The target is present in Sample (+)

® There are no unconfirmed wells

* The IPC succeeded in all wells

® There is no amplification in NAC wells

To view and assess the presence/absence plot

1. In the Experiment Menu pane, click Analysis » Presence/Absence Plot.

Note: If no data are displayed, click Analyze.

2. Display all 96 wells in the Presence/Absence Plot screen by clicking the upper left corner of the
plate layout in the Plate Layout tab.

3. Enter the following plot settings.

Menu Selection
Target Reporter dropdown list TGFB
Control Reporter dropdown list IPC
Show Calls dropdown list All Calls
Show a legend for the plot Check (default)
(This is a toggle button. When the legend is displayed, the button changes to Hide the
plot legend.)

4. Select the Show IPC checkbox to view the fluorescence intensity of the IPC target in the
Unknown-IPC wells.

5. Select the Show Controls checkbox to view the fluorescence intensity of the IPC target in the
negative control-IPC wells and the negative control-Blocked IPC wells.

6. View the fluorescence intensity.
* Presence calls—Select Presence from the Show Calls dropdown list.
* Absence calls—Select Absence from the Show Calls dropdown list.

* Unconfirmed calls—Select Unconfirmed from the Show Calls dropdown list.
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Note: The Presence/Absence example experiment does not contain any unconfirmed calls.

Figure 106 The Presence/Absence Plot for the example experiment

Tips for viewing presence/absence plots in your own experiments

* The IPC threshold is calculated from the negative control-Blocked IPC reactions.

* The Target Threshold is calculated from the negative control-IPC reactions. If the intensity of the
target is:

— Above the target threshold, the call is present (regardless of the intensity of the IPC).

— Below the target threshold, and the IPC's intensity is above the IPC threshold, the call is
absent.

— Below the target threshold, and the IPC's intensity is below the IPC threshold, the call is
unconfirmed.

* Target Calls:
— Presence

— Absence
— Unconfirmed

¢ |PC Calls:
— |PC Succeeded

- IPC Failed
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Control Well Calls:
— Negative control - IPC
— Negative control - Blocked IPC

Assess amplification results using the amplification plot

IMPORTANT! Amplification plots are not used to make Presence/Absence calls. Examine the plots to
help with troubleshooting and quality control.

Amplification plots available for viewing

The Amplification Plot screen displays amplification of all samples in the selected wells. There are
three plots available:

ARN vs Cycle—ARn is the magnitude of normalized fluorescence signal generated by the reporter
at each cycle during the PCR amplification. This plot displays ARn as a function of cycle number.
Use this plot to identify and examine irregular amplification and to view threshold and baseline
values for the run.

Rn vs Cycle—Rn is the fluorescence signal from the reporter dye normalized to the fluorescence
signal from the passive reference. This plot displays Rn as a function of cycle number. Use this plot
to identify and examine irregular amplification.

Ct vs Well—Cy is the PCR cycle number at which the fluorescence meets the threshold in the
amplification plot. This plot displays Ct as a function of well position. Use this plot to locate
outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

Purpose

The purpose of viewing the ampilification plot for the example experiment is to review the target to
identify:

Correct baseline and threshold values
Irregular amplification

Outliers

View the ampilification plot

1.

336

In the Experiment Menu pane, click Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

Display all 96 wells in the amplification plot by clicking the upper left corner of the plate layout in
the Plate Layout tab.

Expand the Plate Layout tab by clicking the left facing arrow that is left of the tab.
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4. In the Amplification Plot screen, enter the following information.
ltem Select
Plot Type dropdown list ARn vs Cycle
Plot Color dropdown list Well (default)
Check (default)
(This is a toggle button. When the legend is displayed, the button changes to Hide the
plot legend).

5. View the baseline values.
a. From the Graph Type dropdown list, select Linear.

b. Select the Baseline checkbox to show the start cycle and end cycle.

c. Confirm that the baseline is set correctly. The end cycle should be set a few cycles before the
cycle number where significant fluorescent signal is detected. In the example experiment, the
baseline is set correctly.

6. View the threshold values.
a. From the Graph Type dropdown list, select Log.

b. Select the Threshold checkbox to show the threshold.
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c. Confirm that the threshold is set correctly.

7. Locate any outliers.
a. From the Plot Type dropdown list, select Ct vs. Well.
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b. Look for outliers from the amplification plot. In the example experiment, there are no outliers
for IPC.

Tips for viewing amplification plots in your own experiments
When you analyze your own Presence/Absence experiment, look for the following items:

* Outliers
* A typical amplification plot—The QuantStudio™ 12K Flex Software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a typical amplification

plot. A typical amplification plot has four distinct sections:
— Plateau phase
— Linear phase
— Exponential (geometric phase)

— Baseline
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Figure 107 Typical amplification plot

IMPORTANT! Experimental error (such as contamination or pipetting errors) can produce atypical
amplification curves that can result in incorrect baseline and threshold value calculations by the
QuantStudio™ 12K Flex Software. We recommend that you examine the Amplification Plot screen
and review the assigned baseline and threshold values for each well after analysis completes.

Note: If you use the Relative Threshold algorithm to analyze an experiment that includes amplification,
select to view the analysis results using the ARn vs Cycle, Rn vs Cycle, or Cgr vs Well plot type and
Linear or Log graph type. Also select the Show Crt check box to view the derived fractional cycle on
the ampilification plot.
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View the well table

The well table displays results data for each well in the reaction plate, including the following items:
* The well number, sample name, target name, task, and dyes
* The calculated values: ARn, ARn mean, and ARn SD

Note: ARn, ARn mean, and ARn SD are calculated only when the analysis call settings specify to
analyze data from the pre-PCR read and the post-PCR read.

* Target and IPC thresholds, Call, Comments
* Flags

Purpose

In the Presence/Absence example experiment, you review the well table for:
e Call
* ARn
* Flag
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View the well table

1. In the Experiment Menu pane, select Analysis » Amplification Plot,, then click the Well Table
tab.

2. Use the Group By dropdown list to group wells by a specific category.

For the example experiment, group the wells by flag, call, and ARn value. You can select only one
category at a time.

a. From the Group By dropdown list, select Flag.
* 30 wells are listed under Flagged Wells.
* 66 wells are listed under Unflagged Wells.

b. From the Group By dropdown list, select Call.
Wells are listed in the following order:
* Absence
* Blocked IPC Control
¢ |PC Failed
* |PC Succeeded

* Negative Control
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* Unconfirmed
* No Call
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c. From the Group By dropdown list, select None, then click the column heading ARn.

Wells are listed in order of increasing ARn. Click the column heading again to reverse the sort
order.

Tips for analyzing your own experiments

When you analyze your own Presence/Absence experiment, group the wells by the following items:

* Flag—The software groups the flagged and unflagged wells. A flag indicates that the software has
found an error in the flagged well. For a description of the flags, see “Review the flags in the QC
summary” on page 350.

* Call—The software groups the wells by call: Negative Control, Blocked-IPC, Presence, Absence,
Unconfirmed, IPC Succeeded, and IPC Failed.
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Confirm accurate dye signal using the multicomponent plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected
well over the duration of the PCR run.

Purpose

In the Presence/Absence example experiment, review the Multicomponent Plot screen for the
following items:

ROX™ dye (passive reference)

FAM™ dye (reporter)

VIC™ dye (reporter)

TAMRA™ (reporter)

Spikes, dips, and/or sudden changes
Amplification in the negative control wells

View the multicomponent plot

1.

In the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

Display the wells one at a time in the Multicomponent Plot screen:
a. Click the Plate Layout tab.

b. Select one well in the plate layout. The well is shown in the Multicomponent Plot.

Note: If you select multiple wells, the Multicomponent Plot displays the data for all selected
wells simultaneously.

In the Plot Color dropdown list, select Dye.

Click [] Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.

Check the ROX™ dye signal.

In the example experiment, the ROX™ dye signal remains constant throughout the PCR process. A
constant ROX™ dye signal indicates typical data.

Check the VIC™ dye signal.

In the example experiment the VIC™ dye signal should not amplify for NAC-Blocked IPC wells or if
the IPC call for the Unknown-IPC well is IPC Failed.
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7. Check the FAM™ dye signal.

In the example experiment, for the sample (+), the FAM™ dye signal increases throughout the PCR
process. An increase in FAM™ dye signal indicates normal amplification.
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8. Check the TAMRA™ dye signal.

In the example experiment the TAMRA™ dye signal should not amplify for NAC-Blocked IPC wells
or if the IPC call for the Unknown-IPC well is IPC Failed.

9. Select the negative control (NTC) wells one at time and check for amplification.
In the example experiment, there is no amplification in the negative control wells.
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Tips for confirming dye accuracy in your own experiment

When you analyze your own Presence/Absence experiment, look for the following items:

Passive reference (ROX™ dye)—The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

Reporter dye (FAM™ dye)—The reporter dye fluorescence level should display a flat region
corresponding to the baseline. If target is present in the sample (a Presence call is made), the
baseline will be followed by a rapid rise in fluorescence as the amplification proceeds.

Irregularities in the signal—There should not be any spikes, dips, and/or sudden changes in the
fluorescent signal.

Negative control wells—There should not be any amplification in the negative control wells.

Determine signal accuracy using the raw data plot

348

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter
for the selected wells during each cycle of the real-time PCR.

Purpose

In the Presence/Absence example experiment, review the Raw Data Plot screen for a stable increase in
signal (no abrupt changes or dips) from the appropriate filter.

View the raw data plot

1.

In the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

Click 7] Show a legend for the plot (default).

The legend displays the color code for each row of the reaction plate (see the legend in Figure 108
on page 349).

Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner of the plate
layout in the Plate Layout tab.

Select wells that correspond to a replicate group.
* (-) wells: From the Select Wells with drop-down menus, select sample (-).
* (+) wells: From the Select Wells with drop-down menus, select sample (+).
* Negative control-IPC wells: Select wells A5-A8.
¢ Negative control-blocked IPC wells: Select wells A1-A4.
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5. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example experiment, there
is a stable increase in signal from filter 1, which corresponds to the FAM™ dye filter.

Figure 108 Raw data plot
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Figure 109 Filters used for the example experiment

Tips for determining signal accuracy in your own experiments

When you analyze your own Presence/Absence experiment, look for the following in each filter:
® Characteristic signal growth
* No abrupt changes or dips

Review the flags in the QC summary

350

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the
flag frequency and location for the open experiment. In the example experiment, 31 flags have been
triggered.

Note: The flags triggered in the example experiment are seen in the (+) and (-) wells. The flag NOAMP
indicates that the well containing the sample (+) did not amplify. The flags, NOAMP and EXPFAIL
indicate that the wells containing the sample (-) did not amplify and that the software could not identify
the exponential region of the amplification plot (as amplification did not take place). The occurrence of
these flags in the (-) wells in the example experiment is valid because it indicates the absence of the
target in the sample.
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View the QC summary

1. In the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary

Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the
experiment. If the frequency is greater than 0, the flag appears somewhere in the experiment. The
well position is listed in the Wells column.

In the example experiment, there are 15 flagged wells.

3. In the Flag Details table, click each flag with a frequency greater than 0 to display detailed
information about the flag.

The following details apply to the example experiment:
* The NOAMP flag appears 13 times, in the wells A5 - A8, B1, C3 - C10.

* The EXPFAIL flag appears 14 times, in the same wells as the NOAMP flag, that is, A5 - A8, B1,
C8 - C10. In addition, the flag EXPFAIL also appears in the B1 well.

* The AMPNC flag appears 4 times, in the wells A5-A8.
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4. (Optional) For those flags with frequency greater than 0, click the troubleshooting link to view
information on correcting the flag.

T

Flag Dctails
Flag: Description Frequency Wells
BADROX Bad passve reference signzl 0
NOSIGHAL Mo signal in wel (]
OFFSCALE Fluorescence is offscale o
AMPNC Amplification n negative contro 4 A5, A6, A7, AB
NOAMP iMo zmplfication 13 A5, AG, A7, A8, B1, C3, C4, C5, Co, C7, C8, (9, C10
MNOISE Moiga higher than othere in plata [
SPIKE MNoisz spikes 0
EXPFAIL Exponential aigorthm faled 14 A5, AG, AZ, A8, C1, C2, C3, C4, C5, Ce, C7, €8, 03, C10
BLFATL Baseline algorthrmn failed 0
THOLDFAIL Thresholding algorithm failed (]
CTFAIL Cr algorithm failed 1]
AMPSCORE AMF Score 0
Flag: NOAMP—No amplfication
Flag Detail: The sample did not amplfy.
Flag Criteria: Ampification algorithm result < 0.1
Flagged Wells: AS, Ab, A7, A8, B1, C3, C4, C5, Cb, C7, C8, C9, C10
View NOAMP Troubleshooting Information
Total Wells: 96 | Processed Wells: 28 Manually Omitted Wells: 0 | Targekts Used: 2
Wells Set Up: 28 | Flagged Wells: 15 Analysis Omitted Wells: 0 | Samoles Used: 4
Well Summary: In Plate: 95 Set Up: 28 Analyzed: 28 Fiagged: 15 Omitted by Analysis: Cmitted Manually: 0 Samples Used: 4 Targsts Used: 2

Possible flags

For Presence/Absence experiments, the flags listed below may be triggered by the experiment data.

Flag

Description

Pre-processing flag

OFFSCALE

Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification

NOISE Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed

352
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(continued)

Flag Description
THOLDFAIL Thresholding algorithm failed
CTFAIL Cr algorithm failed

AMPSCORE | Ampilification in the linear region is below a certain threshold, corresponding to the score set
in the analysis settings

Secondary analysis flags

AMPNC Amplification in negative control

Note: If the experiment does not include amplification, then the only flags are BADROX, NOSIGNAL,
and OFFSCALE.

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL
flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed
in the Frequency column for each flag).

For more information

Information Reference

Publishing data Chapter 1, “General information and instructions”

Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold cycle (Cy), flags,
and advanced options.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your
experiment.

View the analysis settings

1. In the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
* (Call Settings
® (7 Settings
* Flag Settings
* Advanced Settings
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Figure 110 Analysis Settings dialog box for a Presence/Absence experiment

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” on page 355).

Note: You can save the changes to the analysis settings to the Analysis Settings Library for later
use. For more information, see “About the analysis settings library” on page 62.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to Default Analysis
Settings.
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Adjust analysis settings
Call settings
Use the Call Settings tab to:

* (Change the default data analysis settings. You can select from the following items:
— Analyze Data from Post-PCR Read Only radio button

— Analyze Data from Pre-PCR Read and Post-PCR Read radio button

¢ Edit the default call settings.

— Click Edit Default Settings, then select the confidence value to use to make
presence/absence calls in the Edit Default Confidence Value dialog box. If the confidence
value is less than the call setting, the call is unconfirmed.

— Click Save Changes.

® Use custom call settings for a target.
— Select one or more targets in the table, then deselect the Default Settings checkbox.
The Confidence Value field in the right pane is editable when the Default Settings checkbox
is deselected.

— Select the confidence value to use to make Presence/Absence calls for the selected target or
targets.

Cr settings

¢ Data Step Selection
Use this feature to select one stage/step combination for Ct analysis when there is more than one
data collection point in the run method.

¢ Algorithm Settings
You can select the algorithm that determines the Cy values. There are two algorithms: Baseline
Threshold (the default) and Relative Threshold.
The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline
component and sets a fluorescent threshold in the exponential region for quantification.
The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency
and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no
dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a
threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold
will not affect the analysis.

* Default Ct Settings
Use the default Cy settings feature to calculate C+ for the targets that do not have custom settings.
To edit the default settings, click Edit Default Settings.

® C Settings for Target
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When you manually set the threshold and baseline, we recommend the following settings:

Setting Recommendation

Threshold | Enter a value for the threshold so that the threshold is:
— Above the background.
— Below the plateau and linear regions of the amplification curve.

— Within the exponential phase of the amplification curve.

Baseline | Select the Start Cycle and End Cycle values so that the baseline ends before significant
fluorescent signal is detected.

Note: Selecting Automatic Threshold implies selection of automatic setting of the baseline.
However, if Automatic Threshold is deselected, then you can choose between setting the baseline
either automatically or manually.

Flag settings

Use the Flag Settings tab to perform the following tasks:

1.

356

Adjust the sensitivity so that more wells or fewer wells are flagged.
Change the flags that are applied by the QuantStudio™ 12K Flex Software.

In the Use column, select the check boxes for flags to apply during analysis.

(Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying
the flag.

Note: If you choose to adjust the setting for applying a flag, make minor adjustments as you
evaluate the appropriate setting.

In the Reject Well column, select the check boxes if you want the software to reject wells with the
flag.

Note: After you have rejected the flagged wells, analysis results depend on factors such as the
experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments
using the Standard Deviation calculations may change the result of Ct SD. For some flags, analysis
results calculated before the well is rejected are maintained.

Click Apply Analysis Settings in the Analysis Settings dialog box.
If the run status is complete, the data are reanalyzed.
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Figure 111 Flag Settings tab

Advanced settings

Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative Threshold setting.

The following steps describe the use of custom baseline settings for a well-target combination.
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target checkbox.

3. Define the custom baseline settings.
* For automatic baseline calculations, select the Automatic Baseline checkbox.

* To define the baseline, deselect the Automatic Baseline checkbox, then enter the baseline
start cycle and baseline end cycle.
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Export analysis results

1. Open the Presence/Absence example experiment file that has been analyzed.

For information about analysis, see Chapter 31, “Review results and adjust experiment

parameters”.

2. In the Experiment Menu pane, click

Export.

Note: To export data automatically after analysis, select the Auto Export checkbox during
experiment setup or before running the experiment. The Auto Export checkbox is unchecked

for the example experiment.

3. In the Format dropdown list, select QuantStudio 12K Flex format.

4. Complete the Export dialog box as shown below.

Field or Selection

Entry

Select Data to export/Select Content

Results

Export Data To options

One File radio button

Export File Name field

96-Well Presence Absence Example_QuantStudio_export

File Type dropdown list

*

Ixt

Export File Location field

Use the default file location or click Browse to select a different
location
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[ Auto Export Format : |QuantStudio 12KFlex v Export Data To: (5) One File ) Separate Files Open file(s) when export is complete

Export File Location: |C:\Applied Biosystems\QuantStudio 12K Flex Software\U:

Export File Name: |96-Well Presence Absence Example_Quant| File Type: |[F] (=tx) |+

[ sample setup [CJRaw Data [ amplfication [ Multicomponent

Skip Empty Wells Skip Omitted Wels

s
elect Content Well Wwell Position Sample Name Target Name Task Reporter Quencher D
P g P
All Fields . 141 NAC PC BlockedIPC vIC TAMRA A
141 NAC TGFB NTC FAM NFQ-MGB
Wel 282 NAC e BlockedIPC viC TAMRA
\Well Position 242 NAC TGFB HTC FAM NFQ-MGE
3A3 NAC PC BlockedIPC VIC TAMRA
Sample Name 3A3 NAC TGFB NTC FAM NFQ-MGE
444 NAC PC BlockedIPC VIC TAMRA
Target Name 4.A4 NAC TGFE NTC FAM NFQ-MGE
5A5 NTC PC NTC VIC TAMRA
Task 5A5 NTC TGFB IPC FAM NFQ-MGB
Reporter 6 A6 NTC PC NTC VIC TAMRA
6 A6 NTC TGFB PC FAM NFQ-MGB
Quencher 7 A7 NTC PC NTC VIC TAMRA
7 A7 NTC TGFB PC FAM NFQ-MGB
Delta Rn 8a8 NTC PC NTC VIC TAMRA
8 A8 NTC TGFB PC FAM NFQ-MGB
Dela Rn Mean 13B1 (+) PC PC VIC TAMRA
Delta Rr SD 13B1 (+) TGFB UNKNOWN FAM NFQ-MGB
14B2 (+) PC PC VIC TAMRA
Threshold Value 1482 (+) TGFB UNKNOWN FAM NFQ-MGE
1583 (+) PC IPC VIC TAMRA
Call 1583 (+) TGFB UNKNOWN FAM NFQ-MGB
16B4 (+) PC IPC VIC TAMRA
Comments 1684 (+) TGFB UNKHOWH FAM NFQ-MGB
Automatic Ct Threshold 1785 (+ pc pC vIC TAMRA
17B5 (+) TGFB UNKNOWN FAM NFQ-MGB
Ct Threshold 18B6 (+) PC PC VIC TAMRA
18B6 (+) TGFB UNKNOWN FAM NFQ-MGB
Automatic Baseline 1987 (+) PC PC VIC TAMRA
Baselna Start gl 1987 &) TGFB UNKNOWN FAM NFQ-MGB c v

[m Save Export Set As Load Export Set Delete Export Set

Figure 112 Export screen
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Figure 113 Exported file
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Overview of melt curve experiments

IMPORTANT! First-time users of the QuantStudio™ 12K Flex Real-Time PCR System, see the part
“Getting started” on page 17 and Appendix A, “Documentation and support”. The sections provide
information and general instructions that are applicable to all the experiments described in this
document.

Note: For more information about any of the topics discussed in this guide, access the Help from
within the QuantStudio™ 12K Flex Software by pressing F1, clicking in the toolbar, or selecting
Help » QuantStudio 12K Flex Software Help.

Overview

A Melt Curve, also known as dissociation curve, is a plot of data collected during the Melt Curve stage
of an experiment. Melt Curve experiments are performed to determine the melting temperature (Tm) of a
target nucleic acid sequence or to identify nonspecific PCR amplification.

Melting temperature (Tm) is the temperature at which 50% of the target DNA is double-stranded and
50% is dissociated into single-stranded DNA.

The melting temperature and non-specific PCR amplification can be identified as peaks in the melt
curve stage of an experiment.

About the melt curve reactions

With Melt Curve experiments, the reactions consist of completed PCR reactions that contain amplified
products and SYBR Green™ dye to detect double-stranded DNA.

The QuantStudio™ 12K Flex Software detects the number of fluorescence peaks, determines the
melting temperature (Tm) for each peak, and plots the results in a melt curve.

The fluorescence data collected during the QuantStudio™ 12K Flex Real-Time PCR Instrument run are
stored in an experiment data file (EDS).

There are two types of reactions in a Melt Curve experiment:

¢ Unknowns—Wells containing PCR product with an unknown melting temperature or unknown
melting temperatures.

* Negative Controls—Wells containing buffer or water instead of sample. The negative control wells
should contain no double-stranded DNA.
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About the example experiment

To illustrate how to perform Melt Curve experiments, this guide leads you through the process of
designing and performing an example experiment. The example experiment represents a typical setup
that you can use to quickly familiarize yourself with a QuantStudio™ 12K Flex Real-Time PCR System.

The objective of the example Melt Curve experiment is to investigate the melting temperature of Target

1, and verify that no extraneous peaks appear. The SYBR Green™ reagent is used to detect the melting
temperature stage.

Note: The example experiment performs a melt curve analysis on PCR products from a PCR
performed on the QuantStudio™ 12K Flex Real-Time PCR System or on another thermal cycler.
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Design the experiment

This chapter explains how to design the example experiment from the Setup menu in the Experiment

Menu pane.

Note: To automatically export the analyzed data to a specified location, select the Auto Export
checkbox in the Export screen, before running the experiment. For more information on Auto Export,
see the part “Getting started” on page 17.

Define the experiment properties

In the Experiment Menu pane, click Setup » Experiment Properties.

Enter or select the following information.

Field or selection

Entry

Experiment Name field

Enter 384-Well Melt Curve Example.

Barcode field

Leave the Barcode field empty.

User Name field

Enter Example User or enter a user name.

Comments field

Enter Melt Curve example.

Block Select 384-Well.

Experiment Type Select Melt Curve.

Reagents Select SYBR Green Reagents.
Ramp speed Select Standard.

Include PCR checkbox

Uncheck the Include PCR checkbox.

Save the experiment.
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Figure 114 Experiment Properties screen

Define targets and samples

1. Click Define to access the Define screen.

2. Enter the following target information.

Chapter 34
Define targets and samples

172/

Target name

Reporter

Quencher

Color

Target 1

SYBR

None

3. Enter the following sample information.

Sample name

Color

Sample 1
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4. In the Passive Reference dropdown list, select ROX .

Figure 115 Define screen

Assign targets and samples

Click Assign to access the Assign screen.

Enter the following targets and samples.

Target name Sample Well Number Task

SYBR Sample 1 A1-P2 (Columns 1 and 2), A3-G3 (Column 3) Unknown
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Figure 116 Assign screen

Set up the run method

Set the thermal profile

Click Run Method to access the Run Method screen.

tab. Enter the following information:

* Reaction Volume Per Well: 20 uL

* Thermal Profile

Chapter 34 =0

172 /]

Set up the run method

Set the thermal profile under the Graphical View

Stage Step Ramp rate Temperature Time
Melt Curve Stage Step 1 1.6°C/s 95°C 15 seconds
Step 2 1.6°C/s 60°C 1 minute
Step 3 (Dissociation) 0.05°C/s 95°C 15 seconds
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Set up the run method

Edit the ramp increment

Edit the ramp increment for a melt curve (dissociation) step.

1. Select a melt curve ramp increment method.

* Step and Hold radio button—Increases or decreases the ramp temperature in 0.1°C
increments over the time (duration) for the melt curve ramp.

* Continuous radio button (default)—Increases or decreases the ramp rate in 0.005°C per
second increments.

2. If you selected the Step and Hold ramp increment method, edit the melt curve ramp time.

* To increase or decrease the time in 1-minute or 1-second increments, click the Step and Hold
field, select the minutes or seconds, then use the up or down arrow keys or click the up or
down buttons in the field until you reach the desired time.

* To enter the desired time, click the Step and Hold field, select the minutes or seconds, then
enter the desired time.

3. Edit the melt curve ramp increment.

* To increase or decrease the ramp increment, click the melt curve (dissociation) ramp
increment in the thermal profile, then use the up or down arrow keys or click the up or down
buttons in the field until you reach the desired value.

* To enter the desired ramp increment, click the melt curve (dissociation) ramp increment in the
thermal profile, select the value in the field, then enter the desired value.
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Note: To view the maximum and minimum allowed values, place the cursor over melt curve
(dissociation) ramp increment in the thermal profile and wait for the tooltip to pop up.

Figure 117 Run Method screen

For more information

Information Reference
Consumables Chapter 1, “General information and instructions”
Using alternative setup Chapter 2, “Experiment shortcuts”
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Prepare the reactions

This chapter explains how to prepare the reactions for running a PCR prior to running a Melt Curve.

To perform a Melt Curve experiment without running a PCR, use the reaction plate containing the PCR
product.

Note: The example experiment performs a melt curve analysis on PCR products from a PCR
performed on the QuantStudio™ 12K Flex Real-Time PCR System or on another thermal cycler.

Assemble required materials

* [tems listed in the part “Getting started” on page 17
e Sample 1

* Example experiment reaction mix components:
— Power SYBR™ Green Master Mix

— Target—Assay Mix Forward primer (10 pM)
— Target—Assay Mix Reverse primer (10 uM)

Prepare the sample dilutions

The stock concentration of each sample is 100 ng/pL. After you dilute the sample according to the
following table, the sample will have a concentration of 10 ng/pL. Add 2pL to each reaction.

Sample name Sample volume | Diluent volume | Total volume of diluted sample

Sample 1 (Amplified PCR Product) 10 yL 90 uL 100 pL
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Prepare the reaction mix

Chapter 35 P&y
Prepare the reaction mix

The following table lists the universal assay conditions [volume and final concentration for using the

Power SYBR™ Green Master Mix (2X)].

Reaction Component Volume for 1 reaction Volume for 40 reactions
Power SYBR™ Green Master Mix (2X) 10 uL 400 pL
Forward primer (10 pM) 0.1 pL 4 uL
Reverse primer (10 pM) 0.1 pL 4 uL
Water 7.8 pL 312 uL
Total reaction mix volume 18 uL 720 pL

Procedure

1. Label an appropriately sized tube for the reaction mix: Power SYBR™ Green Master Mix Reaction

Mix.

2. Add the required volume of each rection mix component to the tube.

3. Mix the cocktail thoroughly by gently pipetting up and down several times, then cap the tube.

4. Centrifuge the tube briefly to remove air bubbles.

5. Place the reaction mix on ice until you prepare the reaction plate.

Calculations

Determine the quantity of primer to be added to the reaction mix by performing the following

calculation:

Concentration (initial) C1 x Volume (primer stock) V1 = Concentration (final) C2 x Volume (final reaction)

V2
(10pM) x (V1) = (0.05uM) (20pL)
V1 = (0.05 x 20) / 10 = 0.1
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Prepare the reaction plate

1. Add reaction mix and sample to a tube.
a. Add the volumes of reaction mix and sample listed below to an appropriately-sized tub.

Tube Unknc.>wn Reaction mix Reaction mix Sample Sample
reaction volume volume
1 Target 1 Power SYBR™ Green Master 720 pL Sample 1 80 pL
Mix reaction mix['!

[ Prepared in “Prepare the reaction mix” on page 371.

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.
2. Pipette 20 pL of the unknown (sample) reaction to each well in the reaction plate.
3. Seal the reaction plate with optical adhesive film.
4. Centrifuge the reaction plate briefly to remove air bubbles.

5. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the
reaction plate again at a higher speed and for a longer period of time.

6. Until you are ready to perform the PCR run, place the reaction plate at 4°C, in the dark.
7. Run the PCR.

8. After the PCR is completed, use the same reaction plate containing the PCR product to run the
Melt Curve as described in Chapter 36, “Run the experiment”.

For more information

Information Reference
Assigning the reaction plate components Chapter 1, “General information and instructions”
Sealing the reaction plate Chapter 1, “General information and instructions”
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Run the experiment

This chapter explains how to run the example experiment on the QuantStudio™ 12K Flex Real-Time
PCR Instrument.

IMPORTANT! Run the experiment at the same ambient temperature at which you calibrated the
instrument. Extreme variations in ambient temperature can affect the heating and cooling of the
instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while the
instrument is in operation.

Start the run

1.

Open the Melt Curve example file that you created.
See Chapter 34, “Design the experiment”.

IMPORTANT! The example experiment includes the melt curve analysis of a PCR product from
PCR on the QuantStudio™ 12K Flex Real-Time PCR System or another thermal cycler. To run a
Melt Curve on the example file you created in Chapter 34, “Design the experiment”, ensure that
PCR has already been performed on the reaction plate you load into the instrument. Absence of
the PCR product will lead to no results in the Dissociation Step of the Melt Curve Stage.

2. Load the reaction plate, containing the PCR product, into the instrument.

3. Start the run.

Monitor the run

You can monitor an experiment run in three ways:

From the Run screen of the QuantStudio™ 12K Flex Software, while the experiment is in progress

From the Instrument Console screen of the QuantStudio™ 12K Flex Software, to monitor an
experiment started from another computer or from the instrument touchscreen (see “Monitor a run
from the software Instrument Console screen” on page 374)

From the instrument touchscreen (see “Monitor a run from the instrument touchscreen” on
page 378)
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Monitor a run from the software Instrument Console screen

1. In the Instrument Console screen, select the icon of the instrument that you are using to run the
experiment.

2. Click Manage Instrument or double-click on the instrument icon.

3. In the Instrument Manager screen, click Monitor Running Experiment to access the Run
screen.
View the melt curve

You can view the progress of the run in real time. During the run, periodically view all the three plots
available from the QuantStudio™ 12K Flex Software for potential problems.

Click Melt Curve from the Run Experiment menu, select the Plate Layout tab, then select the wells to
view.

Figure 118 The Melt Curve Plot screen as it appears at the end of the example experiment
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View the temperature plot

Click Temperature Plot from the Run Experiment menu.

Figure 119 The Temperature Plot screen as it appears during the example experiment

Note: The sample temperature displayed in the Current Temperatures group is an estimated value.
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View the run method

Click Run Method from the Run Experiment menu.

Figure 120 The Run Method screen as it appears in the example experiment
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View run data

Click View Run Data from the Run Experiment menu.

Figure 121 The View Run Data screen as it appears in the example experiment
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Monitor a run from the instrument touchscreen

You can view the progress of the run from the instrument touchscreen.

The following figures are for visual representation only. Actual results vary with the experiment.

Figure 122 Experiment View tab
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Figure 123 Time View tab

Figure 124 Plot View tab

Chapter 36
Monitor the run

Note: You will see the Plot View only if your experiment includes the PCR process.
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Review results and adjust
experiment parameters

The following topics are covered in this chapter:

* Review the analyzed data using several of the analysis screens and publish the data (see “Review
results” on page 380)

* Modify experiment parameters to troubleshoot problems with experiment results before rerunning
an experiment (see “Adjust parameters for re-analysis of your own experiments” on page 392)

Review results

Analyze the example experiment

1. Open the example experiment file.
See Chapter 36, “Run the experiment”.

2. Click Analyze.

Note: You can also access the experiment to analyze from the Home screen.

The software analyzes the data using the default analysis settings.

View the melt curve plot

View the Melt Curve Plot as the Derivative Reporter (-Rn) versus the Temperature Plot generated by the
target.

The Melt Curve Plot screen displays the melt curve of the targets in the selected wells. Use the Melt
Curve plots to confirm the results of the experiment:

* Normalized Reporter (Rn) vs. Temperature—This plot displays the fluorescence signal from the
reporter dye normalized to the fluorescence signal of the passive reference. You can use this plot to
see the change in Rn with change in the temperature. You cannot use this plot to determine the Tm
of the target.

¢ Derivative Reporter (-Rn) vs. Temperature — This plot displays the derivative reporter signal in the
y-axis. The peaks in the plot indicate significant decrease in SYBR Green™ signal, and therefore the
Tm of the target.
Purpose

The purpose of viewing the Melt Curve Plot for the example experiment is to review the melting
temperature of the target.
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Review results
View and assess the melt curve
1. In the Experiment Menu pane, click Analysis » Melt Curve Plot.
Note: If no data are displayed, click Analyze.
2. Select the following items in the Plot Settings menu.
Item Selection
Plot dropdown list Derivative Reporter
Target dropdown list All
Color dropdown list Target
Click  Show a legend for the plot (default). Check (default)
(This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.)

Figure 125 Melt curve plot
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Tips for viewing melt curves in your own experiments

When you analyze your own Melt Curve experiment, look for wells with multiple peaks, indicating
non-specific amplifications or primer dimer formation.

If your experiment does not amplify properly or indicates non-specific amplification, troubleshoot by
manually adjusting the Melt Curve settings (see “Adjust analysis settings” on page 392).

Identify well problems using the well table

382

Review the details of the experiment results in the well table and identify any flagged wells. The well
table displays the assay-specific setup and analysis properties for the experiment in a tabular format.

Example experiment values and flags

For the example experiment, confirm that no wells of the reaction plate triggered QC flags (. ).

View the well table
1. Select the Well Table tab.

2. Click the Flag column header to sort the data so that the wells that triggered flags appear at the
top of the table.

3. Confirm the integrity of the controls.

a. In the Group By menu, select Task to organize the table rows by their function on the reaction
plate.
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b. Confirm that each of the controls do not display flags ().

Figure 126 Well table of the example Melt Curve experiment
The table below gives the description of each column in the well table.

Column

Description

Well column

The position of the well on the reaction plate.

Omit column

A check mark indicates that the well has been removed from the analysis.

Flag column

A symbol indicates that the well triggered the number of flags listed
inside the symbol.

Sample Name column

The name of the sample.

Target Name column

The name of the target evaluated by the well.

Task column

The task assigned to the well (Unknown, Negative Control, or Positive
Control).

Dyes column

The name of the reporter and quencher dyes of the associated sample for
the target evaluated by the well.

Tm1 column The melting temperature of the target.

Tm2 column The second melting temperature (for targets with multiple melting
temperatures).

Tm3 column The third melting temperature (for targets with multiple melting

temperatures).

Comments column

Comments
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Tips for viewing well tables your own experiments

When you analyze your own experiment:
* Review the data for the Unknown samples. For each row that displays the symbol in the Flag
column, note the data and the flag or the flags triggered by the associated well.
* Select areas of the table or wells of a specified type by performing the following tasks:
— Left-clicking the mouse and dragging across the area you want to select an area of the table.
- In the Select Wells dropdown list in the Well Table tab, select Sample, Target, or Task.

Select the sample name, target name, or task name to select wells of a specific type using the
well-selection tool.

* Group the rows of the plate layout by selecting an option in the Group By dropdown list. You can
then collapse or expand the lists either by clicking the + button or the — button next to individual
lists, or by clicking + Expand All or - Collapse All.

¢ Omit a well from the analysis by selecting the Omit checkbox for that well. To include the well in
the analysis, deselect the Omit checkbox.

Note: You must reanalyze the experiment each time you omit or include a well.

Confirm accurate dye signal using the multicomponent plot

384

The Multicomponent Plot screen displays the complete spectral contribution of each dye in a selected
well over the duration of the PCR run.
Purpose

In the Melt Curve example experiment, you review the Multicomponent Plot screen for:
* ROX™ dye (passive reference)
* SYBR™ dye (reporter)

* Spikes, dips, and/or sudden changes

View the multicomponent plot

1. In the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

2. Display the unknown wells in the plate layout to display the corresponding data in the
Multicomponent Plot screen.

a. Click the Plate Layout tab.

b. Select one well in the plate layout. The well is shown in the Multicomponent Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays the data for all
selected wells simultaneously.

3. In the Plot Color dropdown list, select Dye.
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4. Click [-] Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.

5. Check the ROX™ dye signal.

In the example experiment, the ROX™ dye signal remains constant throughout the PCR process. A
constant ROX™ dye signal indicates typical data.

6. Check the SYBR™ dye signal.

In the example experiment, because the PCR run has already been completed, the SYBR™ dye
signal shows gradual decrease throughout the run and a sudden dip in the fluorescence at one
point. The sudden drop in the SYBR™ dye signal indicates the melting temperature of the target.

Figure 127 Multicomponent Plot screen for the example experiment

QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide 385



[~

11277

Chapter 37
Review results

Tips for confirming dye accuracy in your own experiment

When you analyze your own Melt Curve experiment, look for the following items:

Passive reference —The passive reference dye fluorescence level should remain relatively constant
throughout the PCR process.

Reporter dye —The reporter dye fluorescence level should display a flat region corresponding to
the baseline, followed by a rapid rise in fluorescence as the amplification proceeds. If the Melt
Curve is being performed post-PCR, then there should be a gradual decrease in fluorescence and
a sudden dip indicating the melting temperature of the target.

Irregularities in the signal—There should not be any spikes, dips, and/or sudden changes in the
fluorescent signal.

Determine signal accuracy using the raw data plot

386

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each optical filter
for the selected wells during each cycle of the real-time PCR.

About the example experiment

In the Melt Curve example experiment, you review the Raw Data Plot screen for a stable increase in
signal (no abrupt changes or dips) from the appropriate filter.

View the raw data plot

1.

In the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner of the plate
layout in the Plate Layout tab.

Click 7] Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot
legend.

The legend displays the color code for each row of the reaction plate (see the legend in the Raw
Data Plot shown below).

Click and drag the Show Cycle pointer from cycle 1 to cycle 135.

In the example experiment, the signal from filter 1, which corresponds to the SYBR™ dye filter, is
stable throughout.

Note: The readings shown below are from the example experiment. Actual results will vary with
individual experiment setup.

Note: The cycle number in the Melt Curve represents the number of data collection points for that
experiment.
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Figure 128 Raw Data plot for the example experiment
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Run Method

Reaction Volurme per Well: 20| uL
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Figure 129 Filters used for the example experiment

Tips for determining signal accuracy in your own experiments

When you analyze your own Melt Curve experiment, look for the following in each filter:
® Characteristic signal growth
¢ No abrupt changes or dips
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Review the flags in the QC summary

The QC Summary screen displays a list of the QuantStudio™ 12K Flex Software flags, including the flag
frequency and location for the open experiment.

View the QC summary

1. In the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the
experiment. If the frequency is greater than 0, the flag appears somewhere in the experiment. The
well position is listed in the Wells column.

In the example experiment, there are no flagged wells.

3. In the Flag Details table, click each flag with a frequency greater than 0 to display detailed
information about the flag.

In the example experiment, the Frequency column displays 0 for the three flags NOSIGNAL,
OFFSCALE, and MTP.

QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide 389



|| Pu74

390

Chapter 37
Review results

4. (Optional) For those flags with frequency greater than 0, click the troubleshooting link to view
information on correcting the flag.

Focsmmn
Flag Details
Flag: Description Frequency Wells
MTP Multiple Tm peaks 0
MNOSIGHAL Mo signal in well ]
OFFSCALE Flucrescence is offscale &

Flag: MTP—Multiple Tm peaks
Flag Detail: Melt curve analysis shaws more than one Tm

peak
Flagged Wels: None
View MTP Troubleshooting Information
Total Walls: 284 | Processed Welk: 30 Manually Omitted Wells: 0 | Targets Used: i
Wells Set Up: 39 | Fagged wWells: 0 Analysis Omitted Wells: 0 | Sarrples Used: 1
Well Summary: In Pite: 384 Set Up: 39 Analyzed: 39 Flagged: 0 Cmitted by Anstysis: (J Gmitted Manuzlly: ) Samples Used: 1 Targsts Usad: 1

Figure 130 QC Summary screen for the example experiment

Possible flags

For Melt Curve experiments that do not include amplification, the flags listed below may be triggered by
the experiment data.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale

Primary analysis flag

NOSIGNAL No signal in well

Secondary analysis flag

MTP Multiple Tm peaks

For Melt Curve experiments that include amplification, the flags listed below may be triggered by the
experiment data.
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Flag

Description

Pre-processing flag

OFFSCALE

Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal

NOAMP No amplification

NOISE Noise higher than others in plate

SPIKE Noise spikes

NOSIGNAL No signal in well

EXPFAIL Exponential algorithm failed

BLFAIL Baseline algorithm failed

THOLDFAIL Thresholding algorithm failed

CTFAIL Cr algorithm failed

AMPSCORE | Ampilification in the linear region is below a certain threshold, corresponding to the score set

in the analysis settings

Secondary analysis flags

MTP Multiple Tm peaks
OUTLIERRG Outlier in replicate group
AMPNC Amplification in negative control
HIGHSD High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL, THOLDFAIL, and CTFAIL
flags are not reported by the algorithm, but they appear in the QC Summary (by default, a 0 is displayed

in the Frequency column for each flag).

For more information

Information

Reference

Publishing data

Chapter 1, “General information and instructions”
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Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the Melt Curve and flags.

If the default analysis settings in the QuantStudio™ 12K Flex Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then reanalyze your
experiment.

View the analysis settings

1. In the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
* Melt Curve Settings
¢ Cy Settings
* Flag Settings
* Advanced Settings

Note: The Ct Settings tab and the Advanced Settings tab appear in the Analysis Settings
dialog box only if the Melt Curve experiment you are performing includes the PCR process.

Note: Select the Include PCR checkbox in the Experiment Properties screen to include
amplification in your Melt Curve experiment.

392 QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide



Chapter 37 [5F4
Adjust parameters for re-analysis of your own experiments

Figure 131 Analysis Settings dialog box for a Melt Curve experiment

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings” on page 394).

Note: You can save the changes to the analysis settings to the Analysis Settings Library for later
use. For more information, see “About the analysis settings library” on page 62.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to Default Analysis
Settings.

QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Experiments User Guide 393



[~

W n74

394

Chapter 37
Adjust parameters for re-analysis of your own experiments

Adjust analysis settings

Melt curve settings

Enable or disable multi-peak calling.
— Select the Enable Multi-Peak Calling checkbox if you expect to amplify more than one PCR
product and you want to determine the Tm for more than one peak.

— Deselect the Enable Multi-Peak Calling checkbox if you expect to amplify one PCR product
and you do not want to determine the Tm for more than one peak.

Enter a value (in percentage) for the peak level relative to the dominant peak.
Specify a fractional level value as the peak detection threshold. The detected peaks are measured
relative to the height of the tallest peak, which has a perfect fractional level 100%. The default
value is initially set at 10%.
For example, if you set a fractional level detection threshold value at 40, then only peaks above
40% of the tallest peak are reported and the peaks at lower height are regarded as noise.

Cr settings

Data Step Selection

Use this feature to select one stage/step combination for Ct analysis when there is more than one
data collection point in the run method.

Algorithm Settings

You can select the algorithm that determines the Cy values. There are two algorithms: Baseline
Threshold (the default) and Relative Threshold.

The Baseline Threshold algorithm is an expression estimation algorithm that subtracts a baseline
component and sets a fluorescent threshold in the exponential region for quantification.

The Relative Threshold algorithm is a well-based analysis based on the PCR reaction efficiency
and fitted to the Amplification curve. This setting is ideal for a single sample across genes with no
dependence on targets, thereby reducing variability. It is not necessary to set either a baseline or a
threshold when you use the Relative Threshold algorithm, so any settings for baseline or threshold
will not affect the analysis.

Default Ct Settings
Use the default Ct settings feature to calculate Ct for the targets that do not have custom settings.
To edit the default settings, click Edit Default Settings.

Ct Settings for Target
When you manually set the threshold and baseline, we recommend the following settings:

Setting Recommendation

Threshold | Enter a value for the threshold so that the threshold is:
— Above the background.

— Below the plateau and linear regions of the amplification curve.

— Within the exponential phase of the amplification curve.

Baseline | Select the Start Cycle and End Cycle values so that the baseline ends before significant
fluorescent signal is detected.
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Note: Selecting Automatic Threshold implies selection of automatic setting of the baseline.
However, if Automatic Threshold is deselected, then you can choose between setting the baseline
either automatically or manually.

Flag settings

Use the Flag Settings tab to perform the following tasks:
* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the QuantStudio™ 12K Flex Software.

1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the setting for applying
the flag.

Note: If you choose to adjust the setting for applying a flag, make minor adjustments as you
evaluate the appropriate setting.
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3. In the Reject Well column, select the check boxes if you want the software to reject wells with the
flag.

Note: After you have rejected the flagged wells, analysis results depend on factors such as the
experiment type and flag type. For example, rejecting wells flagged by HIGHSD in experiments
using the Standard Deviation calculations may change the result of Ct SD. For some flags, analysis
results calculated before the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box.
If the run status is complete, the data are reanalyzed.

Figure 132 Flag Settings tab
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Advanced settings

Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative Threshold setting.

The following steps describe the use of custom baseline settings for a well-target combination.
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target checkbox.

3. Define the custom baseline settings.

* For automatic baseline calculations, select the Automatic Baseline checkbox.

* To define the baseline, deselect the Automatic Baseline checkbox, then enter the baseline
start cycle and baseline end cycle.
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Export analysis results

1. Open the Melt Curve example experiment file that has been analyzed.

For information about analysis, see Chapter 37, “Review results and adjust experiment

parameters”.

2. In the Experiment Menu pane, click

Export.

Note: To export data automatically after analysis, select the Auto Export checkbox during
experiment setup or before running the experiment. The Auto Export checkbox is unchecked

for the example experiment.

3. In the Format dropdown list, select QuantStudio 12K Flex format.

4. Complete the Export dialog box as shown below.

Field or selection

Entry

Select Data to export/Select Content

Results

Export Data To options

One File radio button

Export File Name field

384-Well Melt Curve Example_QuantStudio_export

File Type dropdown list

*

Ixt

Export File Location field

Use the default file location or click Browse to select a different
location
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Figure 133 Export screen
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export.txt - Notepad

File Edt Format View Help
[¥ Barcode = NA A
* Block Type = 384-well Block i
* calibration Background is expired = No
® Calibration Background perfor'med on = 2011-08-05 0QL:46:18 AM 5GT
* Calibration FAM is expired =
# calibration Fam performed on = 2011-08-03 02:04:58 AM SGT
# Calibration ROI is expired = No =
* calibration ROI performed on = 2011-08-04 11:42:31 AM SGT
# Calibration ROX is expired = No
* calibration RoX performed on = 2011-08-05 02:23:30 AM SGT
* calibration SYBR is expired = No
* calibration syBrR performed on = 2011-09-15 05:13:56 AM SGT
# calibration syBrRZ is expired = wo
* calibration svBR2 performed on = 2011-09-14 05:58:11 AM SGT
= calibration uniformity is expired = Mo
# calibration Uniformity performed on = 2011-08-05 01:56:21 AM 5GT
= calibration vIC is expired = NO
* calibration vic performed on = 2011-08-05 02:15:08 AM SGT
* chenistry = SYBR_GREEN
# Comment = NA
* Date Created =
* Experiment File Name = C:‘Program Files‘Applied Biosystems‘QuantStudiol2kFlex‘examples'Melt Curve'384-well Melt Curve Example.eds
* Experiment Name = 384-well Melt Curve Example
# Experiment Run End Time = 2011-09-20 12:30:16 PM SGT
* EXperiment Type = Melt Curve
® Instrument Name = Quamst\‘dw‘ooemo
* Instrument Serial Number Quantstudiobemo
# Instrument Type = Quantstldw 12K Flex
* passive Referenca = ROX
# guantification cycle Method =
# 5ignal Smoothing On = true
* User Name = NA
[Samp'\e setup]
11 wWell Position  sample Name sample Color Biogroup Name Biogroup Color Target Name Target Color Task Reporter
quencher Quantity Ccomments
1 Al sample 1 "RGB(O 255, G}" Target 1 "RGE{0,0,255)" UNKNOWN SYBR None
2 a2 sample 1 ‘RGB(N, 255, 0)" Targer 1 "RGB(N,0,255)"  UNKNOWN SYBR None
3 A3 sample 1 "RGB(D,255,0)" Targer 1 "RGB{0,0,255)" UNKNOWN SYBR Nohe
4 a4
5 AS
& 26
7 AT
g A8
9 A9
10 A10
11 A11
12 a2
13 £132
14 Al4
15 £15
16 216
7 A7 ~

Figure 134 Exported file
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Documentation and support

Related documentation

Document Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System Site Preparation Guide 4470654
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Plate Quick Reference 4478673
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
High Resolution Melt Software for QuantStudio™ 12K Flex Real-Time PCR System Getting Started 4470692
Guide
QuantStudio™ 12K Flex Software Automation APl Reference Guide MANO0028446
QuantStudio™ 12K Flex Software v1.6 or later
QuantStudio™ 12K Flex Real-Time PCR System v1.6 or later Maintenance and Administration Guide | MANO018832
QuantStudio™ 12K Flex Real-Time PCR System v1.6 or later Multi-Well Plates and Array Card Quick | MAN0O018833
Reference
QuantStudio™ 12K Flex Software v1.4 or earlier
QuantStudio™ 12K Flex Real-Time PCR System: Multi-Well Plates and Array Card Quick Reference 4470688
QuantStudio™ 12K Flex Real-Time PCR System v1.4 Maintenance and Administration Guide 4470689

Obtaining information from the help system

The QuantStudio™ 12K Flex Software has a help system that describes how to use each feature of the

user interface. Access the help system in one of the following ways.
® Press F1.
® Click inthe toolbar.
* C(Click Help » QuantStudio 12K Flex Software Help.

You can use the Help system to find topics of interest by:
* Reviewing the table of contents
* Searching for a specific topic
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Appendix A Documentation and support
Customer and technical support

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers

* Product support information
- Product FAQs

— Software, patches, and updates
— Training for many applications and instruments
® Order and web support

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and its affiliates warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/
home/global/terms-and-conditions.html. If you have questions, contact Life Technologies at
www.thermofisher.com/support.
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